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1.2

1.3

1.4

Quick introduction

Installation

When starting the setup program WinOLS.EXE the installation assistant asks for
acknowledgement of the license agreement. Of course this is required in order to
continue the installation process.

After this you'll be asked for confirmation of the default install path, which is
“C:\Program files\EVC\WInOLS". This one should also be used when carrying out a
network installation. The car data can be saved to a directory on the server later on.

The next three queries may also be confirmed by pressing “Next".

The software will work in demo mode until registered. Simulator or EPROM
hardware are not supported yet. In addition you are not able to save any data.

Attention: if you want to use legacy devices like the OLS16 simulator or the
MP2440P eprommer, the you have to enable the respective checkboxes during the
installation.

Registering WinOLS
To activate WIinOLS, use the menu item "Other > Updates + Activation”.

If you have not yet purchased WinOLS or would like to license additional
workstations, you can do this online.

Language

When using the German or English version of Windows the language will be set
automatically. All other versions will not be recognized. The language settings can
be found at “Miscellaneous > Configuration > Miscellaneous > Language”
(“Sonstiges > Konfiguration > Sonstiges > Sprache*). When this setting is modified
WinOLS has to be restarted for the change to take effect.

Checksums

WinOLS can be expanded with checksum modules. These module can be
purchased directly from EVC or online on evc.de. After the purchase simply use the
WinOLS update function to automatically install the modules.

You can check the state of the currently installed modules in the dialog "? > Info
about plugins".
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1.5 Network installation

First WIinOLS will have to be set up on each workstation as described above. The
software also has to be unlocked on each computer separately.

Create a shared directory on the server, e.g. “WinOLS data“. The path to this
directory has to be set in each workstation’s WinOLS at “Miscellaneous >
Configuration > Clients”.

Checksum DLLs may not be put in a shared directory but have to be copied to each
workstation into the directory called “C:\Program filesS\EVC\WinOLS\DLLSs". This is
done automatically during the update process.

1.6 The main screen

The WIinOLS main screen contains several elements:
WinOLS - Alfa 156 (Original), , Hexdump ME="EA x|

Ernject Edit Hardware View Selection 5Search Miscellaneous Window I
488 R C(E) P ERT (2| (fs) B
13 Poinlk=! 13 point 12 | B[] 1 e | e ) add |

i b aps E S ooo O oo oo

D@L
M.+ Addiess  Mame 115

Alfa [Driginal]
& Hexdump
00000 Hexdump
& Meine Kennfelder
El ennfeld "Da HELS
B FPotentielle Kennfelder [79]

# 5

Press F1 to receive help.

1. Switching between clients
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2. Search field for "projects, versions and maps". Enter a text to reduce the view to
matching entries
3. Dropdown button for previous searches
4. Options for the map list and the search
5. Button project properties and fast switching (black triangle) between elements
6. Unimportant program areas (empty ranges and program code) are shown pale
(More color info)
7. Switching of the preference of hexdump or bar when the window is too small
8. Color-coded overview of the project. The scrollbar has 3 buttons at top and
bottom: Scroll to top/bottom; Scroll fast; Scroll normally
9. Automatically found, potential map
10. Map registered by you (Also visible at "My maps")
11. Switching of the view mode between Text, 2d, 3d and Slices
12. Checksum status: Checksumms, Patches, Sync-Blocks, Text description
13. Hardware status (of OLS16 or OLS300 modules)
14. Several filters for the list "Projects, Versions and Maps"
15. Show/hide sidebar
1.7 Projects
All eprom data will be administered in so-called projects by WinOLS, which consist
of an original file and as many modified ones (versions) as are needed. They will be
saved to one single file together with the vehicle data as well as possible comments.
Please note:
It is not possible to edit external file formats directly. Since WinOLS stores lots of
additional information you have to import it into a WinOLS project first (for example
by drag+drop) and export (or burn or write) it later again.
1.7.1 Creating a project
The creation of a new project starts off by selecting “Project > New". Data out of an
eprom or from a file can now be read into this empty project.
1.7.2 From afile
Data from a file is being read in by selecting “Project > Ex- & Import > Import File®.
First you have to choose a file type, then the file name has to be chosen.
You can drag files or Outlook e-mail attachments directly into the WinOLS window. If
you drop the file over an existing project window, it will be imported as version. If you
drop over the WIinOLS frame window or on an empty workspace background, it will
be imported as new project.
1.7.3 From an eprom

To read out an eprom, you have to choose its type first at “Hardware > Producer*.
Then you can start the reading process by selecting “Hardware > Eprom > Read".

(C) 2025 EVC electronic



Quick introduction 15

1.7.4

1.7.5

1.7.6

Please note:
Eprom operations are only supported if the project type was set to "Eprom" in the
Project properties or if the project is empty.

From an ECU (via BDM100)

Certain ECUs (you'll find a list on the EVC Website) can be read with the additional
hardware BDM100. This not only reads the eprom, but all available memories (e.g.
the CPU-internal memory). To store this data WinOLS creates multiple “Elements”
within the project. (Elements are explained in the chapter “Special aspects”.)

To read a ECU via BDM100 please refer to the BDM100 documenation on the EVC
website. To initiate the read process in WinOLS select the menu item “Hardware >
BDM > Read”.

Please note:
BDM operations are only supported if the project type was set to "BdmToGo" in the
Project properties or if the project is empty.

The original

The first read-in data record will automatically be saved as “Original* while any
further ones will be named “Version®. Different names can be assigned later on,
though. Some checksums require the file saved as “Original“ to contain the
unmodified data from the ECU.

After reading in the original a dialog window will appear which asks for typing in the
vehicle data for the project to be identifiable later.

The version

When a version has been imported another dialog window will appear where a name
and the vehicle information may be entered. You can also read in a file that was
modified by another software just for the checksum to be balanced.

Version folders:

By default versions are simply listed, but you can also use version folders to
organize them. This has no influence on the program behavior, but only affects the
display of the version list.

Any version can serve as folder to another version. Furthermore you can use
abstract folders (which are just folders, but not a version) which can also contain
other versions. To change the version folders, simply drag a version to another place
in the open version dialog or edit the version properties and change the parent
folders. To get a version back to the top level, simply drag it far to the left.
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2 Typical tasks

2.1  Creating a new project

Choose the menu item “Project > New”.

Now you have an empty project and you need data (Original data is always best).
Either from a file or from an eprom. To import a file you have several possibilities:

1. You drag the file with “Drag und Drop” into the empty project window.

2. You import the file with the menu item “Project > Ex- & Import > Import file” or

you activate the import with the keyword shortcut Ctrl+1 or the icon ,, ﬂ

Choose your file format, click on “Ok” and choose the file.

Now you have imported the original. All versions that you create or import later will
automatically be compared with the original and the differences will be marked will
colors on the screen. If you want to import a version, just repeat the steps shown
above.

2.2 Automatically find maps

If you have created a new project, WinOLS will automatically start to search for
maps after a few seconds. You can see this in the status bar at the lower end of the
window. You can influence the background map search with the menu items in the
“Search” menu.

After the map search has finished, you have several possibilities to review its results:

e There is a new subfolder labeled “potential maps” in the project and map list
at the left border of the window. It contains all maps that were found during
the search. Open the folder clicking it with the left mouse button. Click on a
map in this folder to view it in the hexdump. If the Preview Window is open
(Hotkey “P”), you'll directly see a 3d preview of the potential map.

e Use the function “View > Recognize map” (Hotkey “F”) to jump to the next (or
“Shift+F” for previous) map and to select it.

e Every map that was automatically recognized has a small tag with its name.
Click on the tag to display the map optimally. Double-click it to convert the
potential map in a normal map (which can be edited easier). Right-click the
tag to get more options.

2.3  Manually find maps (Text mode)

It is not easy and requires a lot of skill to manually find maps. First you should start
with the view mode that you like best. For this click on the tabs “Text > 2d > 3d” on
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the lower border of the screen or use the hotkey “T” and “Shift+T”.

This section describes the manual search for maps in text mode. A corresponding
description for the 2d mode is in the following section.

Now choose the view parameters. Make a doubleclick on the window and choose
the “Values” (8 Bit, 16 Bit, ...). New ECU'’s often use 16-Bit Data. Motorola
Processors use “HiLo” Notation and Intel Processors use “LoHi”. (WinOLS
automatically recognizes the processor manufacturer. You can see it the in the
project properties. Choose “Project > Properties: Project”.)

Now scroll through the file. Use the mouse (mouse wheel or scroll bar) or the keys. A
few tips:

¢ If the numbers a pale, then this area was recognized as program code by
WInOLS. You should ignore this area. Normally you won't find maps here and
changes might easily result a crash in the car’s software. Empty areas are
also displayed and are equally uninteresting.

e Use the overview window (Menu item “Window > Overview”) to get a rough
outline of the project. You can move and resize this window, just like the
preview window. You can also tell this window to “roll up” when it is not active
by clicking the button left of X button.

If you've found something that could be a map, the first thing you should do is to
adapt the view settings for this map. You can do this in all view modes, but it is
easiest the text mode. Start with the number of columns. The maps often have
“lJumps” which represent a new line in the map. Change the number of columns in
such a way, that all jumps are in the same columns. You can change the number of
columns with the hotkey “M” and “W”. In the viewmode “Text” you can also change it
by clicking and on the single vertical line and dragging it.

O08ca O09&80 DABC OCmd Ll o120 good oooo oooo
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0E74 OE74 1068 015 1ESB 1F< — |
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Image: Map before changing number of columns Image: Map after changing n
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Now you can probably recognize a bit of the maps. The next thing that you should do
is to move the start address of the map so that it will start on the left of the hexdump.
For this use the menu item “View > Move origin left” And “View > Move origin right”.
(Hotkeys Ctrl + Cursor left or right.) If you're finished with this, select the map.

(Tip: If the bar display doesn’t contain anything useful, you should optimize the value
range for your data. If you've selected the map, choose “View > Optimize value
range” or press Ctrl+B. WIinOLS will automatically be configured in such a way that
the data used in the selection optimally uses the heights available for the bars.)

oooo oi90 040 0&40 0700 Q9480 0A Oo20 0ELOD
OE74 OE7T4 74 106 aEC 1! ! 58 1F40 1F40
OE74 OE7T4 7o ! 58 1F40 1F40
10 oo 1l0cc : 57 A, 1E58 1rF40
OFaD A0 OF&A0 1130 1 * 13EC 157¢ 1770 1F40

OE74 10cC 11F8 12 : 1770 1F40

OE74 94 3 3 1F40 1F40
ar oE : 1F40 1F40

. 1F40 1F40
1EB3S 1rF40 1r40
1F40 410 1F40 1F40

oooo o19a

1740 gulae]

Image: Map with the right start Image: Marked 1

If you've activated the preview window, you can now see a 3d preview of your
selection. Use the menu item “Selection > Selection -> Map” (Hotkey “K”) to create a
map from your selection. A new window will open and you can edit your map.

But first, a few alternatives for entering maps:

e The assistant “Support map selection” can help you. Activate it with the menu
item “View > Support map selection”. At the beginning nothing will happen
(except it you already had a selection active while doing this. In this case the
assistant will be applied without activating it permanently). If you now create a
selection with your mouse, the assistant will try to optimize it. It will perform
the steps that we described above (Number of columns, Start, ...)
automatically. But you should always be careful not to select to any data that
does not belong to the map.

e The assistant works perfectly together with the “Map Selection”. You may
need to activate this by selection the menu item “View > Symbol bars >
Frame: Map Selection”. Whenever you now create a rectangular selection,
you can change it with the new symbol bar afterwards. You can change the
beginning in X or Y direction or change the number rows or columns.

Manually find maps (2d mode)

Finding maps in 2d mode is similar to finding them in text mode. Start the same way
as above by configuring the view parameters (8 Bit, 16 Bit, ... / HiLo, LoHi) and then
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scroll through the file until you find a possible map. (Remember that you can change
the X and Y zoom factors with the menu bar “Frame: View” or Ctrl+Mousewheel.)

If you found a possible map, you should start by setting the right number of columns.
In 2d-Mode the “line breaks” will be symbolized by vertical lines, but you can
configure this in the configuration (page View, in the 2d-Range).

Change the number of columns so that the vertical lines are always parallel to
“lJumps” in the map. Use the hotkeys “M” and “W” to add or remove columns.

Image 1: Map before changing number |Image 2: Map after changing number
of columns of columns

In 2d mode you also have to move the beginning of the map (“View > Move origin
left* and “View > Move origin right* or with the hotkeys Ctrl + Cursor left or right). It
can now become clear that the number of columns isn't right, yet. In this case go
back to the steps shown above.

Image 3: Map with right start Image 4: Marked map

Now you have to select the map, which isn’t easy in 2d mode because the pixels are
quite close to another. Start by marking the map only rough. Now move the mouse
cursor over left end of the selection. The cursor will change to an arrow pointing to a
line (see image 4). Click here and drag to the left or right to change the selection.
This will only change a selection that was already made. WinOLS will automatically
make sure that the selection starts on a line break. Repeat this for the right end of
the selection.

Again, it is easier with the assistant “View > Support map selection”. If you don’t
want to activate it permanently, you can also apply it on demand. Just right-click a
selection and select this function from the context menu: (Of course this will also
work in text mode)
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2.5

2.6

Y Copy ChrliC
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Support map seleckion
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Selection

Selection mode

Yalue + 1
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r* Change absolute, .
"* Change relative. ..
Change by edit...
Criginal walue

Manually find maps (Typing)

You can also create maps by typing the data manually. Simply press "K" (or
"Selection > Selection->Map") anywhere in the hexdump. This will create a map at
this address and open the dialog "Properties: Window". Now you can enter
parameters like name or size.

Tip: The map window in the background is automatically updated to give you
feedback.

Tip: Special info for Vertical-maps
Manually find maps (Vertical map)

This is a special map format where the axis data is not (as usual) separated from the
map data, but interwoven. Each row of map data starts with the corresponding value
of the y-axis.

Manually:

To represent this with the WinOLS map settings you need to:

¢ adjust the rows/columns of the map to the size of the map data (without axis) in
cells

e set the start address of the map to the first cell of the map data

e set the line skip bytes for the map to "2" (for WORD maps; or "1" for BYTE)

e set the byte skip to the y-axis to "2*columns” (for WORD maps; or "1*columns” for
BYTE)

Using selections:
Use a rectangular selection to select the map data, but not the axis and press "K".
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2.7

2.8

WiInOLS will now create a map.

Using potential maps:
Make sure the car ECU manufacturer is set to "Denso" and start the potential map
search.

Create many maps

If you want to create many similar maps, there are several possibilities:

e Create a selection and generate the first map (K). If you have activated the option
"F12 > Miscellaneous > Edit > After map create select the area behind" (and if
necessary "Open newly created maps directly” deactivated), then the next map is
selected directly and you can simply press K again.

e Create a selection that does not result in a map and press K. If you have activated
the option "F12 > Miscellaneous > Edit > Create Map Wizard", then you can now
enter not only the map size, but also the number.

e You can also (via the project menu) export the selected maps as CSV, edit them
with Excel (and add new entries) and then import them again.

e If the maps have already been identified as potential maps, you can select them in
the KF list and simply move them to the normal map area.

e Create the first map and edit the properties as desired. Use the function Copy map
properties and activate the option "Apply automatically”. Now create new maps by
pressing K in the hexdump (without selection). (If necessary, deactivate "F12 >
Miscellaneous > Edit > Open newly created maps directly").

e Create the first map manually. Now hold Ctrl+Alt and click in the hexdump on the
first cell of the map and drag it to a new position to create a copy.

See also:
e Importing data from older projects
e Edit many maps

Edit many maps

To change several maps simultaneously in a similar way, you can use the following

functions:

e Copy source data with map properties and paste it into a map with Ctrl+V.

e You can also select several maps in the map list and press Ctrl+V there.

e If you right-click a selection in the map list, you will find the menu item "Edit
multiple maps" for numerous standard functions.

e Via the project menu you can export the map list as CSV, edit it in Excel and then
apply it to the project again. This allows them to process conditions via Excel
formulas, such as maximum values.

e With the LUA plugin you can write scripts to edit the maps.

(C) 2025 EVC electronic



Typical tasks 23

2.9 Preview

If you've activated the preview window, it will automatically open if you have a
rectangular selection that is not wider than 32 columns. This is very helpful for
configuring your maps, but you must learn how to “read” the window. Here are few
typical views to help you:

Too much selected. The high area looks different and doesn’t belong to the map.
Because it is much “higher” than the rest, the rest is displayed smaller and thus is
more difficult to recognize:

~|

Wrong number of columns. Look at the typical diagon
fpreview 0|

~| 1| T —— -

al line formed by the jumps.
Elfereview = ~

= E

Right number of columns, but a wrong Everything right:
start. There is a “jump” within the map.
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2.10

2.11

Changing maps

Why use maps? You could edit data directly in the hexdump, but editing in a map
has man advantages:
e |t brings structure in a project and makes it easier to find the maps again, later
on.
e You can open multiple windows at the same time.
e The correct axis values are displayed, even if they are done by additive
calculation.
e You cannot change data outside of the map by chance.

You've created a map with the methods described above and now want to change it.
The simplest possibility is to use the keys “+” and “-* to increase or decrease the
value at the current cursor position. Keep the key pressed to make the change go
faster and faster. If you want to return to the original value then use the menu item *
Edit > Original value” (Hotkey F11). If you've created a selection this will apply to the
entire selection.

Note:

You can also change the way that selections are created. Normally a selection is
kept until you delete it (“Selection > Select nothing” or the key ,Del”). But you can
also configure WIinOLS, so that a mouse click will always remove the previous
selection (“Miscellaneous > Configuration > Miscellaneous > Edit").

If you right-click a selection, you'll see a menu will several more tools to change the
selected values. Finally you can also press Enter key to directly enter a new value
and again press the Enter key to confirm it.

Correcting checksums

Correcting checksums is very easy because this is done by additional plug-ins. They
must be purchased separately but for this they do all the work needed automatically.

Start the checksum dialog with the menu item “Edit > Checksum” (Hotkey F2). Click
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on “Search”. If you own the right checksum module, it will automatically be applied
and the checksum will be calculated and (if you want that) always be corrected.

If you do not have the matching module, you can have your project checked online
(free and without any commitments). Click on “Search checksum online”. The project
will be compressed and uploaded to the EVC server (Internet connection required).
A few seconds later you will receive an answer, telling you which checksum module
will work for your data.

Important:

Some checksum modules require an unmodified original version. That means, that
you must have loaded the original data from the car as original version into the
WinOLS project. Otherwise the checksum may not be recognized or not calculated

correctly.

Importing data from older projects

If you have a new project that is similar to an old one, there is no reason to reinvent
the wheel. WinOLS has many features to import the data. This applies both to
structure information like maps and to concrete changes.

WInOLS offers the following options

What can be transferred?
Data Compari |Offsets |Toleranc |[Map Map Hexdum
source |son e? structure|values |p values
criteria
Import: |.ols n/a none n/a yes yes yes
Similar (except:
project Data
areas)
Import .ols Content [per yes yes yes yes D
changes map/bloc
k
Referenc |.ols Manually/manually |yes yes yes yes
e version Offset/Co|/
+ ntent/Ma |individual
Connect p-Id ly
windows
Import .ols Offset 1 per file |no yes yes no
maps
Map kp Offset 1 per file |no yes yes no
packs
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Scripts  |.winolsskr|Content |per yes yes yes yes 1
ipt map/bloc

k
AutoUpd |same n/a no no no yes no
ate project
Autolmpol|.ols Content [per yes yes yes no
rt map/bloc

k

DIncreased risk of mistakes

In detail:

Import changes

This is the simplest option to import data from another (already opened) project into
the current project. Choose the menu item “Project > Ex- and Import > Import
changes” (Hotkey Ctrl+Alt+l). In the automatic mode WIinOLS will automatically
recognize the maps and search them in the current project. The manual mode
prepares two windows with Reference and Connection.

Reference version + Connect windows

These modes allows you to manually import data. This makes it very powerful, but
also more difficult to use, than the assistant described above. You can activate these
modes manually with the menu items of the “View” menu or let WinOLS configure
them for you as described above. Afterwards you’ll have both projects next to
another. If you scroll one project, the other will be scrolled, too. To make comparison
easier, the other window will always be the “reference version”, meaning that its data
will be used as original version for the current window (only temporary, don’t worry).
With a right click on a selection or a map in the hexdump you can transfer the data
(Menu item “Transfer values” or “Transfer maps”)

Import maps
If you're sure that all maps are still at the same address, you can use this menu item

to import map information from another project. This will only transfer structure
information (address, size, ...). The data within the maps will not be imported.

Map packs
Similar to the point above, map packs can transfer map data. But you must begin by

exporting maps from the old project into a map pack file to import them afterwards
into the new project. This has several advantages. These files are much smaller than
project files because they contain only structure information, no map values. This
makes it easier to transfer them. Furthermore you can enter an offset when
importing them.

Scripts
This option was build into WinOLS for power users. With scripts (“Search > Scripts”

or Hotkey F8) you can export structure and / or values of maps in special script files.
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These files automatically recognize if they can be applied and at which position the
map, that should be modified, is located. Changes can be done absolute, as
difference or percentual. Use scripts if you have to do the same similar changes for
many files.

AutoUpdate + Autolmport

These are options for advanced users who want to manage a large number of
versions automatically. AutoUpdate combines several versions within a project to a
new version. Autolmport imports the versions from another project.

2.13 AutoUpdate + Autolmport

This function requires WinOLS 5.21 + FeatureUpdate

AutoUpdate and Autolmport are mechanisms to automatically import/combine/
update data from other versions/projects.

AutoUpdate

Here a version receives the map values of one or more other versions of the same
project. Both the source version(s) and the target version must be created by the
user beforehand. You can combine several source versions. You can have multiple
versions calculated by AutoUpdate. Offset is not supported.

A project can contain multiple target versions that combine source versions in
different ways. If a source version is changed, then the target version is
automatically updated when it is opened.

One Project
Mame: | Stagel - | Mame: | FeatureX - Mame:| Stage 1+FeatureX -

State: | AutoUpdate ~ | {You do this

WinOLS does this

=)

Procedure:

e Give all source versions unique, meaningful, and short names.

e Mark the target version with the version status "AutoUpdate" or
"AutoUpdateAndExport" (see below).

e The version name of the target version must consist of the names of the source
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versions, connected by plus signs. Example:
Stagel+FeatureX+OptionAlpha

Tips:

e Maps that contain changes in a source version always overwrite the complete map
in the target version.

e Changes in the rest of the project are also deleted by default. You can disable this
by putting a plus in front of the first version name. Example:
+Stagel+FeatureX+OptionAlpha

e Changes outside of maps are not transferred. If necessary, create a map for this
purpose.

e If you do not want to change the version name, you can alternatively enter the info

in the version comment like this:
@auto source Stagel+FeatureX+OptionAlpha

Autolmport

Similar source projects are searched automatically and their source versions are
imported by Import changes. The user has to create the source projects and the
original of the target project. The further versions are created and filled
automatically. By default, only changes within maps are transferred.

Procedure:

e Mark the source projects and the desired source versions with the project/version
property "AutoExport” (or "AutoUpdateAndExport").
e Target projects must have the project status "Autolmport”.
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Multiple Projects:

1 New project:

EState: AutoExport E|State: AutoImport |~

State: '

v

7] State:
You do this

-

Find most :
similar [*7] State:| AutoImport -~

[7] State: | AutoExport |~

WinOLS does this

[%7] State: | AutoExport [%] State: | AutoImport

Import
versions

Notes:

e WInOLS creates versions here and marks them with "Autolmport”. You should not
edit Autolmport versions manually, because WinOLS can delete and recreate the
version (which would cause your changes to be lost).

e The versions are always imported 1:1, there is no combination (like with
AutoUpdate). However, you can take over versions previously calculated by
AutoUpdate into Autolmport.

e When transferring the changes, the offset is determined automatically. This always
includes the possibility of errors.

Parameters:
You can define additional conditions in the project comment of the source project to
prevent error transfers and increase performance.
e Minimum similarity: (default value: 70%)
@auto min_similarity 90%
e Project properties that must match: (default value: empty)
@auto check_property ECU.ECUProd, ECU.ECUStg
WinOLS always chooses the most similar version that meets all your conditions.

If the data is transferred, then you can configure stuff in the project or version

comment of the source project:

e Whether tolerance should be used when matching the maps: (default value: 0%)
@auto transfer_tolerance 10%

e Whether the map structure should be transferred: (default value: yes)
@auto transfer_maps no
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¢ With which mode the changes should be transferred: (default value: relative)
@auto transfer_mode absolute

e Whether also maps without changes in the source project should be transferred:
(default value: yes)
@auto transfer_unchanged no

¢ Whether changes in the source project should outside of maps should be
transferred: (default value: no)
@auto transfer_outsidemaps yes
Warning: You should definitely combine this with "transfer_mode absolute". This is
because if WinOLS does not know the bit width, relative/percentage can result in
incorrect values.

AutoUpdate + Autolmport:

You can combine both features by marking the versions as "AutoUpdateAndExport".
Then, on the one hand, they are assembled from other versions of your own project
and, on the other hand, they serve as a template for other (Autolmport) projects.

Performance:
The mentioned functions manage considerable amounts of data and can slow down
WinOLS noticeably. To minimize the effort you can:

e Autolmport: Define as strict conditions (parameters) as possible.
e Autolmport: Keep the number of source projects low
¢ Disable the encryption of versions (F12 > Miscellaneous)

See also:
e The command AutoUpdate + Autolmport (Menu Project)
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3.1

Special Aspects

Keyboard Shortcuts

WIiInOLS support keyboard shortcuts for many functions. Most of them are

documented directly next to the function in the pulldown menu and in the tooltip of its
icon. For various abbreviations that contain 'Ctrl' and display a dialog, the dialog can
be skipped by additionally pressing 'Shift'.

Note:

If a hotkey does not work, please check if other applications claim this hotkey system

wide. Test on F12>Debug.

(Click on column headers to sort)

Program functions:
Area

Project

Project
Project
Project
Project
Project
Project
Project
Project
Project
Project
Project
Project
Project
Project
Project
Edit

Edit

Edit

Keys
Ctrl+N
Ctrl+O
Ctrl+S
Ctrl+Shift+S
Shift+P
Shift+Alt+Enter
Ctrl+Alt+O
Ctrl+P
Ctrl+E
Shift+Alt+E
Ctrl+l
Shift+Alt+l
Ctrl+Mm
Ctrl+Shift+l
Ctrl+Alt+I
Ctrl+D
Ctrl+z
Ctrl+Y
Ctrl+C

Description

New project

Open project
Save project

Save all projects
Properties: Projekt
Properties: Version
Similar projects
Print

Export

Export map pack
Import

Import map pack
Send as mail
Import maps
Import changes
Import damos
Undo

Redo

Copy
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Edit
Edit
Edit
Edit
Edit
Edit
Edit
Edit
Edit
Edit
Edit
Edit
Edit
Edit
Edit
Edit
Edit

Edit

Edit
Edit
Edit
Edit
Edit
Edit
Edit
Edit
Edit
Edit
Hardware

View

Ctrl+X
Ctrl+Vv
Ctrl+Shift+C
Ctrl+Alt+H
Ctrl+Alt+K
Shift+K
Ctrl+Del
Ctrl+Shift+T
Enter
Shift+Q

+

Ctrl +"+"

Ctrl + "-"

%
Ctrl+Shift+A

Ctrl+Shift+P

/

Ctrl+Alt+R
F11

I
Ctrl+Alt+Shift+Del
F9

F2/C
Shift+C
Alt+Enter
Ctrl+Shift+F4
Ctrl+Shift+H

Ctrl+CursorLeft

Cut

Paste

Copy address

Active hexdump window
New hexdump window
Open map

Delete map

Edit as text

Inplace edit

QuickFix

Value + 1

Value + 100 (Configurable)
Value - 1

Value - 100 (Configurable)
Change absolute

Change relative

Change relative (Addition
activated)

Change relative
(Percentage activated)

Change by edit
Round/limit values
Original value
Interpolate

Remove row / column
Repeat

Checksum
Checksum ranges
Properties: Window
Close all map windows
Producer

Hexdump: Move origin left
Map: Display previous
parallel map
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View

View
View
View
View
View
View
View
View
View
View
View
View
View
View
View
View
View
View
Selection
Selection
Selection

Selection

Selection

Selection

Selection
Selection
Selection

Ctrl+CursorRight

Ctrl+J

M

W

z

Shift+R

Shift+D

Shift+1

Shift+O
Ctrl+Shift+Alt+O

—rzZz< mC

Ctrl+2
Ctrl+B

F

Shift+F

Ins

Ctrl+A
Alt+Shift+D

Ctrl+Alt+Shift+D

Ctrl+Alt+L

Ctrl+Alt+Shift+L

Ctrl+Shift+Ins
Ctrl+L
Del

Hexdump: Move origin
right

Map: Display next parallel
map

Cursor position as origin
More columns

Less columns

Default view

Percent

Delta

Ignore factor/offset
Original values
Original original values
Differences

First difference
Previous difference
Next difference

Last difference
Connect windows
Optimize value range
Detect map

Detect previous map
Select cell

Select screen

Select changes
(Repeatedly: Only +/-)

Select changes adding to
the current selection
(Repeatedly: Only +/-)

Create selection

Create selection (Without
dialog)

Selection from clipboard
Selection from live-search
Select nothing
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Selection
Selection
Selection
Selection
Selection
Selection
Selection

Selection

Selection
Find
Find
Find
Find
Find
Find
Find
Find
Find
Find

Find
Find
Find
Find
Find
Find
Find
Find
Find
Find
Miscellaneous
Window

K

Ctrl+R
Ctrl+W
Ctrl+Shift+M
Ctrl+Shift+B
Ctrl+Shift+K
Ctrl+Alt+"+"

Ctrl+Alt+"-"

Ctrl+Alt+"0"
Ctrl+F
Ctrl+Alt+F
Alt+F3

F3
Shift+F3
Alt+Shift+P
Ctrl+Alt+P
A

Ctrl+G

J

Ctrl+Shift+V
Ctrl+Shift+N
Shift+V
Shift+N
Shift+Enter
Shift+F5

F5

Ctrl+F5

F7

F8

F12

Ctrl+K

Selection -> map

Load selection

Save selection

Change selection mode
Selection beginning
Selection end

Deselect > Positive
changed

Deselect > Negative
changed

Deselect > Unchanged
Find byte sequence / Text
Find selection

Start search

Continue search

Search backwards

Map axis profiles

Parallel maps

Go to address

Go to address

Jump to address from
hexdump

Previous map
Next map
Previous comment
Next comment
Insert / edit map
Previous marker
Next marker

Insert / delete marker
Solutions

Scripts
Configuration

Map selection
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Window U Differences

Window @) Overview

Window P Preview

Window Tab Toggle floating windows

Window Ctrl+0 Window list

Window Ctrl+1 Maximize

Window Ctrl+3 Cascade

Window Ctrl+4 Tile vertically

Window Ctrl+5 Tile horizontally

Window Ctrl+9 Optimize window size

Context menu Ctrl+Shift+Del Delete potential map

Context menu Ctrl+Alt+Win+C Copy both axes

Context menu Ctrl+Q Map icon menu. (Map list,
map, hexdump selection)

Context menu Ctrl+ShiftQ Map icon (no menu)

Context menu Ctrl+F11 Set map to original

Connect bar Ctrl+Alt+W Transfer values

Connect bar Ctrl+Alt+Shift+W Transfer values (no dialog)

Connect bar Ctrl+Alt+T Transfer map(s)

Connect bar Ctrl+Alt+Shift+T '(;’iraalr(;zf)er map(s) (no

Connect bar Pause Pause the reference
version

Connect bar B Transfer map(s) / value(s)
(no dialog)

Configuration > Hexdump  Ctrl+Alt+Win+P Toggle display of pot.
maps in the hexdump

Configuration > 2d Alt+. Toggle display of connect
lines on new line

Map Ctrl+T Swap axistmap

Map sidebar Ctrl+Shift+F Focus search line

- Shift+F12 Open folder with
configuration files

- Shift+Ctrl+F12 Open mail with WinOLS

logfile

(C) 2025 EVC electronic



Special Aspects 37

Cursor + Navigation:
Keys
Scroll Lock

Ctrl+Up
Ctrl+Down

Ctrl+Top
Ctrl+End

Shift+Cursorkeys
Ctrl+Cursor I/r

Ctrl+Shift+Cursor I/r

Ctrl+Shift+Cursor u/
d

T
Shift+T

Ctrl+PageUp
Ctrl+PageDown

Win+PageUp
Win+PageDown

Shift+Ctrl+Alt+F12 Reset symbol bars

Ctrl+H Client menu

Ctrl+Alt+S Sessions menu
Description

Toggle the Scroll Mode. In this mode you can easily
scroll through hexdumps with the left mouse button.

Scrolls the visible area up
Scrolls the visible area down

Moves the cursor to the beginning of the window
Moves the cursor to the end of the window

Moves the cursor and creates a selection while moving

Hexdump: Moves the starting address of a hexdump
Map: For parallel maps, switches to the next/previous
map in the parallel group

Rotates the view (3d mode only)
Changes the view perspective (3d mode only)

Next view mode (Text->2d; 2d->3d; 3d->Slices)
Previous view mode (Slices->3d; 3d->2d; 2d->Text)

Page up (with configurable jump size)
(With shift = Select area)

Page down (with configurable jump size)
(With shift = Select area)

Previous Element
Next Element

Special cases with Alt, Shift, Ctrl:

Keys

Description
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Shift while starting OLS WIiInOLS starts without loading the previously
opened windows.

Ctrl while starting OLS  The simulator status display is not initialized / used

Shift while clicking Connect projects
another project's titlebar

Shift while creating a The automatic map detection is suppressed
map

Alt+ClickDrag Hexdump Scrolling
Alt+ClickDrag Map Move map
Ctrl+Alt+ClickDrag Map Duplicate + move map

Mouse functions:

Keys Description

Left: Click Sets the cursor position

Left: Click+Drag Selects an area

Left: Click+Drag+Citrl Extends the current selection with another area
Left: Doubleclick Opens the menu ‘Properties: Window’

Left: Doubleclick on Opens the menu ‘Go to address’

address column in text

hexdump

Right: Click Opens the context menu

Middle+Ctrl Set line break here

Within 5s at a second spot: Set columns

Mouse wheel:

Keys Description

Mousewheel+Shift Scrolls by pages instead of lines
Mousewheel+Citrl Set zoomfactor / fontsize
Mousewheel+Ctrl+Shift The cursor is moved over the changes cells
Mousewheel+Alt+Shift Rotate 3d view

Mousewheel+Ctrl+Win Change number of columns
Mousewheel+Alt+Win Change number of Rows

Mousewheel+Middle-Click Changes the selection depending the cursor
position in the selection
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3.2

Mousewheel+Middle- As above, but stronger
Click+Shift

Drag and Drop

WinOLS supports drag and drop. You can simply drag a file into the WinOLS
program window and drop it there. You can drag either a file from from the Windows
explorer or an attachment from an e-mail stored in Outlook.

Normally you can only drag one file at a time into WinOLS.

The following file types are supported:
Binary files

OLS and WinOLS files (*.dat / *.ols)
Map-Pack-Files (*.kp)

Selection files (*.blk)

Intel hex files (often *.hex)

Motorola hex files (often *.s19)

Key files (*.scr)

SPI key files (*.spikey)

Ifo files (*.ifo) / Ini files (*.ini) / EcuX files (*.EcuX)
vSpire files (*.vSpire)

The following file types are supported by plugins:

e Vadis VBF files (*.vbf; Vadis VBF Import/Export plugin required)
e Lua skript files (*.lua; External control plugin required)

e ASAP2 files (often *.a2l; Damos plugin required)

e Damos files (often *.dam; Damos plugin required)

All these file formats can be imported while by compressed (as *.zip or *.rar file).
Simply drag the archive file into WinOLS. 7-Zip files (*.7z) can be unpacked if 7-Zip
is installed.

You can integrate third-party command-line conversion software, too.

Tricks:

e Drag the file into an existing project window to create a new version for an
existing project.

e Drag the file into the program itself (for example into the menu bar area) to create
a new project for this file.

e If you're dragging an Intel or Motorola hex file into an existing project you may
press the CTRL key while releasing the file. This will cause WIinOLS not to create
a new version, but write the data over the current version.

e You can drag and drop two files at once when importing '16 bit in two files'.
WinOLS will automatically try to find out which is high and which is low.
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3.3

e ASAP2/Damos files may only be dragged into existing projects. If you drag
ASAP2/Damos file and a binary/hex/... file at the SAME time into the WinOLS
frame, then binary/hex/... file will be imported and the ASAP2/Damos file then
applied to it.

e Dragging a key file into the workspace changes the configuration, dragging it into
the project changes the project.

e If (during the drag and drop process) the target window (WinOLS) is hidden,
simply move the cursor (while keeping the mouse button pressed) over the
WinOLS entry in the task bar (lower border of the screen) and wait without
releasing the mouse button. This will bring the WinOLS window into the
foreground.

e You can drag+drop BSL key files into the BSL info dialog (a subdialog of the
project properties).

Drag+Drop in the map list:

e You can drag a folder into another folder to create a subfolder

e You can drag a project directly into a windows explorer folder or Outlook e-mail to
export it.

e You can drag a project onto another project to connect them.

Floating / dockable dialogs

[+ [ -1 | Odainal | Eiaay [

Preview : Map

Floating dialogs:

WInOLS supports several (so-called) "floating” dialogs. These are dialog windows
that are shown above the normal workspace without blocking it. This means that you
can work with WinOLS normally even though the window is open and (as it looks like
it) lies above the workspace. This allows you for example to work while the search
window is open and shows it results.

You may toggle these dialogs separately (with their respective hotkey, icons and
menu items). Or you may use the tab key (left of the Q-key) to toggle all windows
that can currently be seen.
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You can recognize a floating dialog by its smaller title bar (the blue bar where the
name of the window is shown), compared to normal windows.

All floating windows are "magnetic". This means, if you move the window and get
close to another window or the screen border, then it will jump exactly there to
support a "nice" positioning.

The following windows float:
Overview

Differences *

Map Selection *

Preview *

Search for Byte sequence / Text
Checksum ranges

Project comment

* Only 'floating' if it's not docked

Dockable dialogs:

Three windows are special, because they can have to states. They can be docked to
the window border (left or right) and then aren't floating windows any more. You may
toggle between the two states (docked / floating) by double-clicking its headline. This
works with the following windows:

e Differences

e Map Selection

e Preview

Advanced docking:
By clicking and dragging the window title you can dock the window at the desired
location. This markers can help you:
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3.4

Preview x

0 Unterschiede  Preview

Y
left: helping markers; right: Two dialogs as "tabs"

Move the mouse cursor on one of the arrow markers and release the mouse button
to dock the window to this border. Use the middle field (without arrow) to combine
two dockable windows. The windows will be placed in the same location and can be
switched with tabs at the bottom. To end the "tabbed" state, start the drag+drop not
at the window title, but on the respective tab.

Mouse cursor

WInOLS uses the mouse cursor to display information about what can currently be
done with a click of the left mouse button.

The following mouse cursors are used (apart from the default cursor).

Viewmode "Text’:
1 This cursor appears when you move the mouse over the double line of a
hexdump (right of the address column). Click and drag to move the visible area
vertically.

=:>|]<:=- This cursor appears when you move the mouse over the single line of a
hexdump (between the hexdump and the bars). Click and drag to change the
number of columns.

Viewmode’2d’:
s This cursor appears when you move the mouse over the lower scale. Click and
drag to move the visible area horizontally.
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3.5

1

NS

This cursor appears when you move the mouse over the right scale. Click and
drag to move the visible area vertically.

This cursor appears when you move the mouse over the left end of a selection.
Click and drag to move the beginning of a selection.

This cursor appears when you move the mouse over the right end of a
selection. Click and drag to move the end of a selection.

This cursor appears when you move the mouse over a rowmarker within a
selection. Click and drag to change the number of columns.

This cursor appears when you move the mouse outside a rowmarker within a

% selection. Click and drag to move the start address (and thus the rowmakers).

2

This cursor appears when you move the mouse cursor directly over a 2d value
that is either currently selected by the editing cursor or that is part of a
selection. Click and drag to change the value / all selected values. You can
disable this function in the configuration under "2d".

Viewmode’3d’:
[+<& This cursor appears when you move the mouse over the left or right edge of

=

el

2

the floor grid. Click and drag to change the strength of the perspective.

This cursor appears when you move the mouse over the lower edge of the
floor grid. Click and drag to rotate the view.

This cursor appears either when you move the mouse cursor directly over a 3d
value that is currently selected by the editing cursor or when you move the
mouse cursor over a selection. Click and drag to change the value / all selected
values. You can disable this function in the configuration under "3d".

Scrolling

There are many ways in WinOLS to get to the right place:

Scrollbars:
The WInOLS scrollbars have 3 buttons. From inner to outer they stand for:

e jump to the end of the file
e scroll fast
e scroll slow
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3.6

A click on the scrollbar (outside of the current position) can either (F12 > Hexdump)
scroll into that direction or directly jump to that position.

Hotkeys:

Ctrl+up / Ctrl+Down: Scroll one line

PageUp / PageDown: Scroll one page

Ctrl+PageUp / Ctrl+PageDown:  Scroll 0x8000

Ctrl+Pos1 / Ctrl+End: Jump to the beginning / end of the project
Mouse:

When you're moving the mouse cursor over the double-line (or in 2d mode the
horizontal scale) the mouse cursors turns into a double-arrow. By clicking and
dragging you can now scroll.

Use the "ScrollLock" key (right of F12) to (de)activate a mode where this applies to
the entire window. Or press and hold Ctrl+Shift to achieve the same effect.

Use the mouse wheel to scroll by line. Hold the shift-key at the same time to scroll by
page.

Context menus

Context menus are all menus which appear when you click with the right mouse
button somewhere in the window. These menus contain functions which relate to the
current context (meaning where you click).

All entries in context menus show help texts in the status bar (lower edge of the
screen), when you move the mouse cursor over the respective entry.

The following context menus are used by WIinOLS.

All view modes:

Click in the data: A context menu appears with functions for editing and navigation.
Click in selected data: A context menu appears with functions for changing a
selection and editing the context.

Click in the ASCII or bar data: A context menu appears with functions for changing
the view mode of the right side.

View mode 'Text’ and "2d’:
Click on the headline of a potential maps: A context menu appears with functions for
working with potential maps.

View mode 'Text’:

Click on the single vertical line: A context menu appears with functions for changing
the number of columns.

Map only: Click in the axis description or the upper left corner of the map to quickly
change the unit (factor, offset, description, etc.) of the axis or the map data.
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3.7

View mode ’2d’:
Click on the vertical or horizontal scale: A context menu appears with functions for
changing the zoom factor.

Window 'Map selection’:
Click on a project or map: A context menu appears with functions for opening,
closing, coping and deleting of windows.

Selections

Basics:

If you want to change multiple data fields at once you must select them first. That
works just like in any other Windows application: Click somewhere (with the left
mouse button), hold the button pressed and move the mouse. You've got selection.

Selection modes:

WinOLS can select with 4 different styles: Consecutive, Rectangle, Rows or
Columns. Just try them out. You can see the currently selected mode in the menu "
Selection > Selection mode", in the default context menu and perhaps in the toolbars
if you have the 'Selection’ bar activated. WinOLS stores the selection mode
separately for 2d/non2d and for hexdump/maps.

Trick: You can change a selection later if you chose the wrong mode. In order to do
this, just finish the selection as usual and change the selection mode immediately
afterwards. The selection will change into the new mode.

Trick: In text mode you may select rows by clicking on the address column.

Configuration:

WinOLS supports two different selection modes. The currently selection method can
be seen in the Configuration dialog (“Miscellaneous > Configuration > Miscellaneous
> Edit“) under 'Delete selection when moving the cursor’.

If this checkbox is activated, selections immediately disappear if you change the
cursor position. That's the way it is done in many Windows applications. But this
makes so-called multiple selections a bit more difficult. If you want to add another
block to the current selection you must hold the 'Ctrl’ key pressed.

If the checkbox is not activated you can simply select again to extend the current
selection. If you want to unselect everything, use the 'Delete’ key.

Specials:
There are some special items in the 'Selection’ menu. They allow you to select all
currently visible cells or to invert the selection.
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Clipboard:
As usual, you may copy the current selection and insert it somewhere different.
Small selections may even be pasted into the search window as search text. You
can also copy values from / to Microsoft Excel
Load and Save:
You can save selections on your harddisk and load them later on again. This creates
'blk’ files. You will find the necessary commands in the menu 'Selection’. If you want
to load a selection, you may also drag and drop its file into WinOLS.

3.8 Elements
Basics:

Nowadays one ECU can contain data in multiple eproms, processor, eeprom, etc.
That's why WInOLS can administrate these different data ranges, too. In WinOLS
they’re called "Elements".

One project can contain many elements (but at least one). Each element contains
the data from one hardware, e.g. from the eprom.

Seeing the elements:

By default WinOLS will show you the eprom element. You can recognize that from
the title of the WinOLS window: "WInOLS - 1134.0ls (Original) as Engine / Eprom". If
you have an element active, the map list will contain only the maps (and potential
maps), which are in this element. Other functions like the "Differences" window or
the search function ignore the data outside the current element, too. Just like export
functions that only support one element (e.g. the binary export) and thus only export
the current element.

Please note: By default all elements begin with the address 0. Thus, you can have a
map in the eprom element at the address 0 and a map in the CPU element at
address 0. Nevertheless these are different maps with different content.

Changing the current element:

You'll see a small black triangle next to the button "Properties: Project” (a green P on
the symbol bar "Navigation"). If you click on it, a small menu will open, displaying all
the elements that the project contains. Click on the desired element to activate it.

BEE- 7 8 o

e | B <Al elements =

Engine | Processor

Engine [ Epraom

Engine [ Cu:unfiguraticu!!
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3.9

Instead you may also (if the project contains multiple elements) change the "ECU
usage" in the Dialog "project properties” to get the same effect.

Hardware elements & virtual elements:

Some of the checksums (and the free plugin OLS550) define virtual elements within
the "normal" hardware elements. These can be seen as subitems of the hardware
elements in the selection list and can help to limit the view to the essentials. Virtual
elements are very often "data" elements and are then also used as help for the
similarity search.

<All elements>:

The list with the elements also contains an entry "<All elements>". It shows all
elements at the same time in one, long hexdump. This can be useful if you want to
define the elements or if you're unsure which element contains the maps that you're
looking for.

Editing & defining elements:

WinOLS automatically creates the elements when reading an ECU or importing from
a BdmToGo file. Many EVC checksums also automatically create the elements for
you. If you want to change this definition, open the project properties and click the
button "..." next to the ECU usage. The help for this dialog "Multiple elements in the
project” (a subdialog of the "project properties”) explains the details.

Elements vs. Versions:

One project can contain several elements and any number of versions. For all
versions of one project the element definitions (Number, size, area) are identical. So,
for example, an eprom element in the original cannot have a different size from the
eprom element in version 1. If you change the current version, this change always
applies to all elements of the project.

Data areas

Data areas are virtual elements that are marked as "data". They are usually
determined automatically by the free plugin OLS550.

The similarity search automatically takes data areas into account and can therefore
also suggest projects that have a completely different size, as long as only the data
area is similar enough. These projects cannot be used directly as a basis, but you
can import their maps / changes.
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3.10 Clients
Basics:
Clients allow you to quickly switch between eprom file data paths. This influences the
project open function, searching for similar projects and creating new projects.
Clients make it easier for you to sort your projects. This way you can create folders,
e.g. for:
e Major customers
¢ Old projects
e Employees
¢ Finished / Unfinished projects
Creating clients:
You can configure the clients in the configuration (“Miscellaneous > Configuration >
Paths > Clients”). You can also assign names to your customers to make it easier to
administrate them.
Changing the current client:
You can find the client icon (a hat) in the "Navigation" toolbar and in the dialog
"Open project” which allows you to switch between the pre-configured clients.
Consequences:
Projects that do not belong to the current client (and reside in his folder) are invisible
for the WIinOLS file functions. They do not appear in the project list and are not
taken into account for functions like "Search similar projects” or "Update projects"”.
Projects that are already open when the client is changed remain with their old client
and will continue to be saved to his data path. But they also refer to current data
path (and not to their own) for file functions like "Search similar projects”. To move
an existing project to a different client, right-click it in the "Open project” dialog.
If you create a new project (through the "New" menu item or by drag and drop), then
this project will always be created for the current client.
Shortcuts
Symbol bar: ﬂ
Keyboard: Ctrl+H
3.11 Reseller

Basics:

Reseller are a method to let WinOLS-users transfer or sell projects to other users.
To publish projects, you have to be registered at EVC as reseller. To receive data
from resellers, you only have to be accepted as customer by a registered reseller
(and then use the WInOLS update function). You will then have the option to use the
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3.12

"Open project” dialog to access the reseller's data as if it was stored as a client (hat-
icon).

Credits:

The base for the billing between reseller and customer are credits. Each project
costs 10 credits by default, but the reseller may use the project properties dialog to
enter a different value (including 0). A separate account is maintained for each
reseller/customer combination. The real value can be negotiated between reseller
and customer.

Version credits:

You can also offer individual versions (or the original) for sale separately. The

customer then receives the original and, if applicable, the corresponding version, as

well as all other project data such as maps, comments, etc. when purchasing. To

use this feature, you must enter a credits price in the version properties and fulfill the

following conditions:

e The version name must be unique within the project and between 3 and 50
characters long

e The version name must not contain any special characters (e.g. \ ")

e The credits must be >0 and <project credits

e The project must not contain more that 50 versions

e The original is a normal version and can also be offered for sale. It is supplied with
the maps.

¢ You can offer original-only projects (without maps) at a flat rate via the
corresponding option in your evc.de account.

Reseller registration:

If you want to become reseller, you have to purchase the product Res-Start once.
After the registration you will be configured as reseller when you start the update
function the next time. A special client (with a corresponding folder in the file system)
will be created. WinOLS will store all projects that you keep here on the EVC server.

Online:

e List of all available projects and resellers
¢ Detail information

e FAQ: Reseller

Command line

WiInOLS understand command line instructions. This allows you to:

e Pass WInOLS files for opening them (e.g. by dragging the onto the WinOLS icon)

e Export BxxToGo files by putting the parameter /ConvertBdmToBinaries in front of
the files. WinOLS will export the individual elements as binary files.

The following commands are also supported:
e /Service
Required parameter if WIinOLS is started as NT service.
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e /Console
Starts the service console to configure the NT service. WinOLS must be started as
administrator to communicate with the service.

e /StartService
Only in combination with /Console: Starts the NT service if it is not already running.

Clarification:
This page is about parameter for starting the program. There's also a window named
"Command-line".

3.13 Language

Basics:

Starting with version 2.42 WIinOLS support multiple languages for map properties.
This mean that for example the property "map name" can contain multiple values,
but only one is shown at a time. You can switch to another language any time using
the project properties dialog or the map list menu. In the map tooltip of the map list
window, you can also see the values of the other languages.

Tip:
You can use the WIinOLS plugin OLS540 to perform a machine translation from
German to English.

3.14 Sessions

WinOLS saves automatically which projects / windows are currently open and
restores this during the next start. You can keep up to 10 of these saved states as
"sessions".

Changing the active Session

Click on the session button in the dialog Map selection and choose the desired
session. The projects of the current session will be be closed. If there are any
unsaved changes, you will be asked if you want to save them. Then WinOLS will
open the projects / windows of the selected session.

Shift: Renaming a session
Keep the shift key pressed while selecting a session to rename it.

Ctrl: Copy session

Hold the control key pressed while selecting a session to copy the list of opened
projects to the selected entry. (Note: This copies the list of projects. Not the actual
projects.)

Shift+Ctrl: Swap sessions
Hold the shift and control key pressed while selecting a session to swap the current
and the selected session. This swaps both the name and the list of opened projects.

Shortcuts
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Symbol bar:
Keyboard: Ctrl+Alt+S

3.15 WInOLS as service

You can run WIinOLS as service to perform automated tasks in the background. This
option is suitable only for people with experience in software development,
administration of NT services and administration of batch systems.

Software Requirements:
e A windows PC with WIinOLS license
e OLS530 (LUA for WinOLS)

Skill Requirements:

e Experience in handling services and the traps of Windows user accounts
e Software development with LUA

e Software development with batch systems

Steps for the installation: (WinOLS4/5)
1. Install WinOLS normally
Register + install plugins
Check if everything is registered + the registration password stored
2. Create a new Windows "Shortcut" to the WIinOLS icon. Edit it and add the
parameter "/console” and set it the "Run as administrator”. (Both changes must
be done on the page "shortcut".)
. Start WinOLS with that shortcut. It should open in service console mode.
. Uninstall the old service, if needed
. Install the service and select the LUA file to run.
. Start the WinOLS service.
. Register the WIinOLS service
. Stop+restart the WinOLS service

oO~NO Ok W

Notes:

¢ After the successful start of the service it can still take time until the plugins are
loaded and LUA is started.

¢ Do not start the normal WinOLS if the WIinOLS service is already running. This will
cause file access conflicts.

3.16 Protections

WiInOLS knows several mechanisms to protect your data.

OLSX-Password

Where: In OLSX file format

How: While exporting as OLSX

Function:  Import only possible for selected EVC customer number and/or
password.

(C) 2025 EVC electronic



WinOLS 5.74

Self-lock-  Yes, if foreign EVC customer number required or password lost.
out:
Disadvanta Works only until file was imported. No protection after that point.
ges:

Bdm2Go/Bsl2Go reimport protection

Where: In Bdm2Go/Bsl2Go file format

How: While exporting as Bdm2Go/BsI2Go

Function: Disallows the import into WinOLS (import into Bdm2Go / Bsl2Go is still
allowed)

Self-lock- No

out:

Disadvanta Works only until file was programmed. No protection after that point.
ges:

NOREAD (external programs)

Where: Text in Hexdump

How: Entry in external program

Function:  Disallows import / reading; Works in many, but not all programs.
Self-lock- Yes

out:

Disadvanta Can be removed with hex editor.

ges:

NOREAD / BDM2GO (WinOLS)

Where: Text in Hexdump

How: Project properties (Globally in Miscellaneous > Configuration > Read
protection)

Function: Disallows import / reading; Works in many, but not all programs.

Self-lock- No

out:

Disadvanta Can be removed with hex editor.

ges:

Comment: Requires EVC checksum or manual Tag-Patchblock (Edit > Checksum >
Add).

NOREAD (WinOLS Signature)

Where: Invisible signature in hexdump

How: Edit > Sign Hexdump

Function:  Disallows import / reading; Works only in WinOLS.

Self-lock- No

out:

Disadvanta Works only in WinOLS.

ges:

Comment: Requires semi-manual inserting in user-selected maps.

Encrypted versions
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Where: In .ols files

How: Edit > Miscellaneous

Function:  If you encrypt them with your customer number then your .ols projects
cannot be opened in case of unauthorized sharing of the files.

Self-lock- No

out:

Disadvanta Doesn't protect against export
ges:

Comment: The encryption happens only when the version is saved (again).
3.17 Shadow data

Some of the export plugins require additional data (beyond the hexdump data) for
the export. This is the "shadow data", as it is are usually barely noticed. WinOLS
automatically saves it in the project file. (per project, not per version.)

If a project contains shadow data, you can see this in the project properties (in the
project size field).

They are also relevant for similar projects. WinOLS warns you if you choose an
action which causes the loss of the shadow data.

As a consequence, these plugins cannot export without this data, so this option may
not be offered at all. You can only export the projects you have imported with the
same plugin.

3.18 View mode

WinOLS can display maps / hexdumps in different ways. You can change this type
at any time with a click on the tab at the bottom left of the window. Your choice will
be saved per map in the project.

You can define the default value for new maps under F12 > Hexdump. You can
change the value later with Edit multiple maps for many maps at the same time.

Text mode:
Allows an exact view of the values. Bars and/or ASCII characters can be displayed
to the right of the values.

2d:
Facilitates the visual recognition of maps in the hexdump. The View toolbar can be
used to scale the display.

3d:

Good visual representation for maps. With the toolbar view the display can be
rotated+scaled.

Slices:
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3.19

Alternative visual representation for maps where all lines are at the same height,
which facilitates comparison. With the toolbar view the display can be
rotated+scaled.

Twin windows:

» Video

You can use several view modes at the same time for hex dumps and maps. To do
this, hold down the Ctrl key when clicking on the tab.

Note: Layers and twin windows were added later and are part of the WinOLS feature
updates, i.e. they may need to be unlocked by paying a fee.

Shortcuts:
Symbol Bar: -
Keyboard: T/ Shift+T

International characters

WinOLS supports various languages. You can select the current language under
F12 > Language.

1. Wrong characters in menus and dialogs:
Please check in Windows if the "Language for Unicode incompatible programs" is
set correctly:
Windows Settings > Language and Region > Administrative Language Options >
Administration
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¥ Region x
Formatz  Administrative

Welcome screen and new user accounts

View and copy your international settings to the welcome screen, system
accounts and new user accounts,

®y Copy settings...

Language for non-Unicode programs

This setting (systemn locale) controls the language used when displaying
text in programs that de not support Unicode,

Current language for nen-Unicode programs:

English (United States)

[ o Change systern locale...

QK Cancel Appl,

2. Wrong characters in hexdump and map list:
Please check if the "Script" of the font is correctly selected in WinOLS under:
F12 > View > Select font

(C) 2025 EVC electronic




56

WinOLS 5.74

nfiguration

Schriftart

Schriftart

Schriftschnitt: Schriftgrad

ourier New

ays vertically
=d spin-buttons shouldnt use standard direction |

=t one empty project open

urned off

15

[ ok

Fett Kursiv 14

= & Paths
high-esolution displa

Line thick

xdump + map:

arch re

Addtional line height:

3. Ini-Files and Combo-Box-Templates:
Save the file in "Ansi" or "UTF-8 with BOM" format.

Beispiel

RaBbYyZz

Abbrechen

Skeript:

[ Westlich
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4

Commands of the menu Project

The menu Project contains the following commands:

New

Open

Open version
Close

Save
Save all

Properties: Project
Properties: Version

Find similar project

Find dupilcate
objects

Update all projects
Ex - & Import

Print

Print preview

Configure printer

Exit

Creates a new empty project

Opens an existing project

Opens a different version from the current project
Closes an open document

Saves an open project under its filename
Saves all open projects under its filenames

Shows the properties of the current project

Shows the properties of the current version of the
project

Searches all projects of the current client for similar
hexdump data
Searches all files for versions which exist twice.

Updates information in all projects

See below

Prints a document

Previews a document as it would look like when printing

Selects a printer and a printer connection

Exits WinOLS

The Submenu Ex- and Import contains the following items:

Import File
Export File

Send project as Mall

Creates a new version from a raw-file.
Creates a new raw-file from a version.

Creates a new E-Mail and appends the current project
as attachment.

(C) 2025 EVC electronic



Commands of the menu Project

Import directory

AutoUpdate +
Autolmport

Export CSV map list

Update map list on

basis of CSV file

Export map pack
Import map pack

Import maps
Import changes

Import Damos &
ASAP2

Export project
properties
Import project
properties

Translate map texts

59

Imports entire directories into the WinOLS directory
Trigger + Configure AutoUpdate and Autolmport

Creates a (with Excel readable) CSV file containing a list

of all maps

Updates the map in the project with the changes in the
CSV file.

Exports a list of all map into a KP file, for a later import
Imports a previously exported KP file

Imports all maps from one file into the current project

Imports maps from another project, even if they were
moved to another address.

Allows you to import maps from DAM or A2L files. This
function requires the Damos-Plugin

Exports the project properties as ini file.
Imports the project properties from an ini file.

Translates the map, axis and folder description into
another language.
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4.1 The command New (Menu Project)

(23 1149.0ls (Qriginal), , Hexdump o= | ]
You've just created a new project.
Please choose a data source:
BEDM 10001 519
BSL
File .
[ |Bsl-To-Go Files
SEE 10000 BsIToGo

o et I'I:._\ el C; P )
NewGenius 10001 BslToGo

You can also drag files from the Explorer/Cutlook into this window.
Fip+Rar are fine.

Use this command to create new projects in WinOLS from an existing binary file,
eprom or ECU. The empty project will display the options as shown above.

By clicking on [...] you can choose the paths from where the files are displayed in
this dialog. (WinOLS automatically hides file that probably aren't useful here, like *.

ipg.)

Tip:

If you keep the shift key pressed, while clicking the icon in the symbol bar, the file-
import dialog will be opened after the new project windows was opened.

Note:
Use the Open command instead if you want to open an existing WinOLS project.

Shortcuts

Symbol bar: ﬂ
Keyboard: CTRL+N
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The dialog File format

File format

What file format do you want to process?

\ary files (Low/High)
OLS file, current project version
OLS file, all project versions
encrypted OLS file, current project version
encrypted OLS file, all project versions
Intel-Hex
Motorola-Hex
Ecux
EcuX, al project versions

All elements
Al elements
Al elements
All elements
Al elements
All elements
Al elements
Al elements
All elements

# ols

* ols

# olsx
* olsx
*_hex
#3519
#_Ecux
= EcuX

61

Ll 1. [P B all 0o e - ]

[] Tempararily delete checksums+synchlocks before export
] Compress as ZIP-File [J..as7z
Also export: [ ini {Project properties)

[] cav (Maps) [ jsan (Maps)

(ffset & address area:

[] Start address: (Min: 0)

] End address: (Max: VFFFF)

hecksum status: Mo C5

oK Cancel

This dialog is shown during import and export. You can configure the type of file(s)
you want to import/export. At the top you can choose file format. Several formats are
available. Some of them are only visible depending on the project type selected in
the project properties or if the respective plugin is installed. (Export: Plugins may not
appear due to shadow data restrictions.)

All of the following options are only visible if they are supported by the selected
format:

Individual checkboxes:
e Temporarily delete checksums + sync blocks before export [Only export]
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Removes the mentioned properties and restores the original values (only while
exporting)
Compress as Zip-File

Create new version

Creates a new project version when importing (instead of overwriting the current)
This file may not be reimported into WinOLS

The created file can only be used in BdmToGo / BsIToGO. Not in WinOLS. (This
option does not modify the programmed data and thus does not offer any
protection against re-reading the data from the ECU. To get that kind of protection,
activate the option "BDM read protection” in the dialog "Properties: Project". It will
place a marker into the data and thus the re-read project can only be imported into
a WInOLS that is registered to your customer number.)

Export only active element

By default WinOLS exports always the entire projects. For some file formats you
can limit the export to individual elements (if there are several).

File version

For compatibility reasons you can export an older version of the ols file format.

Code data & swap lines:

It is possible to encrypt data and lines just like it would be done with the integrated
eprommer. In oder to activate this option you must enable encryption in the producer
dialog and select a key file.

Optionally swapping of data lines can be activated, which is done just like it would be
done when you are using the integrated eprommer. In order to activate this option
you must select a producer and activate the swapping of data lines.

Offset & address area:

Here an offset can be configured for Intel-Hex / Motorola-Hex files for the addresses
in these files. Furthermore an address range can be configured if you want to handle
only a part of the project. When importing this option is only available if the project
already contains a version. It is always available when exporting.

For Intel-Hex / Motorola-Hex files you can tell WinOLS to mimic the file format of the
imported file. This is only available when the file was imported from the same file
format. It helps you communicate with other programs that require the file to have a
certain format (within the standard).

Project rights:
Allows you to configure the project rights when exporting to limit the rights when the
file is reimported.

Password and customer number:
You can make sure that the file can only be imported if you know the password and /
or use a WinOLS with the right customer number.
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Security areas:

You can choose up to 3 areas, which should be compared with the ECU before
programming. This was introduced to protect the user from using the wrong ECU
and it is also a copy protection for your work. Simply include the VIN into the
checked areas and the file can only be programmed into the desired vehicle (and not
into all other similar vehicles). It is recommended to mark the areas by comments. If
you use the comment names "BDM1", "BDM2" or "BDM3", WinOLS will recognize
the comments and automatically enter the marked areas into this dialog.

Which elements should be exported?
Here you can select which elements should be programmed later on. Elements that
contain differences between original and version are printed in bold.

Shortcuts

Symbol bar: -
Keyboard:

4.2  The dialog Open (Menu Project)

- Select ECU for VonAxs
(@ | MNECUs | Today | Vesterday [ 7days [ 8 [ C[ 0 [E[F ]G [H[1 [k 0 <] -5

4 Producer Chaszis ki odel Output it

4 3

Search far: * | Al Entries

ak [ Cancel ] [ Filter inztead of search Ornly wizible colurmns
RBemember zearch

This dialog allows you to search, manage and open projects. It lists all files in the
current project folder.

Clients:
You may use the hat icon in the upper left corner to change the current client and
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thus folder. Furthermore you may choose to display the data from all local clients at
the same time.

The client menu also allows you to view the data from resellers. You can see and
purchase their projects directly from this dialog. This function requires an internet-
connection.

To the right of hat icon, a button displays the last reseller used.

Column sets:

Right next to it, WinOLS can display a selection for the currently selected columns.
(This feature must first be activated in the options: Cog icon in this dialog). This
allows you to switch between different column configurations. Just like in the
Sessions menu, you can manage the menu items with: Shift=rename, Ctrl=Save
current configuration there, Shift+Ctrl: Swap.

Filter tabs:

Use the tabs on the top of the dialog to choose if the want to see all projects,
projects that were changed today or projects where the producer begins with a
certain letter. You may also activate the letters with the hotkey Ctrl+A to Ctrl+Z. To
select which tabs you want, click on the tabs using the right mouse button.

Tab 'Purchased / Limited':

This tab only displays projects that you have purchased from resellers or for which
the rights have been limited. For technical reasons, the 'Purchased' state can only
be saved in ols files since Q2/2018. Therefore, it is determined at the same time
whether the rights for the project are limited (which is often the case with purchased
projects) also taken into account.

Colors / formats:

The following colors are used (per line) in the list:

e Blue: This project file is currently locked (might be in use in WinOLS on another
computer)

e Red: This project is currently opened on this computer.

e Green: You already purchased this reseller project. (For reseller lists and own
projects purchased from Q2/2018 onwards.)

e Cyan: The rights of these projects are limited.

e Bold: When using the function "Search similar projects”, the columns "ECU-Nr.
ECU" and "Software" are printed bold if they match the current project.

e grey: When using the view "All Resellers", this color indicates that you're currently
not a customer of this reseller.

Sidebars:

Using the 3 icons at the top right corner of the dialog you can:

¢ Statistics about during which time period how many projects were created/
modified. This data refers to the current selection or (if there is none) to all projects
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of the active client.

¢ View statistics about the files in the current view. If you select 2 or more projects,
then the statistics will be calculated about the selection. You can use searching
and sorting in combination with this feature.

¢ View the versions in the selected project to make it easier to choose the right
project. If you double-click a version, WinOLS will open it directly (without
displaying the Open Version dialog).

Search function:

You may also simply type into the list to just to the next entry which begins with the

letters that you enter. The letters that you enter will appear in the combobox at the

bottom. If you activate "filter instead of search”, the project list will show only projects

that match your search string.

e -Negative: Type a minus sign in front of a word to exclude all projects that contain
this word from the results.

e "exact words": Put words in quotation marks to search for projects that contain
these words in exactly this order (and not just the individual words).

¢ "one, ortheother": Separating words with a slash (or the word "or") means that it's
okay if only one item in this group is found.

Context menus:

The tabs and calendar headers have their own context menu that can be accessed
by right-clicking them to change configuration settings. By right-clicking one or
multiple projects you can access another context menu. Here you have options to
edit, move, or send by e-mail, to export the list as text or perform a mass export of
the files.

Copy / Move projects:

You can right-click selected projects in the list and copy / move them to other clients
(or any folder). Directly in front of the list of clients there is the "and update" option. If
it is switched on, the function "Update projects” with the currently saved settings is
also applied directly to the projects when copying / moving. Irrespective of this, the
menu option "Copy to Reseller Upload..." is available when copying. Here the
destination folder is already preset, but in the following dialog (which can also be
skipped with the shift key) you get further options especially for resellers.

Excel export: (This function requires WinOLS 5.25 + FeatureUpdate)

You can have a selection exported as an Excel file and then edit it in Excel.
Important: If you want to import the changes later into WinOLS, then the column
"File name" must be exported.

Excel import: (This function requires WIinOLS 5.25 + FeatureUpdate)
You can apply the changes made in Excel to the WinOLS projects. Either by right
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clicking in the list or by dragging the Excel file into the list.

Search for this: (This function requires WinOLS 5.25 + FeatureUpdate)

This transfers the value of the clicked cells into the search line of the dialog. Instead
of the context menu function you can also use Alt+mouse click. Additionally press
Ctrl and add the cell text to the search rows. If you press Shift additionally, the text
will be preceded by a minus sign, so that you exclude this text from the search.

When all / some projects are missing:
Help

Shortcuts:

Symbol bar: ﬂ
Keyboard: Ctrl+O

Within the dialog:

All clients Ctrl+Alt+A

My resellers Ctrl+Alt+R

All resellers Ctrl+Win+Alt+R
Letter-Tab  Ctrl+A to Ctrl+Z

When all / some projects are missing

Don't panic
WinOLS does not delete projects (unless you explicitly command it).

If you have deleted projects unintentionally yourself

WinOLS deletes projects into a separate trash folder and keeps them for 30 days.
You can reach this folder by clicking on the hat icon in the Open project dialog. Move
the project to the desired folder by right-clicking on it.

Defective / foreign projects

Projects that caused crashes are automatically moved to the CorruptFiles folder.
Projects that were purchased with another user account and therefore cannot be
opened are moved to the ForeignFiles folder. Both are subfolders of the respective
client folder.

Is a search function active?

Please check whether you are currently using a search function:
e Tab at the top

e Search line at the bottom

e P-Icon below (red = active)

e Special search (Black triangle next to P icon at the bottom)

e Non-developer mode

Non-developer mode
It's possible that only some of your files are displayed and the title bar of the window
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contains the text 'Only finished projects’. If this is the case, then you've activated the
non-developer-mode. As a consequence you can only see / open finished projects
and you cannot change them. To reactivate the developer mode, open the
configuration menu, go to the page 'Miscellaneous’ and uncheck the 'Non-Developer
Mode'.

If all projects are missing

You are probably just looking at the wrong folder.

e Change the client by clicking on the hat icon

e In the configuration dialog select the correct folders with their .ols files as clients. If
you do not know where your projects are stored, click [...] in the mentioned dialog
and let WinOLS search for them.

The dialog Mass export (contxt menu)

Target folder:

Export coverage:

@) Original and all versions into one file

1 Original and all versions into separate files

1 Only ariginal
Target format:
1 0LS file Intel-Hex
@) encrypted OLS file Motorola-Hex
Binary BdmToGo
Adjust filemame:

Insert
[ Underscores instead of spaces
Make filenames unigue by adding numbers, if necessary

The adjusted filename will be appended to the target folder. You can use the backslash (V) to spedfy
subdirectories.

Preview for the current project:
0.0kw Criginal . olsx
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The dialog mass export is a subdialog of the dialog 'Open project’ where it can be
reached through the context menu. It allows the export of all previously marked
projects. Here you can choose which version shall be exported and in which format
this should be done.

You can enter your own template for the file name. Use the Insert button to access
all available text blocks. The template can contain a backslash ("\") to create your
own structure of subfolders.

Examples for "Adjust file names"

¢ %ECU.Producer%\%File.Filetitle%
(Depending on the Ecu-Producer into a folder. All versions in one file.)

¢ %Vehicle.Producer%\%Vehicle.Series%\%File.Filetitle%_ %More.Versionname%
(Folder structure by vehicle. Each version in a separate file)

The dialog Search and replace in projects (context menu)

Search and replace in the project properties | 2 i‘s-]
Search:
Search text: | -
Replace with: -
Match caze Only in vizible calumnz
Rezults:
File:
Column;
Tt
Beplace Replace all | lzl LCloze

RS ~

This dialog allows you to search and replace texts in the properties of all selected
projects. Changes will only be performed if you use the button 'Replace’ or ' Replace
all'. This will change the project file in such a way that the search text will be
replaced.

Note:

The button 'Replace all' performs the replacement operation for all projects in
guestion directly, without asking. Use it with care, because the changes cannot be
undone..

Note:
This Dialog can only be reached via the context menu of the dialog 'Open (Menu
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Project)'.
Shortcuts

Symbol bar: -
Keyboard: -

4.2.4 The dialog Search in projects (context menu)

Search in projects

Search for: Hexadedmal ASCII

Search in:

Found projects:

Project Wersion

This dialog is used to search for projects. You can search for specific hexdump/
characteristic values as well as for specific characteristic diagrams, or combine both.

Examples:
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Search for all projects that contain "AA BB CC" in the hexdump.
Search for all project versions that contain a map with the name part "Abc*", which
contains changes.
Search for all project versions that contain the name part "*Stage*" and a code field
with the name part "Abc*", which contains the decimal value "1000".
Tip:
Because the projects have to be opened for the search, this function is relatively
slow. In the 'Open (Menu Project)’ dialog, only select the projects where the search
makes sense beforehand.
Note:
This dialog can only be accessed via the context menu in the 'Open (Menu Project)’
dialog.
Shortcuts
Symbol bar: -
Keyboard: -
4.3 The dialog Open version (Menu Project)

F | Select the version EE

Froject:

Wersions: Comments:

""" | Duplicate. .. | Current version | Al versions | P'ru:uieu:t|
,
Delete
Az Original
0 map(z] that are different fram the ariginal:
Addrezs Mame Size
Created: ?

Changed:  08.07.2008 [16:02:45)

[ ok ][ Cancel ]

This dialog allows you to select and manage the versions of a project. With the
buttons of the same name you may duplicate version, change their descriptions or
delete them. You can drag+drop versions in the tree to change the version folders.
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Versions that are already open are printed in bold.

Use the button ‘As original’ to convert the selected version into the original version.
As a consequence all future comparisons will use this version. The former original
version will not be deleted; it will be stored in place of the currently selected version.
This function swaps the hexdump data, but not the additional version information.

The button ‘Swap’ can be clicked if two versions are selected (for example by
ctrl+mouseclick). Use it to swap the selected versions. This function swaps both the
hexdump data and all additional version information.

Furthermore you may view and edit comments for all versions and for the project
itself on the upper right corner of the dialog. Use the tabs the select the comment
that is currently displayed. You may also view (but not edit) a summary of all
comments

In the lower right corner a list is displayed. It contains all maps which are changed in
this version from the original version. It will automatically be generated and cannot
be edited.

Version folders:

By default versions are simply listed, but you can also use version folders to
organize them. This has no influence on the program behavior, but only affects the
display of the version list.

Any version can serve as folder to another version. Furthermore you can use
abstract folders (which are just folders, but not a version) which can also contain
other versions. To change the version folders, simply drag a version to another place
in the open version dialog or edit the version properties and change the parent
folders. To get a version back to the top level, simply drag it far to the left.

You can sort the version tree using the tabs. If you hold down the Ctrl key while
clicking, the tree is not flattened into a list.

Shortcuts:

Symbol bar: ﬂ
Keyboard: Ctrl+Shift+O

Note:
If the hotkey doesn't work, a graphic card software is reserving it. Test it on
F12>Debug.

4.4  The command Close (Menu Project)

Use this command to close all windows concerning the active project. WinOLS will
ask to save any changes before closing the project. If you're closing the project
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without saving, all changes since the last save will be lost.

Shortcuts
Symbol bar: -
Keyboard: -

The dialog Save changes (Menu Project)

The project has unzaved changes:
File: 1147 alz
Dezcription: L

Which part of the changes do you want to zave?
Save changes in eprom contents

Save changes in zettings / map structune

oKk | Cancel | | Close WITHOUT saving |

This dialog will be shown when you close a project and still have unsaved changes.

Use the two checkboxes to configure which part of the changes to want to save. You
can save changes in the eprom data independently from the changes in the map
structure. The checkboxes only take effect if you confirm the dialog with ‘Ok'.

If you leave the dialog with ‘Cancel’ nothing will be saved, but the project won't be
closed either. No data will be lost.

With the button ‘Close WITHOUT saving‘ you will (no matter whether checkboxes
are checked or not) leave the project and discard any changes.

Shortcuts
Symbol bar: -
Keyboard:
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4.4.2 The dialog Save changes (Table style) (Menu Project)

WinOLS - Save change [——c—

There are unzaved changes in these project(s]:

Froject File Sawve eprom? Save maps?

L 1147 .aolz e
Audi A4 Audi-a4-20..

I Maone I l MNone

Mote: Changes in eprom and changes in the map structure may be saved independently from another,

oKk || Cancel | | Close ALLWITHOUT saving |

This dialog will be shown when you close WIinOLS and still have unsaved changes in
at least one project.

Use the table to configure which part of the changes to want to save. You can save
changes in the eprom data independently from the changes in the map structure.
The configuration done in the table does only take effect if you confirm the dialog
with ‘Ok’. To change the table, either click on the button ‘all’ or ‘none’ below the
columns or click directly on the word ‘yes’ or ‘no’.

If you leave the dialog with ‘Cancel’ nothing will be saved, but the project won't be
closed either. No data will be lost. WinOLS will not be closed.

With the button ‘Close ALL WITHOUT saving‘ you will (no matter how the table is
configured) leave all projects and discard any changes. There will be no further
guestions.

Shortcuts
Symbol bar: -
Keyboard:

45 The command Save (Menu Project)

Use this command to save the active version of the current project under its current
name and directory.

Often you'll have several windows for the current version opened. Not the window,
but the version is saved, so this command affects all windows of this version.
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Shortcuts

Symbol bar: E
Keyboard: Ctrl+S

The command Save all (Menu Project)

Use this command to save all opened project versions.

Shortcuts
Symbol bar: -
Keyboard: Ctrl+Shift+S

The Dialog Properties: Project (Menu Project)

[Project propertie: [ e |
Client: ECL: File:
| Mame: I:I - Use: Ergire - File: 1149.als
= Folder:
Li late: Elements: | ... -
iR L] Created: 2806 2012 [12:50:47)
Project state: |in development - Producer: - b th |
Build: - Changed: 2R.06.2012 [12:50:47)
Whicle: ECL-Nr. Prod. by th
a-Bit zum: 0000 [Cpu:0000 Eprom:0000) =
Type: Passenger car - ECU-Mr. ECL -
Froducer: - Software: Beseller.
Chassis: - . WEIgion; Price: Credits
Modek - Software size; 0 - Project type:
Modelyear: - Checksum: Details:
WIN: Proceszor: not recognized
Communication:
User defined: Engire: Epraom:
Eenutzer 1: Mame: KEY code: l_l
SPI code: B
Benutzer 2: Twpe: - |—|
) Fead hardware: hd
Benutzer 3: Dizplacement: L =
Project type: | .. | Binary data -
Benutzer 4: Olutput: P5 K
o MHoread marker zertag:
Benutzer 5 Transmission: - 71 Spi marker
Emission std.: - Bdm/B sl pratection

[ Ok ] | Search vehicle data | &+ | @I \E \;/El | LCancel |

The properties of the active project may be edited with this dialog. If the project
contains several versions the data displayed in this dialog applies to all versions. To
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make browsing your projects easier it is recommendable to fill in this dialog and use
consistent values. To help you WinOLS automatically corrects many common wrong
notations. You can configure this under "Miscellaneous > Configuration >
Automatically".

A click on the hyperlink 'Client’, 'Vehicle', etc. shows the properties of the other
currently open projects as a menu. Click on a menu line if you want to use these
values.

Client:

Enter the customer details here for your reference. The customer details can be
used in reports. Use the button [...] to reach the customer list dialog. If you use the
project state "in development" then the profile is hidden from WIinOLS users that
have the "non-developer" mode active. If you mark the project as "master"” then it will
displayed with higher relevance in the "Import similar" dialog.

Vehicle:

The fields ‘Producer’, ‘Chassis' and ‘Model* can easily be filled in with the mouse.
Just click (in the uppermost field) on the arrow to get a list. Immediately after you
made your choice, the further drop-down lists will be filled with the matching data for
the selected producer (or producer and chassis).

User defined:

In the lower left corner you can see 5 fields that you can use for your purposes. You
can edit the field name by clicking on the blue underlined text. (The 5 field names
are the same for all projects.)

ECU:

The field 'Elements’ allows you to select the currently active element. Use the button
"..." next to it to get to a subdialog which allows you to configure the elements in the
project.

The field 'producer’ is important for the automatic map search. An incorrect or empty
value can decrease the number of found maps because WinOLS uses producer-
specific algorithms.

With the field 'Software size' you may not only view the current size, but also change
it. Please note that this will affect all versions of the current project and that the
change cannot be undone. If you choose a software size smaller than it currently is,
data will be lost permanently.

Communication:

Use the 'Read hardware' to set the hardware of the project. This has an influence on
what export and hardware functions are available for the project. If you choose a
BDM, BSL or Eprom project type, you can use the button "..." to view details.

The field 'Project type' allows you to remember the type of contents. Some details
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about the available options:

e Complete binary file => The dump contains all data from the hardware.
¢ Partial (map data) => The dump contains only the maps. The rest is cut off.
e Partial (full length) => The dump contains only the maps. The rest is cut

empty (usually FF or 00).

Using the 4 checkboxes you can insert up to 4 'tags' into the project hexdump data.
This requires that either a checksum is used or that you manually add a patch tag
block in the checksum dialog (extended mode). Noread is a general tag that is also
supported by other programs and protects you again the reading of the programmed
data by your competitors (encrypted variation). The checkbox 'Bdm/Bsl protection’
works similar, but still allows you to read the data with a WinOLS with your customer
number.

Buttons (from left to right):

e OK

e Search vehicle data: You can let WinOLS recognize several technical information
about the project. You can configure WinOLS at "Miscellaneous > Configuration >
Automatically” to do this automatically for new projects. The button is red if a click
will yield new data.

e Search online: You can save a lot of time when you're filling the in the form. To
achieve this, several characteristics from the project will be transferred to an
internet database. Within seconds you'll receive a resulting list with matching
models. With a single mouse click you may transfer the results into the form.

e Store online: Sometimes it may happen that a model is not yet in the database, so
you still have to enter the data manually. With the option you may store the model
in the internet database. If you get similar models in future, they will automatically
be recognized, too.

e Project comment: Allows you to enter a comment for this project and connect files
to the project.

¢ Rights: Here you can disable rights for the project. This is useful for resellers.

e ini-files: Exports an ini-file containing the project properties. You can drag that file
into any WIinOLS project to copy the data. Use the dropdown button to import the
data from an ini/ifo file or to copy the project properties from another, open project.

e Cancel

Red fields:

If you are a Reseller and the project is in your Reseller Upload folder, some fields in
the dialog may be highlighted in red. These are mandatory fields that must be filled
in for an upload. In this case they will be marked red if they are empty.

Write protection:

Projects can be protected against changes. Then you will see the text "Read only" in
the window frame. The following conditions can lead to this:

e Non-developer mode (Configuration > Miscellaneous).

e Project status Finished, Finished+Master or Ready for reseller
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¢ Project icon "Padlock"
e Unregistered WinOLS

Note:

The functions ‘Search online* and ‘Store online’ only transfer a few characters of the
projects to the internet database. The project itself and the changes you made will
not be transferred and continue to exist only on your harddisk.

Note:

You can also fill the property fields of a project with values by dragging a
Byteshooter ifo file or a WinOLS ini file into the project window. This is done
automatically if such a file exists in the same folder and with the same filename
(except for the suffix).

See also:
e Shadow data

Shortcuts:

Symbol bar: @
Keyboard: Ctrl+Alt+Enter

The dialog customer list

2 -
Customer list I. ? ihI
Cusztomer ...  Mame Company Phaone
Mew... Edit... Delete Search:
L [ ok ] Ok+bccept Lancel

You can reach this dialog from the dialog "Properties: Project". This dialog allows
you to administrate a list of all customers and to reach the matching entry via the
entry from the previous entry.

You can create, edit or delete the customers separately. The list is stored
independently from the current project. Use the button "OK+Accept" to copy the
currently selected entry into the dialog "Properties: Project".
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4.7.3

By default WinOLS stores the data from this list inside the WinOLS configuration file.
You can change this behavior at "Miscellaneous > Configuration > Path". There you
can specify a CSV file which WinOLS can use to store this file. The CSV file can be
stored on a network drive and shared by multiple WinOLS clients.

Shortcuts
Symbol bar: -
Keyboard:

The dialog customer details

Customer details &léj

Cuzstomernr.:

Mame:
Compary:
FPhore:
E-Mail:

Comment;

[ (] ]| Cancel | L

RS ~

You can reach this dialog from the dialog "Customer list". This dialog allows you to
view and edit each customer’s data.

Shortcuts
Symbol bar: -
Keyboard:

WiInOLS ini files

You can use ini files to store descriptions of WinOLS project properties. Drag such a
file into a WinOLS project to apply the texts to the project. You can easily create ini
files with ini4WinOLS.

WiInOLS ini files are normal text files with a file name that ends on ".ini" and this
content:
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[WinOLS]

ClientName
ClientNumber
ClientLicenceplace
UserdefTl

Userdef2

Userdef3

Userdef4

Userdef5

VehicleType
VehicleProducer
VehicleSeries
VehicleBuild
VehicleModel
VehicleCharacteristic
VehicleModelyear
VehicleVIN

EcuUse

EcuProducer

EcuBuild

EcuProdNr

EcuStgNr
EcuSoftwareversion
EcuSoftwareversionVersi
EngineName
EngineProducer
EngineType
EngineDisplacement
EngineTransmission
EngineEmmisionStandard
EngineMaxTorque
OutputPS

OutputKWw
ResellerProjectDetails
ResellerProjectType
ResellerCredits
ReadingHardware
ProjectType

Commentl

Comment2

n= ...

I T 1 1 1 O 1 1 1 O e 1 I I O | I A 0

/I Change version properties:
VersionComment
VersionResellerCredits

/I Only when importing together with a file: Setting the target client folder
Client = ...
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Umlauts and international characters: Save the file in "Ansi" or "UTF-8 with BOM"
format.

All lines, except the [WIinOLS] line are optional. Instead of the "..." in the text above
simply use the text that you want to import.

The field "VehicleSeries" was previously named "VehicleChassis". The old name can
still be used.

The dialog Multiple elements in the project

Multiple elements in the project - I. 2 i‘s-]
Type Fram To Use Digplay offzet  Yalid Cpu offzet
Hardware 0 JFFFFF 7 0 Yes ]

Add Delete
| LCancel |

RS o —_ -

This dialog allows you to define the elements within the project. Internally WinOLS
stores all elements in one big data block (visible as ‘<All elements>’). Here you can
define for the elements where they are located within the big data block.

Hardware/Virtual:

Hardware elements represent physical memory modules. Each project must have at
least one hardware element. Virtual elements are generated by the OLS1xxx
importers and/or checksums and define areas within hardware elements.

Addresses:

For each element you need to define the start and end address (hexadecimal). For
the "Use" you have several pre-defined texts, so that WinOLS can handle the
element correctly. The "Display offset" is the address that is used to display the first
value of the element’s hexdump. This value can be bigger than the project size.

Further columns:
The columns "Type" and "Valid" are used by the checksums only.
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See also:
Overview Elements

Shortcuts
Symbol bar: -
Keyboard:

4.7.5 The dialog Project comment

Deszcription:

Linked files:

Add... Delete

] [ Cancel

In this dialog you can enter a comment for the current project. WinOLS automatically
adds information here when you import something.

This field "Linked files" can store a list of files that are related to the project. The files
are not used by WIinOLS, but the list is stored here for your reference only. The
project version stores link to the files only (and not their contents). To add files, use
the "Add" button or drag+drop the files into the field. Double-click a list entry to open
the file. If you rather want to store the link for the current versions use the dialog "
Properties: Version".

Files can be detected automatically in the autodiscover path. These files cannot be
deleted.

If you open this dialog from the dialog 'Properties: project' it will be a modal dialog. If
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you open it from the Window menu, it is not modal, meaning that windows lying
behind the window may still be used. Then this dialog is a "floating” dialog. All
floating dialogs can be toggled with the tab key.

Shortcuts
Symbol bar: -
Keyboard: -

The dialog Project language

Project language

Map texts can exist in multiple languages at the same time. This project contains:

Status Language Activate
Activated German
Translate
Duplicate. ..
Caorrect...
Delete

Close

Maps have various description fields in WinOLS. Their texts can be stored not only
in one language, but in several. Only one language is active at any time and thus
visible in dialogs.

You can manage the languages in this subdialog of the project properties. If the
current texts are marked with a wrong language, you can correct this here. If you
manually add a new language (by duplicating), it starts by default as a copy of the
previously active language. Now you can change texts in the map properties as
normal. And change the active language afterwards. You can do this in the project
properties and also in the sidebar menu. The tooltip of the map always shows all
languages.

If you have licensed the plugin OLS540, you can have all texts translated
automatically from German to English or define your own translation tables for other
languages..
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Shortcuts
Symbol bar: -
Keyboard: -

4.8 The dialog Properties: Version (Menu Project)

Version properties
Name: Original

Faolder:

Output: S oy gnature:

Max. Torque: Nm & Bit sum version:

CVN: 8 Bit sum original:
State: no state
Price: =mpt not purchasable |Credits for Reseller)

Description:

Linked files:

Cancel

Use this dialog to edit the properties of the current version of the project.

Name A title which is also displayed in the selection list when opening the
project. Open the combo-box to see the names of other open projects
or to select a files with a list of names. This name list is a text file that
you create, with one name per line. It can contain the usual
placeholders such as %Client.Licenceplate%.

Folder The project is organized in this version folder. (Can be empty)

State A descriptive state for the versions. Only the Autolmport/AutoExport/
AutoUpdate states are considered by WinOLS.
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Price For resellers only: If you would like to sell this version individually, you
can enter a price here. More about this under Reseller.

Description A user-defined description of the version.

Linked files This field can store a list of files that are related to the current version.
The files are not used by WIinOLS, but the list is stored here for your
reference only. The project version stores link to the files only (and not
their contents). To add files, use the "Add" button or drag+drop the files
into the field. Double-click a list entry to open the file. If you rather want
to store the link for all versions use the "Comment" button in the project
properties.

Files can also be detected automatically in the autodiscover path.
These files cannot be deleted.

Signature If this project version was signed (with the sign hexdump function) the
signature text will be displayed here.

8 bit sum  The 8 bit sum of the original and the current version is displayed here

Shortcuts

Symbol bar: @
Keyboard: Shift+Alt+Enter

The command Find similar projects (Menu Project)

Use this command to search projects on your harddisk which contain data similar to
the active project. The result is displayed in the known ‘Open’ dialog.

The list shows all projects that:

e are very similar on the whole. (The limit for this can be set with the combo box at
the top right.)

e have the same values for software, ECU-Nr Prod or ECU-Nr ECU. (This are then
shown in bold)

e only one hardware element or the data area are very similar. (You can then
transfer the maps/changes from this projects)

Note 1:
The results will only include data from the currently active client.

Note 2:
As usual, you can also activate resellers here.

Shortcuts
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Symbol bar: -
Keyboard: Ctrl+Alt+O

4.10 The command Find duplicate objects (Menu Project)

Find duplicate objects
What kind of duplicate objects did you want to find?
(") Projects that contain the same versions twice
Mote: The search only applies

to the directony of the cument
[ Onily  the maps are idertical, too cliert.

[ Only  the comments are identical, too

[ lgnore versions

("1 Delete empty folders in the curment project

Cancel

Delete file?

|dentical projects were found:

Producer Model

Marked projects: [ Integrate versions into the unmarked project

[ Delete 1 Move. ..

This command (lower screenshot) will search all projects of the current client and
detect whether any project contains the same version twice / any project exists twice.

If such a project is found, WinOLS will ask if it should delete one of the two versions
/ projects.

Note: This process may take several minutes.
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Projects that exist completely 2x:
You can define the comparison conditions here. If you choose to ignore the versions,
only the original is compared. You can then use the function to integrate the versions
from several projects into one main project. WinOLS automatically avoids integrating
versions that already exist. Optionally, you can restrict the recognition to the version
name (instead of version name+hexdump) to prevent there being several versions
with the same name in the (unmarked) target project.
Shortcuts
Symbol bar: -
Keyboard: -

4.11 The dialog Update all projects (Menu Project)

Update all projects

With this function you can update projects. Current target:
u All projects in: Standard

Update: Delete [ Overwrite:
Search vehide data (refering to dialog "project properties”) [Opelete data
[ ] only if there isn't any data yet Mame (Client)

Mormalize vehide data an
(Volkswagen => VW, 200CDI = 200 CDI, ...) Licence plate

- ] o (7 - Y
[ Chedksums Created [ changed by (person)

Only if there isn't any data yet or the data is obsolete Created / changed on (date)

Quicktest (no questions) Project comment

|:| Chedk script’ability {slow) Version descriptions

Only if there isn't any data yet All maps in the My maps" folder

All maps+olders

Indexing for similar-project-search Linked URLs
[ ]Filename {if it's not already in the namespace) Linked fles
Reseller Folder: Caution, customers will be unable to re-download ’
projects, because the identification is done by the name. Attached files

|:| Overwrite rights with: | Rights...

[JDelete all checksum blacks and restore ariginal values *)
WARMING: This applies to ALL versions,

Alle Optionen aufer *) werden gespeichert und kénnen automatisch beim Kopieren in den Reseller-Ordner angewendet werden.

Mote: This process may take several minutes, Open loafile Save + Close Cancel

Use this dialog to update several aspects in all projects. In order to achieve this all
projects (of a client) are loaded, updated and saved (if necessary). Use this feature
when WiInOLS offers new features (e.g. 8 Bit sum of the original version) or you've
licensed a new checksum. Without this dialog the new fields in the project open
dialog would stay empty at first.

(C) 2025 EVC electronic



Commands of the menu Project 87

Vehicle data are multiple fields from the project properties dialog, which you could
also fill manually with the button ‘Search vehicle data'.

Normalize vehicle data fixes typical minor problems in the vehicle properties such
as missing capitalization, PS/KW in the wrong field and standardizes spaces and
spelling for certain vehicle manufacturers. This option affects the project properties
in the 'Vehicle' section and output.

Checksums apply the checksum search to the project. If you're choosing
‘Quicktest’, the projects are only tested roughly. In this case no blocks will be entered
and WinOLS will not ask any questions. But in may happen that checksums are
found, where there aren’t any.

Check script'ability means that WinOLS checks which of your scripts are
applicable to the project. This allows you to classify projects automatically. The result
is displayed in the project list and can be searched.

Versions:

Here you can edit versions with different actions. This always affects all versions of
the selected projects, but each project is only considered on its own (i.e. no projects
are mixed). The configuration takes place via files with rules. WinOLS automatically
explains the format for the rules in the files:

e Rename: Correct spelling mistakes and enforce standardized version names.

e Sort: Change the order of versions to a standardized order

e Combine: Create combinations of multiple versions

e Credits: Set a standard price for versions (for resellers)

Tip:
You can right-click a selection in the Open Project dialog and apply this dialog to
selected projects.

Note:

This process may take several minutes. WinOLS may ask questions. Projects that
are currently open, are not processed. The 8-Bit checksum of the original version is
recalculated automatically.

Shortcuts
Symbol bar: -
Keyboard: -
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4.11.1 The command Clone project properties (Menu Project)

4.12

Clone project properties

Search in this client: There values are the same as an empty field:
i, | Temp

.. for projects with identical...

Software version
[ ECU-Nr. Producer
[] Name {Engine)

And then copy the project properties for:
Vehicle

[ Userdefined

ECU

Engine

WinOLS automatically recognizes:

Careful with these: Undefined, empty, leer, nfa, -

Allow source fields with conflicting values
Even if there’s only a simple majority

[] Owverwrite non-empty fields

This dialog is a sub-dialog of 'Update projects'.

This command searches all projects in the selected client for projects in which the
selected properties are identical to the current project. In the projects found, all
properties that are uniform there (optional: have a majority) are searched for and
these are then transferred to the currently updated project.

This function is only executed if at least one comparison condition is selected and its
value in the currently updated project is non-empty and non-trivial (<4 characters,
"empty" or similar).

Shortcuts

Symbol bar: -
Keyboard: -

Ex - & Import

Please choose a subtopic.
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4.12.1 The dialog Import file

File format
What file format do you want to process?

ame Applies to.

2 binary files (Low/High) All elements .

OLS file, current project version Al elements * ols
OLS file, all project versions Al elements * ols
encrypted OLS file, current project version Al elements # olsx
encrypted OLS file, all project versions All elements * olsx
Intel-Hex All elements * hex
Motorola-Hex Al elements *519
EcuX All elements * EcuX
EcuX, al project versions All elements #* EcuX

Lol 1 S L[ P T R ]
[] Tempararily delete checksums+synchlocks before export
] Compress as ZIP-File [J..as7z
Alzo export: [] ini (Project properties) [ cav (Maps) [] json (Maps)

(Offeet & address area:
[ Start address: (Min: 0)

] End address: (Max: VFFFF)

hecksum status: Mo C5

oK Cancel

The dialog will be displayed in different situations: When importing a version you can
configure the data source you want to use. When exporting a version you can
configure the kind of data file you want to create.

Area "File format™:

First you can choose the file format you want to process. Binary files contain the
pure eprom data without any control information. WinOLS may also read from two
files (one byte from each file alternating). Furthermore you may read OLS files and
read or write WIinOLS files. You can recognise OLS files at the file suffix ‘.dat* and
WinOLS files at the file suffix ‘.ols". If you export ols-files you can also create older
versions. (The WInOLS file format has been changed several times due to the
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numerous improvements, which have been made. If you want to create a WinOLS
file that can be read by an older version, you can configure it here.)

Furthermore you may read and write Intel-Hex files. These files often carry the files
suffix ‘.hex‘ sometimes also ‘.paf‘ or ‘.daf*. And your may read and write Motorola-
Hex files. These files often carry the suffix *.s19".

The list of supported file formats can be extended by plugins or third-party
command-line software.

Area "Code data & swap lines™:

Furthermore it is possible to encrypt data and lines just like it would be done with the
integrated eprommer. In oder to activate this option you must enable encryption in
the producer dialog and select a key file.

Optionally swapping of data lines can be activated, which is done just like it would be
done when you are using the integrated eprommer. In order to activate this option
you must select a producer and activate the swapping of data lines.

Area "Offset & address area":

Here an offset can be configured for Intel-Hex / Motorola-Hex files for the addresses
in these files. Furthermore an address range can be configured if you want to handle
only a part of the project. When importing this option is only available if the project
already contains a version. It is always available when exporting.

For Intel-Hex / Motorola-Hex files you can tell WinOLS to mimic the file format of the
imported file. This is only available when the file was imported from the same file
format. It helps you communicate with other programs that require the file to have a
certain format (within the standard).

Area at the bottom of the dialog:

When exporting you may ‘zip‘ the results. This will create a compressed (=smaller)
files, which is great for sending it by e-mail. In order to unpack it you'll need
programs like WinZip (www.winzip.com). If 7-Zip is installed on your computer, you
can also use this file format.

When importing into a project which already has a version you may decide not to
create a new version but to overwrite the current one. This is especially useful when
you want to combine multiple Intel or Motorola files.

Notes about file formats:
BdmToGo-files can only be exported if the project is marked as BDM project in the
dialog "project properties"”. BslIToGo-files work respectively.

Notes about exporting elements:
If the file format doesn’t support elements, only the data from the currently active
element will be exported. If you want to export all elements, select <All elements>
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before exporting. If the file format supports elements (only OLS and BdmToGo files
do this), all elements will be exported, regardless of the element that is currently
active.

Shortcuts
Symbol bar: -
Keyboard: -

4.12.2 The dialog Export file

File format

What file format do you want to process?

2 binary files (Low/High) All elements

OLS file, current project version All elements

OLS file, all project versions Al elements * ols
encrypted OLS file, current project version Al elements * olsx
encrypted OLS file, all project versions All elements * olsx
Intel-Hex Al elements #_hex
Motorola-Hex All elements *519
EcuX All elements * EcuX
EcuX, al project versions All elements *_ EcuX

Lol 7.0 ISP B Al e e ——n e |
[[] Tempaorarily delete checksums+syncblocks before export
[ Compress as £IP-File [J..as7z
Also export: [ ini {Project properties) [ csv (Maps) [] json (Maps)

(ffzet & address area:

[] Start address: (Min: 0

[] End address: (Max: 7FFFF)

hecksum status: Mo C5

The dialog will be displayed in different situations: When importing a version you can
configure the data source you want to use. When exporting a version you can
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configure the kind of data file you want to create.

Area "File format™:

First you can choose the file format you want to process. Binary files contain the
pure eprom data without any control information. WinOLS may also read from two
files (one byte from each file alternating). Furthermore you may read OLS files and
read or write WinOLS files. You can recognise OLS files at the file suffix ‘.dat* and
WinOLS files at the file suffix ‘.ols". If you export ols-files you can also create older
versions. (The WInOLS file format has been changed several times due to the
numerous improvements, which have been made. If you want to create a WinOLS
file that can be read by an older version, you can configure it here.)

Furthermore you may read and write Intel-Hex files. These files often carry the files
suffix ‘.hex‘ sometimes also ‘.paf* or ‘.daf’. And your may read and write Motorola-
Hex files. These files often carry the suffix *.s19".

The list of supported file formats can be extended by plugins.

Area "Code data & swap lines™:

Furthermore it is possible to encrypt data and lines just like it would be done with the
integrated eprommer. In oder to activate this option you must enable encryption in
the producer dialog and select a key file.

Optionally swapping of data lines can be activated, which is done just like it would be
done when you are using the integrated eprommer. In order to activate this option
you must select a producer and activate the swapping of data lines.

Area "Offset & address area™:

Here an offset can be configured for Intel-Hex / Motorola-Hex files for the addresses
in these files. Furthermore an address range can be configured if you want to handle
only a part of the project. When importing this option is only available if the project
already contains a version. It is always available when exporting.

For Intel-Hex / Motorola-Hex files you can tell WinOLS to mimic the file format of the
imported file. This is only available when the file was imported from the same file
format. It helps you communicate with other programs that require the file to have a
certain format (within the standard).

Area at the bottom of the dialog:

When exporting you may ‘zip‘ the results. This will create a compressed (=smaller)
files, which is great for sending it by e-mail. In order to unpack it you'll need
programs like WinZip (www.winzip.com).

When importing into a project which already has a version you may decide not to
create a new version but to overwrite the current one. This is especially useful when
you want to combine multiple Intel or Motorola files.
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Notes about file formats:
BdmToGo-files can only be exported if the project is marked as BDM project in the
dialog "project properties”. BsIToGo-files work respectively.

Notes about exporting elements:

If the file format doesn’t support elements, only the data from the currently active
element will be exported. If you want to export all elements, select <All elements>
before exporting. If the file format supports elements (only OLS and BdmToGo files
do this), all elements will be exported, regardless of the element that is currently
active.

See also:
Mass export

Shortcuts
Symbol bar: -
Keyboard: -

4.12.2.1 The dialog BdmToGo-Properties (Menu project)
I. Bdm-To-Go Propertie M EE |

Security areas: [optional]
Y'ou can protect paur custamers fram accidentally uzing the file in the wrang ECU. Far

thiz enter up to 3 areas [e.g. the VIM pogition] where thiz file must match the current
ECU data.

The file can only be programmed if all defined areaz match.

In element I iw I From To
In element I - I From To
In element I h I Frarm Ta

Trick: If you define areas as comments in the project and use the comment texts
"BOMIT"Y, "BOMZ2" or "BOM3" then these areaz will be entered here.

YW'hich elements should be exported?

Froceszzor Eprom 2

Eprom EEpram

The file may not be reimported into WwWind LS.

ok Cancel |
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4.12.3

This dialog is shown if you choose BdmToGo as file format when exporting.
BdmToGo files are compact and can be programmed into ECUs using BDM100
devices. Depending on the settings they may also be used to send somewhere and
re-import them into WinOLS without programming them

You can choose up to 3 areas, which should be compared with the ECU before
programming. This was introduced to protect the user from using the wrong ECU
and it is also a copy protection for your work. Simply include the VIN into the
checked areas and the file can only be programmed into the desired vehicle (and not
into all other similar vehicles). It is recommended to mark the areas by comments. If
you use the comment names "BDM1", "BDM2" or "BDM3", WIinOLS will recognize
the comments and automatically enter the marked areas into this dialog.

The address ranges have to be entered as hexadezimal.

Notes about elements: Elements that contain differences between original and

version are printed in bold.

Notes about the protection mechanisms: Activate the checkbox "This file may not..."

to disallow WinOLS (the WinOLS on other machines AND your WinOLS) to re-
import the file, because then the use might edit the areas mentioned above. This
option does not modify the programmed data and thus does not offer any protection
against re-reading the data from the ECU. To get that kind of protection, activate the
option "BDM read protection” in the dialog "Properties: Project". It will place a marker
into the data and thus the re-read project can only be imported into a WinOLS that is
registered to your customer number.

Shortcuts
Symbol bar: -
Keyboard:

The command Send project as Mail

Use this command to send the current project by e-mail. You may choose the format
that is used for the transfer (binary, Intel, WinOLS, etc.) encoding. The actual
sending will be performed by your default mail application.

Use the dialog 'Miscellaneous > Configuration > Automatically > E-Mail' to enter
standard texts.

Shortcuts
Symbol bar: -
Keyboard: Ctrl+M
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4.12.4 The command Import directory (Menu Project)

With this command you can import all files of a directory into the WinOLS project
directory (of the current client). All file formats are supported, which can also be
imported with the main program as a project. (Additional files like IFO or A2L are not
supported.)

Source folder:
Select the folder (if necessary incl. subfolder) in which your projects are currently
located.

Move:

You can move the source files in case of success/error. This is helpful to find out
which files have created problems during import and which ones have already been
imported.

Filter:

Here you select which files should be imported and which files should be ignored.
(Technically, these are a positive and a negative list.) At this point, there is no
distinction between the original and the version. If you want to import all files from
the source folder without exception, you can simply uncheck both checkboxes in this
area.

Version detection:

If you have separate version files in addition to the original, these can be imported
directly into the same WinOLS project as a version. Specify a filter (e. g. *. org) with
which WIinOLS can recognize the original files within the files. Anything that is not
the original application file is considered a version.

Optional fallback strategy: If the original is not recognized, WinOLS can simply
consider the oldest file as the original.

Requirements:

1. The file must be in a format that can be imported as a version. (e. g. bin or hex;
but not ols)

2. The relationship between the original and the version must be recognizable. (see
below)

To allow WinOLS match a version to the correct original, there are 2 checkboxes /

strategies:

e The original and its versions are in a subdirectory alone (without any other original/
versions).

e The only difference between the original and its versions is the suffix. (Example:
abc. org and abc. versionl) In this case, the suffix of the version is automatically
saved as version name in the project.

Versions that cannot be assigned to an original are ignored.
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Wildcards:

The 3 input fields in the lower part can handle standard Windows wildcards like ™.
bin'. Even more complex wildcards like "*. version*' are possible. (The asterisk
always stands for an arbitrary sequence of characters.)

Tip:
For this function, use a client that does not yet have any projects. This way you can
easily delete and restart everything in case of problems.

Shortcuts
Symbol bar: -
Keyboard: -

4.12.5 The command AutoUpdate + Autolmport (Menu Project)

This function requires WinOLS 5.21 + FeatureUpdate

With this dialog you can trigger AutoUpdate and Autolmport manually and create the
versions for AutoUpdate.

AutolUpdate / Autolmport

Ind
[ Add changes {+)
kal+kb1+test off
kal+kbl
kal+kb2+est off
kal+kb2
kal+kb3+est off
kal+kb3
ka2-+kb1+test off
ka2+kb1

L= b3 o bmiod nfF

() Update Autolmport

oK Cancel

AutoUpdate Versions:

When creating the versions, WinOLS calculates groups from all versions that are not
already marked with AutoUpdate. Only versions ending with a number or "on" / "off"
are considered.

In the screenshot the groups ka, kb and test were created from the versions kal,
ka2, ka3, kb1, kb2, kb3 and "test off". All possible combinations are then calculated
from all selected groups. All selected combinations are then created as a version
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when you click OK.

Add changes:

If activated, the created version names start with a plus sign. This allows you to

make changes outside of the source identifier fields that will not be overwritten by
AutoUpdate.

Shortcuts:
Toolbar: -
Keyboard: -

4.12.6 The command Export CSV/JSON map list (Menu Project)
" i

YWw'hich maps would you like export?
@ Al maps
1 Al gelected maps

1 Al maps that contain changes

YWw'hich map types would you like export?

Single values
One-dirmenszional
Two-dimensional

“Which columns do you want to expaort? [Oaly for ©5W)

Addrezs Size
M arne [] Comment
14

k. ][ LCancel ]

This command allows you to export all information about the maps of the current
project into a CSV or JSON file. You can open CSV files with the usual spreadsheet
applications, like Microsoft Excel. You can specify the file format (CSV/JSON) in the
file dialog that is displayed after this dialog.

You can apply the (modified) file later with the command Update map list on basis of
CSV/JSON file.

(C) 2025 EVC electronic



98 WinOLS 5.74

You can reach this command with the menu 'Project’ as well as with the special
menu of the map list. You can reach the latter by clicking on the small black triangle
within the map list window.

Note:
All addresses in CSV files are relative to the project start (like in the view "All
elements" and not with their element addresses) and are stored as decimal values.

Shortcuts
Symbol bar: -
Keyboard: -

4.12.7 The command Update map list on basis of CSV/JSON file (Menu Project)

You can apply a previously exported and modified CSV/JSON file to a WinOLS
project. WinOLS matches the maps from the file with the maps in the project by their
address or id and then applies the changes values on the maps in the project.

If you exported *all* columns then the importer will also create maps that are
currently missing.
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4.12.8 The command export map pack (Menu Project)

YWw'hich maps would you like export?
@ Al maps
(71 Al zelected maps

(71 Al maps that contain changes

YWw'hich map types would you like export?

Single values

One-dirmenszional

Two-dimensional

Address

M ame

This command will export all maps (but not the data inside the maps) into an extern
file. This file can be transported as any other file and be imported into other projects.

Shortcuts
Symbol bar: -
Keyboard: -
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4.12.9 The command import map pack (Menu Project)

Impert map pack

You are about to import 125898 maps like...
..with addresses like:

AMfter applying the offset(s):

...are these map bytes identical:

...are these maps inside the project:

afanngn #01TTFEE

Use element informationen:

1
FIII N [ —_I
& s0E0n0an

Rail_wVehSpdLim_C
0x53.8996
0x8053.8996
89.35%

100,00%

S0EEFETT

Duplicates:

[ Awaid duplicates

When comparing:

You may enter an offset for the import. All maps will be moved by this offset.

Ignore axis

Offset 1: +

« | (Hex, Optional)

Automatically lgnore texts
Cffset 2: - « ||{Hex, Optional)

Name-Prefix:
To make it |ater easier to recognize which maps are new, you can enter a

"prefix” ffor example "Imported_"). This text will be put at the beginning of
the name of each new map.

The first offset is added to the address. The second subtracted.

Contents:
[JAlso import values Prefix:
[]Also import empty folders

[]Also maps for which no hexdump is available

({Text, Optional)

Cancel

This command will import all maps (but not the data inside the maps) from a
(previously created by an export process) map pack file.

At the top you can see some sample addresses from the imported file next to the
number of maps. Directly below you can see how your offset changes the addresses
and how plausible the result is. The bitmap shows an overview of the target project,
including element addresses. The blue markers show where the maps will end up.

2 offsets:
You can enter up to 2 offsets. Both will be offset against the address during import.
This makes it easier to subtract an offset and add a new offset if the situation

requires it. For example, to move a map from 0x7000 to 0x400000 enter "0x7000" as
offset 2 and "0x400000" for offset 1.

Find out the offset:
e Use the "Automatically” button
e Look at the addresses of the maps (second line) and compare them with the

element addresses in the image. This will give you a hint in which range the offset
must be.

¢ Click with the left or right mouse button in the image to try different offsets. (You
can also hold the mouse button pressed.)

e Sometimes there is no offset that fits all. In this case use the function Import
changes.
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This is just one of several options to import data from other projects.

Shortcuts
Symbol bar: -
Keyboard: -

4.12.10 The command import maps (Menu Project)

Use this command to import all maps (but not the hexdumps) from another WinOLS
File into the current project. The eprom contents will not be changed, only map
definitions are imported.

The source project is selected in the usual way. It will not be modified by this
command.

This is just one of several options to import data from other projects.

Shortcuts
Symbol bar: -
Keyboard: Ctrl+Shift+l

4.12.11 The command Import Changes (Menu Project)
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Welcome to the wizard for imparting changes!

With the help of this wizard you can quickly import maps and
changes you made within these maps.

(7 Impart changes automatically
WinQLS automatically detects changed maps and data ranges
transfers the ones that you select.

(7 Impaort changes manually
WinQLS prepares 2 projects and windows in such a way that
they can easily be manually compared by you.

With this assistant you may import maps from another project. This function is much
more flexible than the function import maps. It is no problem for this command if the
maps were moved to another address or has even changed data.

In the automatic mode (the 3 following images) WinOLS recognizes maps and
changed data ranges and tries to map these to new projects. You just have to select
to them.

In the manual mode (the last image in this series) WinOLS prepares windows from
the old and new project in such a way, that you can optimally compare them. The old
project is displayed normally. The new project receives the old project as original.

AUTOMATIC MODE:
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In the first step please select the project and the version from
which you want to import maps and values.

Project

While searching for maps. ..
[ ...consider only maps with changed data.

[ ...use a tolerance of e

| <Back | Net> | | Cancel

In the first step you must select the project from which you want to import maps
from. (The current project is always used as target project.) Only projects which are
currently opened can be selected.

If the source project has many maps, it can make sense to reduce the selection (and
speed the import process up) by only showing maps which were changed in the
source project.

Furthermore you may enter a tolerance for the map recognition. This will tell the
assistant to accept small differences while searching the maps within the target
project. However, this slows the search down.
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Please mark all maps you want to import. Only maps that were
recognized comecthy may be imported in this step.

0 of 1 mapis) can be imported
Address  Offset MName Size

All None
Import marked Maps (without data).

Import changed data in marked maps.
Transfer changes [abmlme

| <Back ||

In the second step you can select maps which you want to import into the current
project. You may select whether you want to import the maps and / or the changed
data in the map. Changes in maps are normally transferred as difference, meaning
that the difference between original and version will be transferred. You may also
decide to transfer the data absolute.
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Please mark all the data areas you want to impaort.

Mo data areas were recognized.

From To Cffset

In the last step you may import changes outside of maps. These are bytes which
were changed in the source project but are not within a map. These areas can be
recognised in the target project and imported, too.

Important 1: This is only the second best method. Changes in maps are safer
because the areas and data organization are known.

Important 2: Changes to checksums and patch blocks cannot be accepted. They are

automatically skipped and as of WinOLS 5.72.37 are no longer reported as "not
importable”.

MANUAL MODE:
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In the first step please select the project and the version from
which you want to import maps and values.

Project

VW, 1503060507

s the source project not yet open?
Open project...  Open similar project ...

o )] [ome ] |

In the first step you must select the project from which you want to import maps

from. (The current project is always used as target project.) Only projects which are
currently opened can be selected.

This is just one of several options to import data from other projects.

Shortcuts
Symbol bar: -
Keyboard: -

4.12.12 The command Damos & A2L Import (Menu Project)

Note: This command is not part of the WinOLS main program. It is an additional
module and must be licensed separately.

You may also start this assistant by dragging a Damos or ASAP2 file into a project
window. In this case the first two dialogs will be skipped.
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Dames Import

Welcome to the Damos/ASAP2 import!

In oder to use this assistant you will need a damos file (*.dam) or
ASAPZ file [*.a2l) which belongs to the project you're cumenthy
editing.

Importing is done in 4 simple steps:
1. Select the file.

2. The file is analysed.

3. Enterthe right address offset.

4. Choose the maps you would like to import.

This assistant will guide you through the import of Damos or ASAP2 files. Before
starting it you should open a matching project file or create a project by importing the
matching files, because this assistant always relates to the currently active project.
The project data must match exactly the Damos or ASAP?2 file, since the import may
otherwise be incomplete or erroneous. If you want to use the maps in a different
project, you should first import them into the matching project and then transfer them
with the function 'Import changes' into your desired project.

Please zelect the Damos-File [*.dam] ar ASAPZ-File [*.a21) which belongs to the project you're curmently editing.

| o

In the first step you must select the Damos or A2L file that you want to import.

Analyzing the file.

The data inteqrty iz being checked.

The analysiz brought the following results
0 Ermors

) Show meszages...
22 W arnings = 2

The following maps were recognized / not recognized:
1146 Recoghized

0 Mat recognized

In the second step the file is analysed. The data will be read and stored into and
internal format. Since the file formats are different and not all elements are properly
document warnings and errors may be displayed. They won't necessarily disturb the
import and should be ignored if they’re small in numbers.
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Will the Damos/Azap? data be imparted in the matching praject or inta a similar project?

& The data will be imported into a project that EXACTLY belongs it [Fecommendedf

Pleaze enter the affzet far this file. The offzet iz dizplayed when perfarming a hex impart. [t can alzo be
calculated automatically. [The offzet may not be recogrized for some ASAP2-Formats. ]

Offzet (hew); IEI Automatically |

Mate: |n order to impaort all found maps, it iz neceszan for the offset to be within the range -12084. B1EC.

" The data will be imported into a SIMILAR project. (Status: BetaVersion)

Mate: [ thiz mode only 1d and 2d mapz stored with a certain intemal stucture can be impaorted. Due to
the heunstizcal algorthm the result iz not 100% safe.

In the third step your must tell WinOLS whether you're using the project that
"belongs" to the Damos or ASAP2 File or not. For every Damos or ASAP?2 file a
project exists that "belongs” to it. Only if you're using these two together an exact
import is possible. Only since recently the Damos plugin allows it to import the data
files into other projects. However, if you have access to the project that belongs to
the file it is always best to import the maps into this project and transfer them with
the "Import changes" function into the other project

If you want to (as recommened) use the project that belongs to the Damos or ASAP2
file you must enter the offset which should be used for the import. Within Damos or
ASAP?2 files different addresses are used as in WIinOLS files. The offset is
calculated as the difference between the two address formats. If the current project
was imported from an Intel or Motorola file, the offset was stored (and additionally
shown to you) and this field is already filled in. If this isn’t the case, you should try if
the automatic offset detection can calculate it. It depends on the file structure
whether this is possible. As a last possibility you can estimate the number (often a
hexadecimal round address). As a help you can the address range in which the
offset must be. It is calculated by the analysis of the file.

If you don’t have to project belonging to the data file, you can try to import the maps
into another project. For this, choose the lower option. Please note that several
restrictions apply, when using this import mode:

1. The project must be similar to the one that belongs to the data file.

2. In general only 1d and 2d maps can be imported.

3. The maps must be stored in a certain internal format within the Damos or ASAP2
file. Therefore it can happen that only a part or (in rare case) no maps at all are
found.

4. It is more likely to find maps with ASAP2 files than in Damos.

5. In some cases the import uses heuristics, so the result isn't 100% safe. Please
check it before using it.
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Pleaze zelect the maps pou would ke to import:

.-’-'-.ddressl Id | I arme | Size | -

Filter.... “ Optiors... |l | aloithis | Moneof this | Mone |

As a last step you only have to select the maps you want to import. Since there may
be a large number of files in a file, you may reduce the current view by using the
button ‘filter '. Then only files matching the defined criteria (see below) will be shown.
Furthermore you may enter a search text. In this case only maps that contain the
text will be shown. With the buttons 'all' and 'none’' you may either select all maps or
remove the entire selection. The buttons "all of this' and 'none of this' do basically the
same, but only influence maps that are currently visible. Maps that are hidden by the
current filters are not influenced. Before finishing the import and transferring the
maps into the main program you can use the 'options' button (see below) to
configure details for the import.

( Cptions I,ﬁ,lw

Import of map names:

@ iName and |d separately

M arme

Id

Mame [Id]
Id: Mame

o | Impaort folders

[ (] ]| Cancel |

With the options you may configure which data parts should be imported. Normally
all maps have a descriptive name an a unique id. You may choose to import one of
them, both combined or (since recently) both separately into the respective fields of
WinOLS. Furthermore you may import the maps together with their folders in which
they are organised into WinOLS.
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View filter —5—

hao zingle values
ha ohedimenzional maps
ho baadimenzional maps

no mapz with conztant walues

[ (] ]| Lancel |

With these filter options you can determine which maps should be shown in the view
and which should be hidden. You can select maps you their dimension and by the
fact if they consist of constant values only or not.

Shortcuts
Symbol bar: -
Keyboard: Ctrl+D

4.12.13 The command Export project properties (Menu Project)

The WInOLS project properties can be stores in an ini-file. Use this command to
export such a file (and allow a import later on).

Shortcuts
Symbol bar: -
Keyboard: -

4.12.14 The command Import project properties (Menu Project)

The WInOLS project properties can be stores in an ini-file. Use this command to
import such a file (previously created with an export).

Shortcuts
Symbol bar: -
Keyboard: -

4.12.15 The command Translate map texts (Menu Project)

The map information is often in German. WIinOLS can use a plugin to translate the
map, axis and folder descriptions from German into English.

Note:
This command requires the WinOLS plugin OLS540.

Disclaimer:
This is a machine translation. It's neither 100% complete nor 100% correct. We
cannot accept any guarantees for it.
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Shortcuts
Symbol bar: -
Keyboard: -

4.13 The command Printing (Menu Project)

YWw'hat do you want to print?

@) Current window [in the curent wiew mode]

) Differences list [with the differences to the window that i currently active]

Headlines + Logo:

Line 1:  %File.Created
[ Line 2

[ Lire 2

] Lago:

Frint area: Print optiors:

@ Al ("] Calor

- [Fequires color prinker with activated
) Pages  From 1 I colar mode. )

Selection [ Header lines [like open-dialag)
1 Screen Bowmarkers

"1 Address From 0 Zoomfactar; 100= %

Borders...

Use this command to print a document. The dialog shown above will appear where
you can configure several things.

In the topmost area you may configure what you want to see from the currently
active window (printing always refers to the currently active window). Either the data

like it can currently be seen (for example 3d) or only the differences like they can be
seen in the differences window.

In the part below the first you may configure the headlines that should appear on this
page. This can be a static text (for example the company name) or a project property
that can be inserted by a placeholder with the "Ins." button, just like in the Export
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dialog. Furthermore you may select a logo (a BMP-file) which will appear in the top
right corner. You always need to enter the printing size (in mm) manually since this
information is not included in the file.

The area in the lower left is only active if you print the current window normally (and
not as Differences-List). Here you can configure which part of the document you
want to print. There are several possibilities which are self-explaining. With the print
options you can decide whether you want to print in colour, whether you want in
include headlines (in addition to the ones you already configured above) with details
about the current project and whether you want to print the row markers (2d-Mode

only).

Shortcuts:

Symbol bar: @
Keyboard: Ctrl+P

4.13.1 The dialog Configure printing (Menu Project)
Use this dialog to choose the printer and printer connection.

4.14 The command Exit (Menu Project)

Use this command to end your session in WinOLS. You may also select Close from
the system menu of the application. WinOLS will ask you to save unsaved projects.

Shortcuts
Mouse: Doubleclick the applications system menu
Keyboard: ALT+F4

4.15 The commands 1, 2, 3, 4 (Menu Project)

Use the number and filenames listed at the bottom of the menu to open one of the
last 4 closed projects.
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5 Commands of the menu Edit

The menu Edit contains the following commands:

Undo Makes the last operation undone.

Redo Repeats the last undone operation.

Copy Copies the selection into the clipboard

Copy advanced

- Copy address Copies the current cursor address

- Copy map Copies the current map

- Copy map Copies selected properties of the current map and allows
properties you to apply them to other maps

- Copy both axes Copies both axes of the current map
- Copy both axes Copies both axes of the current map as text (for pasting

(Text only) in a text editor)

- Copy X axis Copies the X axis of the current map

- Copy X axis (Text Copies the X axis of the current map (for pasting in a text
only) editor)

- Copy Y axis Copies the Y axis of the current map

- Copy Y axis (Text Copies the Y axis of the current map (for pasting in a text
only) editor)

-Copy as C array  Copies the currently selected values as text in the format
of an array in the programming language C.

- Copy as text Copies the currently selected values as text (for pasting in
a text editor)

- Copy block Copies large data ranges within the project or into other
projects.

Cut Cuts the selection into the clipboard

Paste Pastes the clipboard at the cursor location

Insert / Delete

window

- Insert new Inserts a new hexdump window
Hexdump

- Insert new Map Inserts a new map window

- Delete Window Closes and deletes the current window
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- Open map

- Delete map

As text
Inplace Edit
Sign Hexdump

QuickFix

Value +1

Value - 1

Change absolute
Change relative
Change by edit
Round/limit values

Original value

Interpolate

Remove row /
column

Again

Checksums
Apply checksum

Search checksum
online

Checksum Ranges

Properties: Window

Opens the map window, that is at the current cursor
location

Closes and deletes the map window, that is at the current
cursor location

Edits the current selection / cursor position as plain text.
Allows you to enter a new value for the current position

Protect your project by entering hidden text that cannot
be removed by others

Define/apply small groups of changes

Increases all selected cells by 1

Decreases all selected cells by 1

Sets all selected cells to a definable value

Changes all selected cells relatively to their current value
Changes all selected cells using slider controls

Rounds the selected values or limits them to a minimum/
maximum value.

Sets all selected cells to their original value

Replaces the selected cells with an interpolation of their
neighbors.

Helps you remove a row or column in a map to make
room for a new one at the side

Repeats the last operation

Shows the checksum dialog
Applies the checksums for the block at the cursor position
Searches online for a matching checksum module

Calculates typical checksums for a user-defined range

Shows the properties of the current map- / hexdump-
window
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5.1

5.2

5.3

The command Undo (Menu Edit)

Use this command to undo the last edit operation if this is possible.

Shortcuts
Symbol bar: -
Keyboard: ctri+z

The command Redo (Menu Edit)

Use this command to redo the last operation undone if this is possible.

Shortcuts
Symbol bar: -
Keyboard: cti+y

The command Copy (Menu Edit)

Use this command to copy all selected cells into the clipboard. If there is no
selection, the current cell will be copied.

You may also copy entire maps. To do so, just select the map you want to copy
within the map selection window before copying. You may also use the map
selection window’s context menu.

Copying data will delete any old data in the clipboard.

Excel

You may copy selections and paste them into Microsoft Excel in Order to transfer the
values. If you copy entire maps from the map selection window, then the headlines
and axis descriptions will be copied, too.

Excel-Bug #1
If the numbers with comma are split into 2 cells when pasting into Excel, select "Data
> Text in columns > Delimited" in Excel and select only "Tab".

Excel-Bug #2

If thousands separators are interpreted incorrectly (1.234567 then becomes
1.234.567), then change "Options > Advanced > Separator characters" in Excel so
that a misinterpretation no longer possible.

Shortcuts

Symbol bar:
Keyboard: cTRrL+C

(C) 2025 EVC electronic



Commands of the menu Edit 117

5.3.1 The command Copy map properties (Menu Edit)

Copy map properties

ies to you want to copy?

Description:

[#] Size Da izatio [+] Adjust HiLo flilke target project hexdump)

[ Name. Descriptio : Jata so address (Optional offset: . hex)

[#] Eactor, Offset, Precision, Number to text
[#] Folder

If something is pasted, use this value instead:
[ Comment

From which areas? )
From which areas?

[7] X-Puis [+] X-Puis
[#] Y-Axis [ Map [#] Y-Pis [+ Map

You can apply the copied properties with "Edit > Paste (Ctr+V) to the cument map or the maps selected in hexdump / map list.

] Apply automatically when a new 1x1 map is created.
(Works until you copy something else into the clipboard. Addrezses are automatically adjusted.)

oK Cancel

Use this command to copy selected properties of the current map into the clipboard.
You can later apply them with Ctrl+V to:

e the currently opened map

e the maps currently selected in the map selection window

e the maps currently selected in the hexdump

Shortcuts
Symbol bar: -
Keyboard: cTRL+Alt+C
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5.3.2

5.4

The command Copy memory range (Menu Edit)

Copy block ?

Source:

..................................

() This project:

.. from... <All elements> v | | 0 v | | From hexdumpeursor
coton, <Al elements> w | | IFFFFF w | | From hexdumpcursor
Target:

(®) Current project

() This project:
From hexdumpcursor
oo from... <All elements> | |0
Automatically
ST <Al elements> v 1FFFFF

Difference between source and target area: 0 bytes (0%)

Copy source into dipboard Copy source to target

Use this command to copy a large block binary to the same / a different project or
into the clipboard. You can choose if you want to enter the addresses relative to a
certain element.

*-Button:
Opens a menu with typical ranges that you might want to select. Ranges marked
with 'Core' have been cut off leading / trailing 00/FF areas.

Automatically:
Automatically finds the offset with the least differences.

Shortcuts
Symbol bar: -
Keyboard: -

The command Cut (Menu Edit)

Use this command to transfer the selected cells into the clipboard and remove them
from the document. This command can only be used if cells are selected.
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5.5

5.6

5.6.1

5.6.2

5.6.3

Cutting data will delete any old data in the clipboard.

Shortcuts

Symbol bar: ﬂ
Keyboard: -

The command Paste (Menu Edit)

Use this command to paste a copy from the clipboard to the place you're currently
editing. This command is only available if the clipboard contains cell data.

You may also use this command to paste a map you previously copied.

Shortcuts

Symbol bar: E
Keyboard: cTrL+v

Insert / Delete window

Please choose a subtopic.
The command Insert new hexdump (Menu Edit)

Inserts a new hexdump-window. This command is used seldom.

Shortcuts
Symbol bar: -
Keyboard:

The command Insert new Map (Menu Edit)

Inserts a new map-window. This command is used seldom, because it's easier to
convert a selection into a map.

Shortcuts
Symbol bar: -
Keyboard:

The command Delete Window (Menu Edit)
Closes and deletes the current window.
Shortcuts

Symbol bar: -
Keyboard:
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5.6.4 The command Open map (Menu Edit)

Opens the map, the cursor is currently within (in a hexdump window).

This command is only available, if the cursor is in a previously found map window.
These areas are highlighted in the hexdump view.

Shortcuts
Symbol bar: -
Keyboard:

5.6.5 The command Delete Map (Menu Edit)

Closes and deletes the map, the cursor is currently within (in a hexdump window).

This command is only available, if the cursor is in a previously found map window.
These areas are highlighted in the hexdump view.

Shortcuts
Symbol bar: -
Keyboard:

5.7  The Dialog as Text (Menu Edit)
I Eat date == o R ]

Edit data as test:

0 Character(s); Address 0014

fram project | Templates

Address Text

O0FFE  pScD
OOCEE ZWli
OocEd GRwUI
01ESE  pScP
733 pScP
o844 UKD,
02285 2lg-
022B7  Sil4
0Z2DF 1419
0276F LD,

03080 aklU
N¥9F R A 1k

&dd

] ] [ Accept

Use this dialog to edit the eprom contents as a normal text, for example to mark
something.
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Create a selection without gaps before starting this dialog to edit an existing text or
place the text cursor on the beginning of the text to use the automatic text
recognition.

In the lower half of the window, you can see a list (automatically generated) with
possible texts within this project. It may take several seconds until the list is
complete. Click on an entry to edit the project at this position.

Use the tabulator bar above the list to switch to a list of predefined default texts. This
list is empty when you install WinOLS. Use the Button "Add" to include the text
currently entered into the list. The list will be stored project-independently on your
hard disk.

If you want to have a bigger edit field, click on the button ">>".

Shortcuts
Symbol bar: -
Keyboard: Ctrl+Shift+T

5.8 The command Inplace edit (Menu Edit)

This command will open a small edit window at the cursor position. Here you may
enter a new value for the current cell. This works mostly as in '‘Change absolute'.

If you're using Factor / Offset: Always enter the value you later on want to see and
not the one that should be stored in the eprom. WinOLS will convert it for you.

Option:
You can start this mode by pressing any of the number keys (see "Miscellaneous >
Configuration > Miscellaneous > Edit").

Shortcuts
Symbol bar: -
Keyboard: Enter
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5.9

The Dialog Sign Hexdump (Menu Edit)

Inztall the follwing zignature test. ..

[C)2mz

in thig...

...map: I [nione]

[nztall ket invigible for other companies.

...and in... [optional] l[nnne]

Inztall test invizible for other companies.

...and in... [optional) I[nnne]
Inztall ket invigible for other companies.

0ld zignature text:

Check. and restore zignatures befare saving, burming and exporting.

[ Irnztall signature ] Iﬂemm-'e signatures] | Cancel |

Use this dialog to install texts into a project file in such a way, that it is normally not
visible. This may be useful for example, to brand all your files ‘invisibly' with your
company name.

WinOLS will make very small changes to the project. These changes are normally
too small to be relevant for the functionality, but large enough to code text into it.

In order to work these function needs to know what map or maps it may change. The
larger the map and the more bytes per cell it has (for example 2 bytes for a 16 Bit
value), the more data can be stored. For best performance use large maps.
Otherwise you can only install small texts.

You may hide the texts from other companies. That way, other people (not in you
company) working with WinOLS will not see any message at all. On the other hand
you may decide to not to hide the texts. That way, other people can see the text in
the dialog, but they do not know where the text is stored within the file. That makes it
difficult (but not impossible) to remove. The best way is perhaps a combination. You
can install one visible text and two more invisible.

Since signatures may be disturbed when you’re editing the project, it is
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recommended to let WinOLS check and restore them before the project is saved,
exported or written into an eprom.

Some more notes:

To create an import protection that is difficult to remove, activate the NOREAD
checkbox. Since signatures always contain the WinOLS customer number, you
will still be able to reimport the file.

Don’t use maps with very small changes in the data, because the changes done
by WIinOLS could make a relevant difference when the data is used.

You can install the same text several times for more security. If one change is
disturbed, there are still others left.

You can only remove signatures performed by your company. You cannot
remove signatures from others.

Use the 'Auto’ function with care. It may select maps that are not fit for changes
in your opinion.

Check any maps that are changed afterwards to see if the changes are not too
big.

The function 'Remove Signatures' overwrites the signatures, but it does not
restore the original values. If you want to get the original values, please use the
undo command as usual.

The signature can be seen in the install signature and in the version dialog.

Unsuitable for this function are:

small maps
maps with skip bytes
maps with float values

Shortcuts

Symbol bar:
Keyboard: -
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5.10 The Dialog QuickFix (Menu Edit)

QuickFix

Name Status
QuickFix: A Off
QuickFix: BB Off

Cancel

Create QuickFix

Name:

MyName]

State names:

Criginal: | On

Version: | Off

0K

QuickFixes define smaller groups of status changes independently of the version.
The states (usually: on/off) are saved in the maps (number-to-text) and are therefore
available in all versions and can be quickly activated or deactivated.

Apply:
Click on the line in the dialog and then on '‘Change status' to achieve the desired
status. Close the dialog with OK to change the hexdump as desired.

Create (manually):

You can create a QuickFix manually:

e Create a new folder in the map tree. The name must start with "QuickFix:"

e Define maps in this folder that cover exactly the memory locations you want to
change. All maps must contain number-to-text definitions with the same texts
(state names). However, they can refer to different values.
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5.11

5.12

Create (from selection):
(This is a WInOLS Feature-Update.)
You need a version where some values have been changed.

e Select these (max 200 cells). Unchanged cells must not be selected.
e Use the Add button in the QuickFix dialog.
e Enter a name for the QuickFix and for the states of Original and Version.

XDF-Import (OLS526)
When importing an XDF file, XDFPATCH blocks are imported as QuickFixes.

Reseller:

QuickFixes are technically maps + map folders. They are therefore included both
when purchasing a project and when purchasing a version. They are only not
included in an original-only purchase because it does not contain any maps.

Shortcuts:
Toolbar: -
Keyboard:  Shift+Q

The command Value + 1 (Menu Edit)
Increases the values of all selected cells / the cell at the cursor position by 1.

Hold the key pressed to repeat this command (with increasing speed).

If you press the Ctrl-Key and the Plus Key (from the Decimalblock), this command
works 100x stronger.

Shortcuts

Symbol bar: M
Keyboard: Plus/ Colon

The command Value - 1 (Menu Edit)

Decreases the values of all selected cells / the cell at the cursor position by 1.
Hold the key pressed to repeat this command (with increasing speed).

If you press the Ctrl-Key and the Minus Key (from the Decimalblock), this command
works 100x stronger.

Shortcuts

Symbol bar: H
Keyboard: Minus
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5.13 The dialog Change absolute (Menu Edit)
Change absolute EE'

Showr value:

Eprom walue:

Modus: Standard
Use this command to set the current cell / all selected cells to a certain value.

WinOLS stores the data internally always in the same format that is used the eprom
later on. But the values shown on the screen may differ, because of factor and offset
in order to improve the display.

That’'s why this dialog shows two values. The upper one is the same you'll see in the
current map or hexdump. All influences (like number system, factor and offset) are
the same. The lower value is always in hex and the same value that is stored in the
eprom later on. The two fields are connected and are updated automatically.

Modus: Multi-Edit

Change absolute (Multi-Edit)

Value: [#Only 1 | acE

Apply all Applhy
O O

This function requites WIinOLS 5.70 + FeatureUpdate

If you have connected (narrow) maps, this window appears. Here you can enter
values per column and either apply them individually or apply all the selected values
together. You can use the More button to generate replace commands for the search
dialog from the current settings.

Individual vs. all:

You can use the individual Apply buttons to apply this column. The "Apply these"
button applies all checkmarked columns. With "Apply all”, all columns (except search
columns) are applied.

If you activate the "Only 1" checkbox, only the first input field is activated and all
others are synchronized with it. (Except for search columns).

Use the "Enter" key to apply the Apply/Search button that matches the EditBox in
which the cursor is currently located. The "Ctrl+Enter" keys correspond to the "Apply
all" button.
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Tri-State Checkboxes:

The checkboxes have 3 states. In the third state (half-gray), the Apply button below
the field becomes a search for this column. Not all features of the search dialog are
supported here, but you can at least enter alternative values (41/42/43).

You can switch back to standard mode via "More".

Shortcuts
Symbol bar: ﬂ
Keyboard: -

5.14 The dialog Change relative (Menu Edit)
Change selected value: EE

Drata zource [x];
@ Current data

) Onginal Eprom [ovenariting previous changes)

Operation fx]):
@ Addition: fx] == +w

) Percentage: x] =« + wi

Change all values by [w]:

[ ok ] I Cancel I

Use this command to change the current cell or the selected cells with mathematical
operations.

Using the data source (upper part of the dialog) you can select the source where
OLS gets the input data for the operations. Note: The option ‘Original Eprom’ means
that version currently selected as original will provide the source data.

In the middle part of the dialog you can choose the mathematic operation which you
want to apply for the cells.

In the lower part of the dialog you can enter the parameter you want to use for the
selected operation.

For example enter 'Addition’ and '1000' to increase all values by 1000 or 'percentage’
and '-10' to decrease all values by 10%.
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Shortcuts

Symbol bar: M
Keyboard: %, Ctrl+Shift+A (Addition activated), Ctrl+Shift+P (Percentage
activated)

5.15 The dialog Change by edit (Menu Edit)
Change by edit EE .I

Datenguelle [x]):

! Current data

@ i0nginal Eprom [ovensriting previous changesk

Operation fx]:
@) Addition; f[=]=s+m

| Percentage: fl=] = = + wi

b atrix [rn]:
Top left: Top nght:
0.00 Lo200
fu Al walues: [t
0.00
B attarn left: faf Battarm right:
2.00 300
Ceale: [}
fine roLgh
[] Changes in realime
[ ok ] I Preview I I Cancel I

—))

Use this command to change all selected cells with mathematical operations. The
two upper areas work just like the dialog Change relative.

In contrast to the dialog Change relative there are 5 parameters for mathematical
operations instead of just one. The parameter in the middle of the dialog influences
all cells the same way. The other 4 parameters work depending on their position
relative to the selection. For example the cells in the upper left of the selection are
influenced most by the parameter in the upper left.

All parameters can also be entered using sliders. The sensitivity of the sliders can be
changed with the scale slider.

If the checkbox ‘Changes in real-time’ is activated, all changes are applied to the
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map or hexdump window immediately. It is recommended to use this function with
care, to avoid damages in the vehicle.

This command is only available when an area is selected.

Shortcuts

Symbol bar: ﬂ
Keyboard: &

5.16 The dialog round/limit values (Menu Edit)

With this dialog the selected values:

e can be rounded (e.g. 1,2345 => 1,2300)
e limited to a minimum / maximum value
e can be (de-)deselected

Round/limit values

Function: Mirirmum P
Desired predsion: 1
Value: 30000
Select values Select all
De-select values De-zelect all
| Change values I Cancel
Tip:

You can apply this function to several maps in one go. Right-click a selection in the
Map-Sidebar and choose "Edit multiple maps".

Shortcuts
Symbol bar: -
Keyboard: Ctrl+Alt+R
Keyboard: Ctrl+Alt+Shift+R (Skips the dialog)

5.17 The command Original value (Menu Edit)

This command resets all marked cells to their original value.

Shortcuts
Symbol bar: -
Keyboard: F11
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5.18 The Dialog Interpolate (Menu Edit)

Use this command to replace the selected cells with an interpolation calculation of
their neighbors. For this the selection needs to be rectangular (or one-dimensional)
and there must be a border on each side that is not part of the selection, in order to
have a base for the calculation. For cubic interpolation 2 unselected cells must exist
on each side, but it creates "rounder” values and is better at continuing trends.

This function can also be used on axis data.

Extrapolation:

If a selection extends to the edge on one side, interpolation (except via the corner
values) is not possible. However, if there are at least 2 cells outside the selection on
the other side, WIinOLS can (if you activate the option of the same name) extrapolate
the values based on the 2 cells. (Interpolate=between the reference values;
Extrapolate=outside the reference values)

Fallback strategy:

It can happen that the selected options (cubic or all 4 sides) are not possible with the
current selection. WinOLS then automatically reduces the options so that
interpolation/extrapolation is possible. A corresponding text in the dialog then
indicates this.

If you have explicitly activated "only left/right" / "only top/bottom”, this may mean that
no calculation is possible because the selection is too close to the edge. Activate the
checkbox "If necessary: All sides" to automatically switch to the other sides, if
necessary.

Example:
In both images the outer 2 values on each side were left unchanged (they're the
same in both images, the scale is different). All other values are interpolated.
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Preview : Map "Phoenix Float” x

linear

Preview : Map "Phoenix Float” x

cubic

Shortcuts
Symbol bar:
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5.19

Keyboard: |

Keyboard:  Shift+l (Dialog will be skipped)

The Dialog Remove row / column (Menu Edit)

Sometimes the range covered by the axis values isn't large enough. Modifying the
outmost axis value would solve this problem, but it would also cause large-scale
changes. This dialog helps you instead to identify and remove an ‘unimportant' row

or column.

Remove row / column

Maode:

(®) Remove row

() Remove column

Statistics:

Column Axis: Value Axis: Distance Map: & error Map: Max. errar
2 20,0195 19,0951 <== 0,031379 «<== 0,068761 «<==
3 30,0049 19,9951 «<== 0,053764 0,117651

4 40,0146 20,0195 0,189877 0,284576

3 o0,0244 19,9951 === 0069177 0108188

6 60,0008 20,9561 0,122515 0,209554

7 79,9805 39,9902 0,111280 0,428397

Movement direction:

Mew axis value: I:I
Cancel

(®) Up | left (Empty area is created at bottom | right)
(") Down [ right (Empty area is created at top [ left)

Requirements:

¢ This dialog requires a map.
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e It can only be used the corresponding axis values come directly (without adding
up) from the hexdump.

Mode:
Choose whether you want to remove a row or column.

Statistics:

This table show for all rows/columns (except for the outmost ones), what would
happen if you would remove it (so that these values would be calculated by linear
interpolation instead). This table shows:

e The number of the row/column

¢ The axis value at this position

e The distance between the neighbor values

e The average error! that this would cause

e The maximum error that would be caused in one cell

1The 'Error' is the difference between the current cell values and the value that
would be calculated by linear interpolation if this row/column didn't exist.

This smallest value in each column is marked with '<==". WinOLS automatically
selects the row where the sum of the last 2 column is smallest.

Move direction:

Choose the direction in which you want to move the values after the row/column was
removed. Enter a new axis values here. WinOLS will use it to extrapolate the map
values from the neighbor values.

Note:
Keep in mind that the axis that you're modifying here, might also be referenced by
other maps.

Shortcuts
Symbol bar:
Keyboard:  Ctrl+Shift+Alt+Del

5.20 The command Again (Menu Edit)

This command repeats the last operation for the current selection. Operation
parameters (e.g. multipliers) are also repeated.

Shortcuts
Symbol bar: -
Keyboard: F9
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5.21

The dialog Checksums (Menu Edit)

Use this dialog to manage the checksums which were found for this project. A
checksum always consists of an area which is checked, an address where the
checksum is stored and parameters which determine how the checksums calculates
its results. A project can contain any number of checksums. For many cars there are
checksum modules available which automatically recognize and correct the
checksums.

For this dialog a simple and an extended view is available.

Simple view:

T Checesums T eem—
[EiMo checkeums available
% Checksum blocks Mo checksums available
&% Patches: Mo patches available
s Sync blocks: Ma zunc blocks available
Tasks

Checksums:  gearch

Diher tazks.. Extended wiew

[ 2k, ] [ Cancel ]

This dialog shows the current checksum status. Use the hyperlink "Search" to search
for a checksum for your current project. All checksum plugins automatically
recognize whether they can handle the current file.

Extended view:
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The following checksums exist: Elements  Simplified view

#

Algorithm From

] [ Add.... ] Properties. .. Apply

[ Inztalled plugins. .. ]
[

Search

] [ Lancel ] Search checksum online. .. ]

Use the button ‘Search’ to search automatically for all kinds of known checksums.
Additional modules are available for WinOLS which complement the main program.
If you click on 'Search checksum online’ WinOLS will check online if there is a
checksum module available for your current project.

Using the button ‘description’ you can edit the parameters of the selected checksum.
Use the button ‘apply’ to apply the selected checksum immediately.

Automatic checksums:

Several checksum modules are available for WinOLS to correct the typical cars. In
order to have them work properly it is absolutely necessary to use the unmodified
original of the car as a project original. Is this isn't the case, the checksum blocks
won't always be calculated correctly or won't be found at all

Manual checksums:

Pros may not only use automatically recognized checksums, but also add (Button
add) or change (Button edit) checksums manually. For details about manual
checksums please refer to the respective dialog.

Sync Blocks:

Click on the small black triangle next "Add" to add a Sync Block. It allows you to
keep two identical data range identical. If one of the two ranges is changed, the
other one will be changed, too.

Patches:
Some automatic checksums insert patches to correct the ECU. If you don't have an
automatic checksum, you can manually add a manual patch-tagblock at an empty

(C) 2025 EVC electronic



136 WinOLS 5.74

area to define the place where WIinOLS can store the tag information (see dialog "
Properties: Project”).

Note:
You can get an overview of the modules you have installed / licensed with a click on
the button ‘Installed Plugins’ (or with the function *? > Info about plug-ins’)

Note about addresses:

The addresses in this dialog do not refer to the current element, but to the addresses
like they are visible in the view <All elements>. This makes actions possible which
apply to the data of multiple elements at once.

Shortcuts:

Symbol bar: =/
Keyboard: F2/c

5.21.1 The Dialog Search checksum online (Menu Edit)

YWelcome to the checksum-online wizard.

With thiz dialog pou can test anling if there i a matching checksum
module for vour curent project. For this the ariginal version data of the
current project, the producer, the chassis text and pour customer number
will be transfered to v, evc. de.

Mo further data will be transfered.

And it workz like this:

1. Create a connection to the internet and click on "Start"’.

2. The data iz being transfered.
| ;00

3. The online analyziz reported the following results:
[ro rezults availble pet]

[ Start ][ Cancel ]

Use this dialog to search the EVC website for checksum modules matching your
ECU.

To do so, just go online and click on ’start’. This assistant will do everything else.

Note:
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An internet connection is needed for this dialog.

Note:

In rare cases you may need to specify a proxy server. You can do this at "
Miscellaneous > Configuration > Miscellaneous > Internet"”.

Shortcuts
Symbol bar: -
Keyboard: -

5.21.2 The dialog Checksum properties
{‘.heclcsum propertie: EE |

B aszic infarmation:

Algarithm: b anual Default-Checksum

Address area: [I -0

Data bit width: D ata organization:

@ 8 Bit 3 LaoHi [Intel]
116 Bit

=1 32 Bit HiLo [tMotorola)
Result:
@) Show change

Corect to; 0
[T Automatic conection

[] Fullbyte-Checksum [Corect ta 16 Bit)

' Showe zum

Use this menu to edit the parameters for the selected checksum. For automatically
found checksums most parameters are controlled by the program. In case of a
manual configuration you can edit several parameters.

Algorithm The selected algorithm
Address area The checksum is calculated from this area in the
project.

Data bit width Specifies whether 8 or 16 bit data will be taken from
the project

Data Describes how the data is organised, if 16 bit data is
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organisation used.

Correct to The checksum is written to this target address. For so-
called "Fullbyte" Checksums (see below for details)
(possibly large) data ranges will be modified to keep
the checksum correct.

Automatic If this checkbox is activated any changes in the

correction address area will result in a correction of the
checksum.

Fullbyte Activates the so-called "Fullbyte" Checksums (see

Checksum below for details)

With this dialog you may view the individual checksums that have been automatically
recognised or you may add and edit your own manual checksums.

The manual default-checksum is a so-called additive checksum. It is calculated by
simply adding all values in the address range. As a consequence it is possible to
correct changes without knowing the further details, like the exact position of the
checksum.

To achieve this, you simply must enter an address range that includes all your
changes and at the same time is smaller than the checksum range defined by the
manufacturer. (As you see, it's better to define this range smaller than larger.) For
the correct-to address just choose the next address after the address area you've
entered. If you now make changes, the values at the correct-to address are changed
in such a way that the total sum stays constant. You may also choose to only display
the sum and keep this value constant yourself. In this case you don’t need to enter
the target address (and some other things).

Fullbyte Checksums:

This is a variant of the normal checksum where the width of the register is wider that
the data. So, if you're working with 8-Bit data, then the actual addition is performed
in a 16-bit register (for 16-bit data a 32-bit register). The difference lies in the
calculation of the carry which is performed much later for fullbyte checksum. If you
increase the data of a normal 8-bit checksum by 300, you only have the decrease
the data by 44 (300-256) at another point. For fullbyte checksums you must subtract
the entire 300 at a difference place. That is the reason why you must specify an
address range as target.

Fullbyte Checksums in the daily work:

For this type, enter a target range instead of a target address. If you increase the
value of data, data in the target range will be decreased and vice versa. The required
size of the target range depends on how much you modify and how far the current
values in the target range can be modified.

Important:
he target address / the target range may not be within the address range that is
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checked, but must necessarily be within the range that is used by the ECU
calculation software.

Note about addresses:

The addresses in this dialog do not refer to the current element, but to the addresses
like they are visible in the view <All elements>. This makes actions possible which
apply to the data of multiple elements at once.

Shortcuts
Symbol bar: -
Keyboard: -

5.21.3 The dialog Sync block Properties

B aszic infarmation:

Address range 1: o

Addrezs range 2 0

Transfer changes az difference

Tranzfer changes in percent

] Cancel

This dialog allows you to add or modify a sync block. A sync block is a method to
make sure that a memory ranges which are currently identical will stay identical. If a
modification is done in one memory range, the same modification will be performed
in the other range, too.

You can reach this dialog, by clicking the small black triangle next to "Add" in the
checksum dialog.

Note about addresses: The addresses in this dialog do not refer to the current
element, but to the addresses like they are visible in the view <All elements>. This
makes actions possible which apply to the data of multiple elements at once.

Shortcuts
Symbol bar: -
Keyboard: -
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5.22 The Command Apply Checksum (Menu Edit)

Use this command to let WinOLS recalculate a single checksum block. If the
automatic checksum calculation is enabled, you won’'t need this command.

This command is only available if the cursor is within a checksum block and the
corresponding plugin is installed and registered.

Shortcuts

Symbol bar: =i
Keyboard: Alt+F2

5.23 The dialog checksum ranges (Menu Edit)

[ Calculate checksums for the fallowing range:

| - [ From hexdumpcursar ]

- [ From hexdumpcursar ]

Org Wer
2 Bit
16 Bit HiLa
16 Bit LaHi

[Drouble-click = copy)

This dialog shows the different checksums for a user-defined range.
This dialog is a "floating" dialog. All floating dialogs can be toggled with the tab key.
Shortcuts

Symbol bar: -
Keyboard: -
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5.24 The dialog

properties: Window: Hexdump (Menu Edit)

Properties: Hexdump (Text) &léj
Start addres: FFFFFFFA
Columns; 3
Values: |16 Bit (HiLo) -

Mumber format;

| Hexadecimal [Baze 16 Spstem] - |

Qriginal walues Difference

Sign Percent
Right side: | Bar display -|
| Dunanic
Yalue range: 0 P
+f | Factor offset; 1 1]
Leading /' Precizion: -0
Z-5cale: % | Standard
O ptirnal
Z-0ffzet: Standard
[ ak. ] | Cancel |

R

~

Start Address: The (virtual) address of the first upper-left cell. This can be a

Columns
Values

Number
format

Original
Sign
Difference

Percent

Right side
Value range

negative number if you shift the Hexdump to the left / right.
Enter the number of columns in this field.

Here the number of bytes per cell and the byte organisation (LoHi/
HiLo) can be edited. This also displays the value range.

You may choose between a binary, decimal and a hexadecimal
display.

Display the original values instead of the current version
Interpret the data as signed values

Instead of displaying the absolute value you may use this option to
show the difference between the cell value and the original value.

Instead of displaying the cell value this option can display the relative
difference between the cell value and the original value.

Optionally you may display the values as ASCII-Characters or bars.

If a bar display is chosen you may use these edit fields to enter the
number range displayed in bar. If only the number 1-10 are used in
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the data you could optimize the display for this value range.

If you activate the Option "Dynamic”, then WinOLS will automatically
determine the best scale for any bar data. This will allow you to
recognize more maps, especially in 16 and 32 bit mode, but it may
cause two rows in a one map to have a different scale. Once a map
is registered or recognized as potential map, WinOLS will
automatically use the value range of the map for displaying its data
in the hexdump.

Factor & Factor and offset help to display physical values by applying

Offset multiplication and addition before displaying them. The value is
calculated by the following formula: DisplayedValue = Value*Factor +
Offset

Leading Number of visible digits before the dot. This can be useful for 32

values which can have lots of digits in theory and often don't use so
many. Leave empty for automatic configuration.

Precision The number of visible digits after the dot.

Shortcuts

Symbol bar: @
Keyboard: Alt+Enter

(C) 2025 EVC electronic



Commands of the menu Edit| 143
5.25 The dialog properties: Window: Map (Menu Edit)
propertiesof.. A
Map | X-Axis | Y-Ais | Comment | | Hobuds

Description: 1 Description: 1

Unit: Id: Unit:

Mame: Map "Delphi 16" Data source: [Epmm v]

Start address: 242042 Start address: 242012

Column x rows: 16 X8 [C] Mimor map

Values: [16 Bit (HiLo) v] Values: [‘IE Bit (HiLo) v] Skip bytes: D

Mumber format: [Dec:irnal {Base 10 System) v] Mumber format: [DECiI'I'IEﬂ {Base 10 System) V]
Sign [ Difference [ sign
[ original values  [] Pencent Signature byte:

Crrganization: [Twodimensional - ]

Right side: [Bar display v]

Value range: 26593 - 7530

Factor. offset: 1,000000  * Eprom Factor, offsst: Ve 1.000000 = Eprom

) ' = i alue=

[ Reciprocal: Value ] + 0,000000 [T Reciprocal: ] + 0,000000

Wariable offset: [{none} v]

Leading / Precision: =) Leading / Precision: (=)
[ ok || canced || Hep |

The following information is stored in the first sheet of the window.

Description, Unit,
Id, Name

Data source

Start address
Rows & Columns
=>Axis-Addr.

Mirror map

User-defined descriptions. The name should describe the entire
map, while description and unit should refer the to map content
(without axis). The id is normally used only by A2L imports.
Defines the source, where the axis data is taken from. You may
choose the automatic enumeration or values from the eprom
(which may also be calculated with additions or subtractions or
indexed with alternating index and value). Moreover you may
decide to enter your own values, which are not stored within the
eprom, but externally.

This address defines the beginning of the map
The map size

This button only appears if you have changed the dimensions of
the map and the axes are located directly in front of the map.
Then you can correct the axis addresses accordingly with this
button.

Use this checkbox to display the map (map and axis) in reverse
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Values

Skip bytes

Number format

Sign
Original values

Difference

Percent
Signature id

Organization
Right side

Value range

Auto

Factor & Offset

Reciprocal
Leading

(in direction of the axis) order.

Here the number of bytes per cell and the byte organisation
(LoHi/HiLo) can be edited. This also displays the value range.

For some ECUs not all bytes are used for the axis but only every
second, for example. Enter the number of bytes that should be
skipped between 2 values / lines. (Tips for Vertical maps)

You may choose between a binary, decimal and a hexadecimal
display.
Displays the values as signed values.

Instead of displaying the modified version, WinOLS will show the
unmodified original values.

Instead of displaying the absolute value you may use this option
to show the difference between the cell value and the original
value.

Instead of displaying the cell value this option can display the
relative difference between the cell value and the original value.

An internal id found by the potential map search. The map axis
profiles use this in their signature.

The type of the map (point, 1d, 2d, 2d mirrored)

Optionally you may display the values as ASCII-Characters or
bars.

If a bar display is chosen you may use these edit fields to enter
the number range displayed in bar. If only the number 1-10 are
used in the data you could optimize the display for this value
range.

If you activate the option "Dynamic”, WinOLS will automatically
determine the best scaling for the bars. This makes it easier to
recognize maps, especially in 16 and 32 bit mode, but it can lead
to two lines of the same map having different scaling. Once a
map is detected or registered as potential, WinOLS uses its
value range to display it in the hex dump.

The value range can also be used (with the lock symbol) to limit
the values to a minimum/maximum when editing.

Use this button to optimize the value range for the current map
data.

Factor and offset help to display physical values by applying
multiplication and addition before displaying them. The value is
calculated by the following formula: DisplayedValue =
Value*Factor + Offset

Displays the data as the reciprocal of their original value.
Number of visible digits before the dot. This can be useful for 32
values which can have lots of digits in theory and often don't use
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Precision
Bar/°C/1
%

f(x)

Triangle

Offset map

so many. Leave empty for automatic configuration.
The number of visible digits after the dot.
Loads stored values for fields factor, offset, unit and precision.

Adjusts factor / offset in such a way that the value at the map
cursor is scaled to 100%

Starts a formula wizard to help you calculate factor / offset from
more difficult formulas or from sample values.

With the arrow button and the menu that is opened by this button
you may store your own preferences. To do so, just enter them
into the mentioned fields. To store them into one of the ten
entries, keep the shift key pressed while selecting an entry from
the menu. You can recall the values anytime simply by selecting
the entry again (without shift).

For trim maps, you can add (or multiply) another map as offset to
the current map. Simply select the other map from list. (The list
contains all maps with identical axis addresses.) For the view
WinOLS adds the values of the other map (but not the axes) like
an offset to the current map (or multiply with the current factor).

For 3d-map-windows:

Rotation
Perspective:
Z-5caling:
Z{ffset:

| Show axis description

870.33 % [ Default
-0.000000 | Standard |

3d
[EL: | Defautt
1.00 Default

Optimal

| Show vertical axis description

| Show helping lines

The fourth sheet contains information about the three-dimensional view. It is only
visible when the map is in view mode 3d.

Rotation
Perspective
Z-Scaling

Z-Offset

Show axis
description

This determines the rotation of the view around the vertical axis.
The value shows the influence of the perspective on the view.

The Z-Scaling determines how much the map is stretched or
compacted vertically for the view.

The Z-Offset is a vertical offset which can be used to make
negative values displayable.

Self-explaining

Show vertical axis Self-explaining
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description
Show helping Self-explaining
lines

Measured values:

If you have a table with measured values to which you want to approximate a map,
you can have WInOLS display these values in the 3d mode of the map. To do this,
select a CSV table with 3 columns (X, Y and value) on the 3d page. If the table is
very large, you can let WinOLS thin out the data. Then only the measured value

closest to a map point in X+Y direction will be used.

Map "Bosch 1T 16" *  [Potentielles kKF]

Jext 2d 3d, <

N
TLL

Templates for map names:

With the button ">" you can store / use a tree structure with map names. The text file

with the names must have the following format:
Name of the groupl

-Namel.1

-Namel.2

Name of the group2

-Name2.1

Shortcuts

Symbol bar:
Keyboard: Alt+Enter
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5.25.1 Calculate factor and offset

This wizard helps you to determine the factor and offset based on various source
data. This is useful if you have information about the conversion of the eprom values
which cannot be entered directly in WinOLS (as factor and offset) due to their
format. You can access this dialog via the f(x) button in the map properties window.

Calculate factor and offset

This wizard helps you to calculate factor and offset from typical formulas. For example if you have written documention about the conversion of the
values,
Formula: Swap inputfoutput
0 1 a 1
() Qutput = () Output = + |0
1 1 0
(O output = P1: P2 P3: P4:
() any sample values: (") Corner values:
Or 3 values for redprocal formula
1] 2557.000000
a 100
#3
Result: Testit:
Factor: spromvave: [ |
[Jrecdiprocal with Offset: I:I
Cancel

Regardless of which of the 5 variants you choose, the wizard immediately calculates
the factor and offset and displays them in the bottom left corner and applies them to
the map in the background for testing purposes. This happens only if this is
mathematically possible (e. g. no division by 0). In addition, you have the option of
having individual values converted on the basis of the determined data for testing
purposes.

1) and 2) given formulas
If you have the source formula, you can simply select the appropriate formula here
and enter the values. For example, you might have the following conversion formula:
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VAL = 100/ (0.00001 * N)

First select the type of formula. The input size in the example is below the fraction
line, so it is the right formula. Enter the values. The number 100 above the fraction
line. The number 0.00001 below the fraction line as a factor. In our example, no
further value is added. So just leave the additive variable under the fraction line at 0.

3) Flexible formula
In this input field you can enter a formula (such as "(input+3)*10") or select a
predefined formula and insert its (up to 4) parameter values on the right.

For all formula formats, you can activate the checkbox "Swap Input/Output”. Use this
if your source formula is formulated backwards, i. e. converts displayed values to
eprom values.

4) Example values

If you have sample values for the displayed value and the corresponding eprom
value, you can enter them here. Normally, two pairs of values are sufficient to
determine the data. Only when using reciprocal values 3 values are required. It is
important that the values for #1 and #2 (and possibly #3) are not identical.

5) Corner values

This is a variation of the example values in which the system automatically
determines the eprom values from the project. You then only need to enter the
displayed values. Pick 2 or 3 corners from the map with different values and enter
their display values. If there are not enough different basic values in the map, this
method cannot be used.

Swap input/output

If your source formula defines how to calculate the eprom values from the displayed
values, then input and output are reversed. This checkbox causes WInOLS to
calculate the corresponding inverse formula.

Reciprocal?

If you do not have the formula, it is difficult to see if a reciprocal value (1/x) is used
only on the basis of the values. Therefore, it is best to try it first without, using 2
values. These 2 will probably be converted correctly (you can see this in the
background in hexdump). If other values are still wrong, activate the reciprocal (= the
third input value) at 3) or 4).

Impossible?

Not every formula can be translated is the scheme of WinOLS. For some this is
unfortunately mathematically impossible. WinOLS then displays a corresponding info
text. This even includes some of the given formulas of 2), depending on how P1..P4
are filled out.

Shortcuts
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Symbol bar: -
Keyboard: -

5.25.2 Number to Text

You can use this dialog to display individual values as text. You can access this
dialog via the "Text" button in the map properties.

Number to text

WinQLS can display individual values as texts. This table defines the assignment.

[]Hex Format: "Number = Text" port.

[] Key +/- jumps only to these values Example: 0=C
: : 1=0n // Tooltip
oK o *=lIndefined

Sometimes numbers have certain textual meanings. WinOLS can use this dialog to
display the text instead of the number in text mode. You can specify ranges by
separating 2 numbers with "..". Optionally (with *), all values that are not assigned
can be translated to a standard text. All texts should be short, but you can use "//" to
define comments that are displayed in the mouse tooltip.

Example:

0=Off

1=0n // Tooltip

10..19=Range // With Colors #ff0000 #0000ff
*=Undefined

You can edit cells via Inplace Edit and enter the text there.

To transfer the content of text files into this dialog, you can drag the file into this
dialog or use the import button. Hex values should have the prefix "0x" in the files.
You can also drag (multiple) files directly onto the "Text" button in the map properties
dialog. Or hold Shift while clicking the "Text" button to go directly to the file dialog. If
you want to add the file (instead of replacing the content), hold down Ctrl while you
drag in the file / click on "Import".

The tooltip can contain colors in CSS format (RGB or RGBA) for the value in the
map. First the text color, then the background color. Or with double # only the
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background color. Examples:

100 = xy // red text #ff0000

101 = xy // red background ##ff0000

102 = xy // white text on red background (semi-transparent) #ffffff #f000080

Shortcuts
Symbol bar: -
Keyboard: -
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6

Commands of the menu Hardware

The menu Hardware contains command to configure and use eprommer and

simulator:

Producer

Swap lines

BDM / Compare

BDM / Program

BDM / Testempty/Delete
BDM / Read

BDM / Info

BSL / Compare
BSL / Program
BSL / Read

BSL / Info

Eprom / Compare
Eprom / Program
Eprom / Testempty/Delete

Eprom / Read

Displays the dialog for editing the eprom
producer parameters

Shows the dialog to swap lines

Compares the current project with the
values in the BDM/ECU

Programs the current project into the
BDM/ECU

Checks if the current BDM/ECU is empty
and/or deletes it

Reads the values from the BDM/ECU
into the project

Open the BDM page in the WinOLS
configuration. For information about the
BDM serial number in the project please
use the dialog "Properties: project”.

Compares the current project with the
values in the BSL100/ECU

Programs the current project into the
BSL100/ECU

Reads the values from the BSL100/ECU
into the project

Open the BSL page in the WIinOLS
configuration. For information about the
BSL serial number in the project please
use the dialog "Properties: project”.

Compares the current project with the
values in the eprom

Programs the current project into the
eprom

Checks if the current eprom is empty
and/or deletes it

Reads the values from the eprom into the
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Eprom / Parameter

Eprom / Options

Simulator / Load

Simulator / Properties

Simulator / Check map
accesses

Simulator / Delete map
access info

project

Allows to edit address ranges for the
eprom-access

Allows to edit special options for eprom
types

Loads the current configuration into the
simulator

Shows the simulator properties

Checks for all maps whether they are
used and shows the results in the map
window.

Deletes the markers in the map window

The dialog Producer (Menu Hardware)

File zize

16 KByte [27128)

32 KByte [27256)

E4 KByte [27512)

128 KByte (27C010)

255 KByte [27C020/29F 200
512 KByte [27C040/29F 400
1024 KEyte [29FE00)
2043 KByt [29F160]

1 | 1]

Type Producer

44-Pin 8 MB

Am29BLB02CE  AMD
Am23F200B  AMD
Am23F300T  AMD
Am23LV300BE AMD
Am23LV300BT AMD
D23F300F2E  Intel
C28F300F3T  Intel

M 23F 2008 SGS-Thoms.
M 23F200T SGS-Thaoms.

Organization

3 Bit epram
16 hit it bwo 8 bk eproms
16 Bit eprom

Copy protection

hiot encoded

[] Criginal and version in one eprom

Only B atronis:

Chonze kevfile...

bl anufacturer

Werzion B atronixl d

(] J[ Search ][ LCancel

153
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Since a project normally has a fixed eprom size, you can normally use the Producer
dialog only to switch between different types, like CMOS or NMOS and the different
programming algorithms.

The organisation selection offers one option to merge the contents of two 8-bit
eproms, which are read consecutively into one 16-bit eprom.

With the choice of the eprom type, the configuration of the simulator module is
automatically made, too. This is especially important for 28F512, which has a
different pin configuration (32 Pins) as 27C512 (28 Pins).

The option ‘Original an version in one eprom’ works together with an extern switching
adapter (e.g. KEY520). This option is not for use with the simulator with automatic
switching. To use the simulator switching, choose the option ‘Switch original /
version’ from the simulator properties.

If you're using Batronix hardware, you also need to select the right chip in the list box
at the bottom, because Batronix sometimes uses different ids. You can use the
Search button for this, too.

Shortcuts

Symbol bar: ﬂ
Keyboard: Ctrl+Shift+H
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6.2 The dialog Swap Lines (Menu Hardware)

l<.i'-.ll elements:

[] Enable swapping Load profile:;

[ Mull profile

| Swap 8 Bit HifLo

[ Yolvo/Renault Siemensz ECL
| WAG Simos 3
l
l
l

Bosch EDC1E
Bosch MES
Peugeat 307 HDI

Current state:

Eprom mode: 2 Bit

[ *R0LS: The curent data is ot swapped.
[=Recommended state]

|
| [rvert line

E wpart; “When exporting, programming,
zimulating no data is swapped.

D ataline eprom

D ataline processzor

Use this dialog to swap or invert lines when reading or writing eproms or when im- or
exporting data. Normally you'll work with "readable” data, so that texts can be read
and checksums can be calculated. The swapping is done on-the-fly when the data is
exported. If the project currently doesn’t contain "readable” data (this is displayed in
the right part of the dialog) you may use the button "Extended" to actively apply a
swapping.

You may use several predefined typical profiles. If your project contains multiple
elements, you may swap each element individually.

Note:
Which values you may edit (8 or 16 Bit) depend on your current eprom. You may
change the current eprom directly from this dialog.

Shortcuts
Symbol bar: -
Keyboard: -
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6.3 BDM

Please choose a subtopic.
6.3.1 The dialog BDM / Compare (Menu Hardware)

Status:
Project: .. 0389060164 | Wers. O

Elements:
Frocesszor (MPCE55/E]

Eprom [29BLE02-EDCTE]
Eprom 2

EE prom [5T95320]

[ Stark ][ LCancel ]

Shows differences between the BDM/ECU and the project. You can choose which
elements to compare.

Elements are printed bold, if they contain contain differences between original and
version (in the PC memory — not differences between ECU and PC).

Note:
BDM operations are only supported if the project type was set to "BdmToGo" in the
Project properties or if the project is empty.

Shortcuts
Symbol bar: -
Keyboard: -
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6.3.2 The dialog BDM / Program (Menu Hardware)

Statuz:

Project: L, 023890680184 Vers. 0

E lements:

[T Processor [MPCERS/E)
] Eprom [29BLE02-EDCR]

Eprom 2
[ EEprom [5T95320]

Programs the contents of the current project into the BDM/ECU interface. Non-empty
areas are automatically detected and deleted. You can choose which elements to
program.

If you want to protect your project from being read with WinOLS by competitors,
please activate the "Bdm/Bsl read protection” in the Project properties before
programming.

Elements are printed bold, if they contain contain differences between original and
version (in the PC memory — not differences between ECU and PC).

Note:
BDM operations are only supported if the project type was set to "BdmToGo" in the
Project properties or if the project is empty.

Shortcuts
Symbol bar: -
Keyboard: -
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6.3.3 The dialog BDM / Testempty (Menu Hardware)

Statuz:

Project: L, 023890680184 Vers. 0

Elemnents:

Froceszor (MPCH55/E)

Eprom [29BLE0Z-EDCTE]
Eprom 2

EEprom [ST95320)

[ Teztemply ][ Eraze ] [ LCancel ]

Allows to test you if the BDM/ECU is empty and to delete it.

Elements are printed bold, if they contain contain differences between original and
version (in the PC memory — not differences between ECU and PC).

Note:

BDM operations are only supported if the project type was set to "BdmToGo" in the
Project properties or if the project is empty.

Shortcuts
Symbol bar: -
Keyboard: -
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6.3.4 The dialog BDM / Read (Menu Hardware)

Statuz:
Project: L ers 0

Elements:
Froceszzor [MPCEE5/E]

Eprom [29BLE02-EDCTE]
Eprom 2

EEprom [ST35320)

Start ][ Cancel ]

Allows you to read the current BDM/ECU contents as a new project or a new
version. By default all elements from the ECU are read, but for versions you may
disable some if you're sure that you don’t need them. When reading the original, you
must read all elements.

Elements are printed bold, if they contain contain differences between original and
version (in the PC memory — not differences between ECU and PC).

Note:

BDM operations are only supported if the project type was set to "BdmToGo" in the
Project properties or if the project is empty.

Shortcuts
Symbol bar: -
Keyboard: -

6.4 BSL

Please choose a subtopic.
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6.4.1

The dialog BSL / Compare (Menu Hardware)

Statusz:
Project: Audi, A3, Werz. 0

Elements:
Prozezzor

Frocesszar
EE prom

[ Start ][ Cancel ]

Shows differences between the BSL100/ECU and the project. You can choose
which elements to compare.

Elements are printed bold, if they contain contain differences between original and
version (in the PC memory — not differences between ECU and PC).

Help:

The EVC website provides information and images to find the right connections. You
can use the link "Online" to reach it. To have this information available without
internet connection you can use the "Update" link to store it locally / update it and
use the "Offline" link to access it.

Note:
BSL operations are only supported if the project type was set to "BsIToGo" in the
Project properties or if the project is empty.

Shortcuts
Symbol bar: -
Keyboard: -
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6.4.2 The dialog BSL / Program (Menu Hardware)

Program BSL ?

ECU: W
webzite

[ ] Recovery-made: Program without reading beforehand

Statusz:
Project: YW Touran [Importierte Yerzion]

Elements:
Processar
Eprom

[ | EEpram
[rata

Stark

Programs the contents of the current project into the BSL100/ECU interface. Non-
empty areas are automatically detected and deleted. You can choose which
elements to program.

If you want to protect your project from being read with WinOLS by competitors,
please activate the "Bdm/Bsl read protection” in the Project properties before
programming.

Elements are printed bold, if they contain contain differences between original and
version (in the PC memory — not differences between ECU and PC).

Note:
BSL operations are only supported if the project type was set to "BsIToGo" in the
Project properties or if the project is empty.

Shortcuts
Symbol bar: -
Keyboard: -
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6.4.3 The dialog BSL / Read (Menu Hardware)

6.5

Read BSL ?

ECL: W

Wehzite
Statuz:

Project: pcd_10044. ols [Qriginal]

Elements:

| Froceszor
| Eprom

| EE prom

| Data

Stark

Allows you to read the current BSL100/ECU contents as a new project or a new
version. By default all elements from the ECU are read, but for versions you may
disable some if you're sure that you don’t need them. When reading the original, you
must read all elements.

Elements are printed bold, if they contain contain differences between original and
version (in the PC memory — not differences between ECU and PC).

Note:

BSL operations are only supported if the project type was set to "BsIToGo" in the
Project properties or if the project is empty.

Shortcuts
Symbol bar: -
Keyboard: -

Eprom

Please choose a subtopic.
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6.5.1 The dialog Eprom / Compare (Menu Hardware)

Froject: L AA0307ER1 AN Yers. 0
E prom: D27A12, Intel, IMTEL
Adapter:  Batronix

Options:  unverschiiizzel

Hi-Byte Lo-Bute (@) Bath

_ | 0:00

Buicktest [Compare changed bytes and spot checks)

| Start |[ Cancel ]

Shows possible differences between the eprom and the current memory contents.
Use the encryption option to compare eproms for EVC-KEY modules.

You may activate a quicktest. If you do so, WinOLS will not compare the entire
eprom, but only bytes where the current version differs from the original and a few
additional bytes as spot checks.

Note:
Eprom operations are only supported if the project type was set to "Eprom" in the
Project properties or if the project is empty.

Shortcuts

Symbol bar: ﬂ
Keyboard: -
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6.5.2

6.5.3

The dialog Eprom / Program (Menu Hardware)

Froject: L AA0307ER1 AN Yers. 0
Eprom: D27A12, Intel, IMTEL
Adapter:  Batronix

Optionz: unwverzchiuzzelt

Hi-Byte Lo-Bute (@) Bath

Next to shown information about the project and eprom the configured adapter is
show. If a keyfile for EVC-KEY eprom copy protection modules is used, the option
encryption will be displayed.

Note:
Eprom operations are only supported if the project type was set to "Eprom" in the
Project properties or if the project is empty.

Shortcuts
Symbol bar: ﬂ
Keyboard: -

The dialog Eprom / Testempty/Delete (Menu Hardware)

Configuration:

Project: L. 48030755140, Yers. 0
E praom: D27512, Intel, MTEL
Adapter; 28 pin socket

Options:  urverschliizzelt

Statuz Ready.

Eraze automatically, if not empty

Teztemply Eraze

(C) 2025 EVC electronic



Commands of the menu Hardware 165

Compares the eprom contents with hex FF for eproms with 8-bit bus and with hex
FFFF for eproms with 16-bit bus. If any differences occur, the test can be stopped
and the eprom can be deleted.

Note:

Eprom operations are only supported if the project type was set to "Eprom” in the
Project properties or if the project is empty.

Note:
This operation is only support for the Grol3e-Wilde eprommer.

Shortcuts
Symbol bar: E
Keyboard: -

6.5.4 The dialog Eprom / Parameters (Menu Hardware)

Eprom parameter EEI

Eprom
Start address: [

End address: FFF

b emary
Start address: 0

End address: FFF

Fleaze note: If you're uzing the option "inteligent
programming’’, it iz pozsible that areas larger than
the ones you specified here will be deleted and
rewritten..

[ k. H Cancel I

This option is not needed normally. It allows you to program parts of an eprom.

Note:

Eprom operations are only supported if the project type was set to "Eprom" in the
Project properties or if the project is empty.

Shortcuts
Symbol bar: Q
Keyboard: -

(C) 2025 EVC electronic



166 WinOLS 5.74

6.5.5 The dialog Eprom / Read (Menu Hardware)
Fead eprom EE'

Froject: Lo ers 0
E prom: 2732, . B0 ms
Adapter:  Batronix

Options:  unverschiiizzel

Hi-Byte Lo-Bute (@) Bath

, | 0:00

Buicktest [Compare changed bytes and spot checks)

Start |[ Lancel ]

An eprom can be read as original or version. An open project is necessary, but the
project doesn’t have to contain data.

Note:
Eprom operations are only supported if the project type was set to "Eprom" in the
Project properties or if the project is empty.

Shortcuts
Symbol bar: ﬂ
Keyboard: -

6.5.6 The dialog Eprom / Options (Menu Hardware)

Programming:
[ Inteligent pragramrming
[ Testempty beforehand
[] Delete beforehand

[] Compare afterwards

FSOP44 - Adapter:
(71 PAD4OD
@ PADATT [=AS44D40)

ok, { [ Cancel
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Here you can switch different adapters, which might be used alternatively and cannot
be recognised automatically.

Furthermore you may select whether the eprom should be tested or deleted before
writing and whether it should be compared afterwards.

The option "intelligent programming" allows a very fast programming. It is only
available for eproms which allows the deleting of areas. If it is activated, the eprom
will be compared the memory and only the areas which were changed will be deleted
and reprogrammed.

Note:
Eprom operations are only supported if the project type was set to "Eprom™ in the
Project properties or if the project is empty.

Shortcuts
Symbol bar: -
Keyboard: -

6.6 Genius

Enter topic text here.
6.6.1 The dialog Genius / Import (Menu Hardware)

Allows you to import the data from the NewGenius hardware into WinOLS.

Requirements for NewGenius actions:

1. Plugin OLS1003 needs to be installed and registered.

2. Dimsport's current NewGenius driver need to be installed.
3. Dimsport's NewGenius hardware needs to be connected.

Shortcuts
Symbol bar: -
Keyboard: -

6.6.2 The dialog Genius / Export (Menu Hardware)

Allows you to export the data from WinOLS into the NewGenius hardware.

Requirements for NewGenius actions:

1. Plugin OLS1003 needs to be installed and registered.

2. Dimsport's current NewGenius driver need to be installed.
3. Dimsport's NewGenius hardware needs to be connected.

Shortcuts
Symbol bar: -
Keyboard: -
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6.6.3

6.7

6.7.1

The dialog Genius / Explorer (Menu Hardware)

Allows you to view the current contents of the NewGenius hardware.

Requirements for NewGenius actions:

1. Plugin OLS1003 needs to be installed and registered.

2. Dimsport's current NewGenius driver need to be installed.
3. Dimsport's NewGenius hardware needs to be connected.

Shortcuts
Symbol bar: -
Keyboard: -

Simulator

Please choose a subtopic.

The command Load Simulator (Menu Hardware)
L]
This command will write all eprom data into the simulator.

Import:
You must turn the ignition off before using this command!

Note:

Eprom operations are only supported if the project type was set to "Eprom" in the

Project properties.

Shortcuts
Symbol bar: -
Keyboard: -
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6.7.2

The dialog Simulator / Properties (Menu Hardware)
Simulator properties EE .I

[nfo:
Mame: 2732

Configuratior:,  SIM27040
Organization:  Bitd
Connectioh:

Line swapping:  OFF
OLC-File:

OLC-Infao:
Aocezs time:

Froperties:

[Clitwtarnark [LUse access display for selection

[] Orly moritar (o simulator function)]

E arly timing [roarrnal tirning]
Allo write acceszs to zimulatar [dizallow)

Fead data back from simulator, iF neceszsany

Settings:
[] Switch original # version:

Foritor afterglow: Seconds

Update delay:

]9

The upper block contains information about the currently selected producer
hardware.

If the checkbox ‘Automark’ is activated and the engine is running, then any accessed
cells are automatically used as a selection for any operation (for example for + and

).

The checkbox ‘Only monitor’ disables the simulator and lets WinOLS only monitor
the engine.

The make the development of vehicles which perform checksum tests at startup time
easier, you may select the option ‘Switch original / version’ which automatically
switches from the original to the changed version after a defined time. This option
must not be confused with the option ‘Original and version in one eprom’ in the
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producer dialog, which needs an eprom of twice the normal size and a switching
module like the KEY520.

While monitoring every memory access is marked on the screen (by default in red).
Use the afterglow field to configure the number of seconds the marking shall last.

Use ‘Write pulselength’ to configure the simulator timinig. If the value is too small,
the data might not reach the simulator memory. If the value is to large, the simulator
might crash when performing online-changes of the eprom contents.

The ‘Update delay’ is the time WIinOLS will wait after any changes until the changes
are written to the simulator memory.

Note:
Since program version 1.030 it is no longer necessary to enter the connection code.
It will be automatically be recognised now.

Shortcuts
Symbol bar: -
Keyboard: -

6.7.3 The command Simulator / Check map accesses (Menu Hardware)

A project may contain many maps but not all are necessarily used right now. With
this command you can instruct WinOLS to check all maps to see whether it is used
(=accessed by the hardware) or not.

All maps that are used will be marked red (the usual simulator colour) in the map
selection window. This information is not automatically updated. If you want to get
the latest information, you must use this command again.

This command is only available if the current project is online with the simulator.
Note: This command may take some time (depending on the number of maps).

Shortcuts
Symbol bar: -
Keyboard: -

6.7.4 The command Simulator / Delete map access info (Menu Hardware)

If you used the command 'Simulator / Check map accesses' you will have several
maps marked in red in the map selection window. This command will delete all
marking information for that window. Neither the maps nor the hexdump data will be
changed in any way.

This command is only available if the current project is online with the simulator.

Shortcuts
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Symbol bar: -

Keyboard:

171
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7 Commands of the menu View

The menu View contains the following commands:

Symbol bars
Status bar

Move origin left
Move origin right

The command
Cursor position as
origin

More columns
Less columns

Percent & Co.
Right side

Zoom

Scale 100%
Unzoom

Connect dots / Fill

surfaces

Show Rowmarkers

Differences

- first
- previous

Toggles the different symbol bars
Toggle the status bar

Shifts the start address of the current 1 to the
left

Shifts the start address of the current 1 to the
right

Shifts the current cursor position to make it the
leftmost cell. (Double: Mark cells)

Increases the number of columns by 1
Decreases the number of columns by 1

Changes the way the differences are
displayed, if factor and offset are used and if
the version values are used

Allows you to change the view mode of the
right side and whether the right side should be
fixed or not.

Enlarges the display

Resets the display to its standard value (2d
only)
Makes the display smaller

Connects the separate dots with lines (2d

only)
Fill the surfaces with colour (3d only)

Visualises the (imaginary) rows by lines (2d
only)

Shows the differences of the current map as a
list

Moves to the first difference in the current map
Moves to the previous difference in the current
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7.1

7.2

7.3

- next

- last

Choose reference
version

Connect windows

Optimize value
range

Detect Map

Support map
selection

map

Moves to the next difference in the current
map

Moves to the last difference in the current map

Allows the user to change the version which
will be used as original

Activates the connection between the current
window and another window. (Shift to skip the
dialog.)

Calculate the optional value range for the bar
display

Calculate the optional value range for the bar
display

Supports the selection of maps by improving
selections you made.

The command Symbol bar (Menu View)

Use this command to toggle the symbol bars.

The command Status bar (Menu View)

Use this command to toggle the status bar. The bar (at the bottom of the WinOLS
windows) contains information about the selected menu item, about the simulator

hardware state and the cursor position.

You can find more information in the status bar page.

The command Move origin left (Menu view)

Use this command to move the beginning of the shown area of window. This might

be necessary to mark maps correctly.

Note:
This command is only available for hexdumps.

Shortcuts
Symbol bar: -
Keyboard: Ctrl+Left
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7.4

7.5

7.6

7.7

The command Move origin right (Menu view)

Use this command to move the beginning of the shown area of window. This might
be necessary to mark maps correctly.

Note:
This command is only available for hexdumps.

Shortcuts
Symbol bar: -
Keyboard: Ctrl+Right

The command Cursor position as origin

Use this command to move the current cursor position ti the beginning of the shown
area of window. This might be necessary to mark maps correctly.

Tip:

Double-tap the hotkey to move the origin and then skip n cells and then select n cells
(where n is the value in the current cursor position). This is helpful for creating 1d
maps in the format "NumberOfCells AxisCells MapCells".

Shortcuts
Symbol bar: -
Keyboard: Ctrl+J
The command More columns (Menu View)

Use this command to increase the number of visible columns by 1.

Note:
This command is only available for hexdumps.

Tip:
You can change the number of columns also with the separator line between
hexdump and bars. Either by "Click and drag" or with a right-click.

Shortcuts

Symbol bar: -
Keyboard: M

The command Less columns (Menu View)

Use this command to increase the number of visible columns by 1.
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7.8

7.9

7.10

Note:
This command is only available for hexdumps.

Tip:
You can change the number of columns also with the separator line between
hexdump and bars. Either by "Click and drag" or with a right-click.

Shortcuts
Symbol bar: -
Keyboard: W

The command Zoom (Menu View)

Use this command to enlarge the display.

If you're in text mode, a larger font will be used to display data. In 2d mode the
graphical display will be enlarged horizontally. Keep the Shift Key pressed to enlarge
the display vertically.

Shortcuts
Symbol bar: @
Keyboard: -
Mouse: Ctrl + Mousewheel

The command Scale 100% (Menu View)

Use this command to reset the graphical display horizontally to 100%. This
command is only available in 2d mode.

Keep the Shift Key pressed to reset the vertical display.
Shortcuts

Symbol bar: -
Keyboard: -

The command Unzoom (Menu View)

Use this command the make the display smaller.

If you're in text mode, a smaller font will be used to display the data. In 2d mode the
graphical display will be displayed horizontally smaller. Keep the Shift Key pressed
the make the display vertically smaller.

Shortcuts
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Symbol bar: @

Keyboard: -
Mouse: Ctrl + Mousewheel

7.11 The command Connect Dots (Menu View)

2d mode:
This command toggles the display of connecting lines for the separate dots.

3d mode:
This command toggles the filling of surfaces with colours.

The command is only available in 2d and 3d mode.

Shortcuts

Symbol bar: E /
Keyboard: -

7.12 The command Show Rowmarkers (Menu View)

Even though in 2d mode the data is displayed as a 'flat' sequence of values,
WiInOLS manages the data in rows and columns internally. (You may switch to text
mode any time to see the rows and columns.) The columns are important for certain
types of selections and thus also for the modification of values and the creation of
maps.

Use this command to toggle the display of line breaks with helping lines.

This command is only available in 2d mode.

Shortcuts
Symbol bar:
Keyboard: -
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7.13

7.14

The command Differences (Menu View)

rDiFFerences to the arigin
I Fram addrezs: 0 M ax. number: 20000 [ ptian:

Mo, Addr... Criginal Werzion Change =

203 182BF AR AC 1
204 182COo BS E9 1
205 182C1 Ca CF 1
206 182C2 EO El 1
207 182C3 4 5 1
208 182C4 32 33 1
209 132C5 5& 5B 1
210 132Ca g2 g3 1=
L+1 J[ -1 J[ Original |[ +100 | [ -100 |

This dialog shows all differences (up to 2000) from the original to the current version
of this window. The different buttons in this dialog allow you to edit the values in the
list.

WinOLS tries to keep this window in sync with the hexdump or map window. If you
change the cursor position in the hexdump or map window, the differences window
will show the respective entry. If you change the position or select entries in the
differences window, WinOLS will change cursor position and / or selection in the
hexdump or map window.

The size of the dialog may be configured.

This dialog is not modal, meaning that windows lying behind the window may still be
used. This dialog is a "floating" dialog. All floating dialogs can be toggled with the tab
key.

Shortcuts

Symbol bar: E
Keyboard: Ctrl+U

The command Differences / first (Menu View)

Use this command to move the cursor to the first difference between the original and
the current version within the current window.

Shortcuts
Symbol bar: ﬂ
Keyboard: E
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7.15 The command Differences / previous (Menu View)

Use this command to move the cursor to the previous difference between the
original and the current version within the current window.

So that larger files can be searched efficiently, there are 2 special rules:

e If several differences are directly behind each other, then the function only stops at
the first difference.

e If the cursor is in the hexdump and several differences are within the same map,
the function only stops at the first difference of the map.

Shortcuts
Symbol bar: ﬂ
Keyboard: V

7.16 The command Differences / next (Menu View)

Use this command to move the cursor to the next difference between the original
and the current version within the current window.

So that larger files can be searched efficiently, there are 2 special rules:

o If several differences are directly behind each other, then the function only stops at
the first difference.

e If the cursor is in the hexdump and several differences are within the same map,
the function only stops at the first difference of the map.

Shortcuts
Symbol bar: ﬂ
Keyboard: N

7.17 The command Differences / last (Menu View)

Use this command to move the cursor to the last difference between the original and
the current version within the current window.

Shortcuts
Symbol bar: M
Keyboard: L
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7.18 The dialog Select reference Version (Menu View)
[T e e v O == i)

Reference version:
(7 &) other projects

Audi A6
Original [0 Bytes different)
i mod [367 Bytes different]

Created: ?
Changed: 121002001 [15:35:18]

bode of comparizon; Other:
(1 Wersion > Reference Talerance; 0
(@ Version = Reference

_ i Offzet: 1]
() Werzion < Reference

k. ][ Drefault ][ Cancel ]

Several functions in WinOLS use a ‘Original version’ as a reference. By default this
is the version read from the eprom. But you may choose any other version of the
current of another project.

Apart from the selection of the reference project you can also selection the kind of
comparison for the visual display of the differences. For example a minimum
difference from the original may be required to mark the cell as changed.

Furthermore an offset may be entered. This is useful when the data in one project is
moved (compared to the other one).

This is just one of several options to import data from other projects.

Shortcuts
Symbol bar:
Keyboard: -
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7.19 The dialog Select the connection window (hexdump) (Menu View)

> Vid Important:
LSRN This page explaing connecting Hexdumps. Here's the page about connecting

Search:
+ 1l ¥
+ +

L)L

Tolerance
% -

Result:
none

Copy:
O

Differenc:

“or»
& WP

maps.
Select connection window I. ? &J

Current project; Connect with:
E=1- -TetChk-Ols220)
- 5 Original
=- -TstChk-Ol223 (330411)

L Origital
-TatChk-0lz223 [350411)
Original

Compare values with; Compare values with:

* [Original " Original

" connected project * connected project

Address offset |0 Autamatically

Cancel |

b -

Right Dialog:

It is possible to connect window. If two windows are connected, any changes to
the visible area will happen to both windows in sync. If one window is scrolled, the
other one is scrolled in the same way.

If the connection is activated, this dialog is displayed to select the connection
window. If you want to skip this dialog and use the window you also used last
time, keep the Shift-Key pressed while selecting this option (works with pulldown
menu and icon bar). Alternatively, you can click on another project in the WinOLS
workspace while holding down the Shift key.

Address offset: This field contains the offset that will be used when keeping the
dialogs in sync. With the 4 buttons next to it you can define how the field should
be initialized now, and in the future when the dialog is skipped. With the button
‘Automatic’ WinOLS can search for an area in the other project which is similar to
the area at the current cursor position in the current project. If such an area is
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found, the offset is used. The 'Cursor' button takes the current text cursor
positions as the basis for the offset. The 'Scrollbar' button takes the current scroll
position in the form of the first currently visible address.

Left Dialog:
When you're working with connected windows, a small window will appear between
the projects.

Section Connect:

You have several possibilities to change the offsets (the address difference between

the windows) between the windows:

e You may manually enter a number.

e Use one of the search options.

e With the buttons +/- you may change the address offset by one unit (depending
on the current bit width). Hold Shift or Ctrl+Shift to make this faster.

e You may click on the checkbox ‘Offset’ to deactivate the connection. In this mode
you can move one window and re-establish the connection when you found the
right offset or use the button "At cursor” to calculate the offset from the 2 cursor
positions.

e Hold Shift while clicking into the other (inactive) hexdump. The old/new cursor
positions determine the offset.

Section Search:

If the checkbox is activated, WinOLS automatically uses 7 different search modes,
each in 2 directions (which can cost noticeable performance in large projects). The
program searches the project that the arrow points to and search for the data of the
project that the arrow points away from. A means that search results
are available. If the * then the current offset is one of the
search results. And ][R e[e]¥[glsl means that this is only the case for the original

(and not the version).

The 7 search modes are (from top to bottom):
1. Search for the data around the current cursor position
2. Search for the data around the current cursor position, but only inside the maps
3. Search for the selected data (only the first 500 selected cells are compared for
performance reasons)
. Search for the selected data, but only inside the maps
. Search for the map that the cursor currently is on
. Search for the map with identical ID as the one that the cursor currently is on
. Search for the map with identical Name as the one that the cursor currently is on
Note: The search feature can slow down WIinOLS noticeably. You can use the
checkbox to turn it off.

~No ok

WinOLS5:
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The icons in the middle between the arrows are clickable. If activated and there is (in
the respective line) only exactly 1 result, then it will be applied automatically.

Section Tolerance:
Here you can enter the desired search tolerance.

Section Result:

This section shows the result of the most recent search. The text shows the number
of the current result, following by the total number of result (max. 200). You can use
the "Slider" to screen through the results, which will adjust the offset. After the
search function is used the slider is automatically set to the search result that is
closest to the original offset. If you want to go to the results individually, click on the
slider once and then use the cursor keys.

Section Copy:

[X] Checkbox: Activate the checkbox before "Copy" to automatically trigger copy
whenever you've created a selection using the mouse. WinOLS will copy the maps if
you selected any, and otherwise the cells. WinOLS will automatically use the last
settings of the respective dialog.

Use these buttons to manually copy data to the respective other side:

1. The currently selected cells.

2. The map under the cursor (or the currently selected maps, if multiple maps are
selected).

3. The text infos from the current map on the source side to the current map on the
target side. (Text infos are: Name, Id, Unit, Factor, Offset, Precision) If you press
Ctrl, the following fields will be transferred additionally: Type, Sign

4. The selected comments / the comment at the cursor position.

Section Differences:

This section is identical with the functions from the view menu. It contains buttons to
move the cursor in either window to the first/previous/next/last difference. The
buttons on the outer sides use the data of their side. The buttons in the middle find
differences in both projects at the same time.

Section Reference Version:

Use these button to select what data should be compared to the version on either
side (its own original or the original or a version from the connected project). Use the
pause button to temporarily compare each side to its own original.

Tip:

You can also connect windows if you:

e drag one project in the project/map list and drop it onto another project
e or hold shift while you click on a different hexdump window

This is just one of several options to import data from other projects.
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Shortcuts
Symbol bar: @

Keyboard: Ctrl+2 to display the dialog
Ctrl+Shift+2 to immediately connect (requires that exactly 2
projects are currently open)
Shift+2 to toggle the active-connection-checkbox (left dialog, top-
left-corner)

7.20 The dialog Select the connection window (map) (Menu View)

Important:
This page explaing connecting Hexdumps. Here's the page about connecting
hexdumps.

Connect maps

O Address | Name

} Map 2
0 Map 1
4 Map 3

Cancel

You can connect 2+ maps. They will be displayed next to another and the scrolling
will be synchronized. Furthermore the cursor keys left/right can be used to switch to
the neighbor-window.

The maps must have the same number rows. Columns and bit width can be
different.

Tips:
e You can double-click the buttons all/none.

¢ You can also connect windows if you hold shift while you click on a different map
window
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e If you move maps to their own folder, you can open them connected by double-
clicking the folder name in the map list.

Shortcuts
Symbol bar: @

Keyboard: Ctrl+2 to display the dialog
Ctrl+Shift+2 to immediately connect (requires that 2+ maps of the
same height are currently open)

7.21 The command Optimize value range (Menu View)

Values from maps or hexdumps may be displayed as bar diagrams. A special scale
can be used to improve visual display. The optimal settings for this can be
automatically calculated with this function.

This command is only available if a bar displayed is activated for the current dialog.

Trick:
Use this command 2x quickly in a row to reverse the optimization and show the
entire possible value range.

Shortcuts

Symbol bar: m
Keyboard: Ctrl+B

7.22 The command Detect map (Menu View)

Use this command to detect a map at the current cursor position in a hexdump
window. Only certain map types are recognized (see below). This function only
works in hexdumps.

If no map is found or a recognised map is already marked, the search will continue
along the file. Hold the shift-key pressed to search backwards.

This function bases on the function "background map search”. This means, it uses
the maps that are listed as "potential maps" in the map selection list. Therefore it has
the same limitations as the "background map search". For example, it you deactivate
the "Statistical map recognition” there, these maps won’t be found here either.
Furthermore you may limit the search by the bit width of the map. For this, click on
the small black triangle in the map selection window. A menu pops open, where you
may select a filter for the bit width (8/16/32 Bit). This filter also works for this function.

Shortcuts
Symbol bar: M
Keyboard: f
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7.23

The command Support map selection (Menu View)

Use this command to toggle the support for a selection of maps. If it is activated, the
user will be supported when creation a selection containing a map. In order to use
this feature, you'll just need to create a selection without gaps (for example with the
selection mode ‘consecutive’).

WinOLS will analyse the selected area for the supposed number of columns and the
start address and change these respectively. Then the beginning and end of a
selection will be extended, so that a rectangular are is selected.

When in doubt, it's better to select to few values than too many. Otherwise you might
affect the analysis method with false data.

The created selection may be changed later in 2d-mode. (Press shift, move the
cursor in 2d mode over the beginning / end of the selection, click and drag.)

If you don't want to have this command permanently activated, you can also just use
it when you need it. Simply create a selection like described above. And when this
selection exists, just activate this command (via the menu or icon bars). Now it will
only be executed once and not be activated permanently.

Shortcuts

Symbol bar: ﬂ
Keyboard: -
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8

8.1

Commands of the menu Selection

The menu Selection contains commands to work with selections:

Select cell

Select row

Select column

Select all

Select screen

Invert screen selection
Select changes
Create selection

Select nothing
Restore last selection

Original

Selection -> Map

Load

Save

Selections mode

Selection beginning
Selection end

Selects the current cell.

Selects the current row

Selects the current column

Selects the entire element / map
Selects the visible area

Inverts the selection in the visible area
Selects cells with changes

Creates a selection from values you have
to enter

Removes the selection
Restores the last selection

Sets all selected cells to their original
value

Creates a map windows from the
selected rectangle

Loads a saved selection into the
clipboard

Saves the current selection into a file

Allows the choice between four different
selection modes

Marks the beginning of a selection
Marks the end of a selection

The command Select cell (Menu Selection)

Selects the cell the cursor is currently in.

Hold the Ctrl-Key pressed while clicking to extend the current selection instead of

replacing it.

Shortcuts
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Symbol bar: -
Keyboard: Insert
8.2 The command Select row (Menu Selection)

Selects the row the cursor is currently in.

Hold the Ctrl-Key pressed while clicking to extend the current selection instead of
replacing it.

Shortcuts
Symbol bar: -
Keyboard: -

8.3  The command Select column (Menu Selection)

Selects the column the cursor is currently in. By default this selects only the visible
part of the column. This can be changed in the configuration menu.

Hold the Ctrl-Key pressed while clicking to extend the current selection instead of
replacing it.

Shortcuts
Symbol bar: -
Keyboard: -
8.4 The command Select all (Menu Selection)

Selects the all cells in the current element / map.

Shortcuts
Symbol bar: -
Keyboard: Ctrl+A

8.5 The command Select screen (Menu Selection)

Selects the all currently visible cells.

Hold the Ctrl-Key pressed while clicking to extend the current selection instead of
replacing it.

Shortcuts
Symbol bar: -
Keyboard: -
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8.6

8.7

8.8

The command Invert screen selection (Menu Selection)

Inverts the selection for all visible cells. Selected cells are deselected and vice versa.

Shortcuts
Symbol bar: -
Keyboard: -

The command Select changes (Menu Selection)

Selects all changed cells. (If necessary, only visible ones, see F12 > Edit).

Repeatedly use for "only increased"” / "only decreased" cells. Additionally press Citrl
to add to the current selection.

Shortcuts
Symbol bar: -
Keyboard: Shift+Alt+D / Ctrl+Shift+Alt+D

The dialog Create selection (Menu Selection)

Create selection

Create selection by addresses....
from... i} = || from hexdump cursor

= || from hexdump cursor

..and the mede | Rectangle

Apply

This dialog allows you to create a selection by entering the start and the end
address. Furthermore you may specify the used selection mode. The resulting
selection is the same you would get if you created a selection with specified
parameters manually.

You can use the buttons to transfer the current cursor position to the respective
ComboBox. If you want to create many similar selections, you can also activate the
checkbox instead and only enter the offsets that WinOLS should add in the address
fields.

This dialog is not modal, meaning that windows lying behind the window may still be
used. This dialog is a "floating" dialog. All floating dialogs can be toggled with the tab
key.
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You can skip this dialog and apply the current values immediately if you hold down
the Shift key when selection the menu function.

Shortcuts
Symbol bar: -
Keyboard:  Ctrl+Alt+L
Ctrl+Alt+Shift+L (Ohne Dialog)

8.9 The command Select nothing (Menu Selection)

Removes the current selection.

Shortcuts
Symbol bar: -
Keyboard: -

8.10 The command Restore last selection (Menu Selection)

Restores the last selection.

Shortcuts
Symbol bar: -
Keyboard: -

8.11 The command Selection -> Map (Menu Selection)

Use this command to create map from a rectangular selection in a hexdump. The
size of the selection should match the optimal size of the later map.

This command is only available when a consecutive, rectangular selection was
made.

Tip:

If you have a 1x1 map selected or if no selection is present, a new map will be
created and the dialog "map properties” will be opened to allow you to enter the
properties manually. Except if you just copied map properties. Then these will be
applied instead.

Shortcuts
Symbol bar: -
Keyboard: K
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8.12

8.13

The command Selection (Table) -> Maps (Menu Selection)

Create maps from address table

Preview:

Address Name
804FC347 Map 1B3B80

You can use this dialog to generate the maps (or alternatively comments or markers)
from a table with map addresses (in the hexdump).

This command is only available if a continuous, rectangular area is selected. Each
address should be on a separate line, then the address is automatically filled in for
you. If the rectangular marker is 3 or 5 columns wide, then the additional data for
size and axis will be used.

If the addresses in the hex dump use a different offset (such as 0x80000000) than
your project, then you can correct the offset with the corresponding fields.

Example:

e For the screenshot, a selection was created that starts at 0x1B3B80, is 1 column
wide and 28 rows high. This information was then automatically transferred to the
dialog.

e WIinOLS now looks in the current map (hexdump) at the address 0x1B3B80 and
finds the value 0x804FC347 there. This is used as the address for the map data.

¢ Depending on the project, this may be outside your hex dump, so it may make
sense to use an "-Offset" of (here) 0Ox803F0000.

e For the next map (here: not in the preview), WinOLS looks at the same place in the
hexdump, but one line lower.

Shortcuts:
Toolbar: -
Keyboard: -

The command Selection / Load (Menu Selection)

This command loads a previously saved selection into the clipboard. Use the
command Paste (Ctrl+V) for further processing.
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Shortcuts
Symbol bar: -
Keyboard: Ctrl+R

8.14 The command Selection / Save (Menu Selection)

This command saves the currently selected cells on harddisk.

Shortcuts
Symbol bar: -
Keyboard: Ctrl+W

8.15 The command Selection mode (Menu Selection)

This command offers a choice of 4 different selection modes:
1) Selection of a consecutive area

2) Selection of a rectangular area

3) Selection of columns

4) Selection of rows

Tip:
If you just created a selection and then use this command to change the mode, then
this change will also be applied to the created selection.

Shortcuts

Symbol bar: IEEI o=

Keyboard: Ctrl+Shift+M (only consecutive/rectangular)

Note:
If the hotkey doesn't work, Radeon graphics card driver tool is reserving it. Test it on
F12>Debug.

8.16 The command Selection beginning (Menu Selection)

This command sets the beginning for a selection. If an end for the selection was
already defined, a selection with the currently selected mode will be made.

Shortcuts
Symbol bar: U

Keyboard: Ctrl+Shift+B
8.17 The command Selection end (Menu Selection)

This command sets the end for a selection. If a beginning for the selection was
already defined, a selection with the currently selected mode will be made.
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Shortcuts

Symbol bar: j
Keyboard: Ctrl+Shift+K
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Commands of the menu Find

The menu Find contains commands to search for different criteria:

Bytesequence / Text
Selection

Start search
Continue search
Search backwards

Restart background map
search

Axis description profile
Parallel maps

Find similar maps

Go to Address

Jump to address from
hexdump

Previous comment
Next comment

Insert / Edit comment

Delete comment

Previous marker
Next marker

Searches a text or a sequence of hex- or
decimal values

Searches an area which resembles the
current selection

Starts the search again.
Continue the search forwards
Continue the search backwards

Allows you to start, cancel or restart the
automatic search for maps in the
background

Administration of the automatically or
manually collected axis descriptions

Helps you search and sync maps that are
similar to the current one.

Searches maps which are similar to the
current map

Moves the cursor to the given address

Moves the cursor to the address from the
hexdump values

Moves the cursor to the previous
comment text

Moves the cursor to the next comment
text

Insert a new comment at the cursor
position or allows you to edit an existing
one

Deletes the comment at the current cursor
position

Moves the cursor to the previous marker
Moves the cursor to the next marker
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Insert/delete marker

Scripts

Creates a marker at the current cursor
position or the current selection or deletes
a marker if it already exists

Create, administrate and run scripts.

197
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9.1

The dialog Search for byte sequences (Menu Find)

Search: Hexadecimal @
Hewadecimal | Tewt | Map
3200909 -

[T Replace with: Replace Feplace al

(] In griginal Search range from/ta (hex] 1FFFFF

"] Search in Realtime Max. difference u/d [dec] 0 0
Match caze
Single value 1-dimenzional 2-dimenzional

Alzo zearch in clozed folders

Select
oK ][ LCancel ]Em yi-,eucﬁf.; E]

Search: Hexadecimal

x|

Alzo zearch in clozed folders

Hewadecimal | Tewt | Map
233231200909 -
[T Replace with: Replace Feplace al
(] In griginal Search range fromdta (hex] 0 1FFFFF
"] Search in Realtime Max. difference u/d [dec] 0 0
Match caze
Single value 1-dimenzional 2-dimenzional

S || Concel [ 4]0 ;falchtiilf.; =J

Mo, Addrezz Found data

Search finighed. 0 ocourences faund.

p

Use this dialog to search for (and optionally replace) byte sequences / texts in the

project data or for texts in the map list.

You can select something in the WinOLS editor, copy it and paste it in this dialog.

(C) 2025 EVC electronic



Commands of the menu Find 199

Use the blue left/right arrow buttons to jump to the next or previous occurrence of the
search text. Use the black down arrow to get a list of all occurrences (max. 200000).
Click on ‘Start’ to initiate a search and fill the list with data. If the list is open and you
start a new search by clicking on one of the blue arrow buttons, only addresses
before or after the current cursor position will be searched. Hold the shift key while
clicking the blue arrow buttons to force WinOLS to use this feature even though you
didn't change the search.

Limiting results:

You may enter the search range. Only occurrences within this range will be shown
as results. Use the maximal difference to configure how far each cell may differ from
your search string in order to be considered as occurrence. You may configure the
difference to up and down separately. Use the options button for more options to
limit the results.

Format + wildcards + alternative values + greater/smaller:

¢ When searching for byte sequences use spaces to separate the different bytes.
The choice of searching for decimal or hexadecimal may be overridden for single
bytes by prefixing them with ‘Ox’ for hexadecimal interpretation.

e Wildcards: You can use a question mark as a symbol for an unknown value. For
example with ‘longw?rd’ or ‘ff ff aa ?? ab’ you can search for these text / byte
sequence. The *?’ / *?2?" will match any byte.

When searching in hexadecimal mode you can also use the question mark for an
unknown half-byte (nibble), for example: ff ?f.

In decimal mode, you can use the question for an unknown cipher, for example
123, 476. )(Please note that using the question mark in decimal mode will slow
down the search significantly.)

¢ Alternative values: If you want more than one value to match in one place, you can
separate them by slashes (but without spaces). Example: 'ff 11/22 ff' finds both 'ff
11 ff* and 'ff 22 ff'.

e Greater/Smaller: You can specify that a value should be greater/smaller than a
certain number. Example: "77 >110".

If you use both operators without spaces, then they refer to the same cell,
effectively specifying a range. Example: "77 >110<120"

Checkboxes:

e Search in realtime: The search will start while you're typing.

e In original: The search text will be searched in the original version instead of the
version you're currently editing.

e Match case: When searching for texts, the case of the letters will be observed.

e Single value / 1-dimensional / 2-dimensional: Only maps with the specified
dimensions will be searched. (Only for map search mode)

e Strictly monotonic values: Only sequences are found where each value is greater
than the previous one (or each value is less than the previous one). This is useful
to search for axes and usually needs to be combined with wildcards or tolerance.
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A click on the button 'Options' shows more options:

e Address: Only data starting at the address of the right offset will be searched. If
‘Automatic’ is used WIinOLS automatically uses the bit width of the current window.

e Programm code: Only within / outside of program code is searched. You can
recognize program code by the ‘faded’ values in the hexdump. (See also overview

e Search in... : Only within / outside maps will be searched.

e For maps... : When searching in (or: for) maps, only modified / unmodified / open
maps will be searched. Important: WinOLS continues to search in the current
window (e.g. Hexdump) and uses its data organization. Not that of the map.

¢ Values end on: When searching for data only values will match that end (in
decimal mode) on the chosen numbers. This options is useful when using
wildcards.

Templates:

Click on ">" next to the search line to display previous searches or to select a
template file whose content is to be displayed here in the list. This is a simple text
file. Each line is one entry. Each line can contain a comment in the format "Search
value // Comment". The search dialog then displays the comment in the drop-down
list, but uses the search value for the search.

Example:

11 22 33

22 33 44 /] You will see this text in the drop-down **)

/I Treebranch

3344 /[ -sub item 1

55 66 // -sub item 2

/I Another Treebranch

/I -Subbranch

Il --Subsubbranch

33 44 /Isub item 1 *)

55 66 //sub item 2

*) Note: For simplicity, you can skip the minus characters for lines that contain
search text. WinOLS will assume that it's a child of the most recent branch.

**) Note: You MUST use a space character before the comment: "x // good" (not: "x//
bad"). This is necessary because "//" can occur in some ECU strings for text search
mode.

Triggers in templates:

You can link the current selection of search/replace with triggers. If a comment in a
template contains the text "->XY", the trigger "XY" is triggered. This selects an item
containing "<-XY" in the comment in the other field.

Example:
Search-Template.txt:
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AA BB // Click here ->MyTriggerName
Replace-Template.txt:
CC DD /I This will be selected automatically <-MyTriggerName

Extended replace:

This function requires WinOLS 5.58 + FeatureUpdate

If the replace text begins with "do ", commands can be entered there. The window
and/or a part of the coordinate can be adjusted.

Examples:
do *2; +1 2 combined commands: The cells are doubled and 1 is added.
do yaxis=1 The value in the Y-axis is setto 1

do map0.coll=4  The value in the connected map O (counted from the left) in
column 1 is set to 4.
do myid.yaxis=4  The value in the connected map with the Id myid in the Y-axis is

setto 4
do maplxy].col[zz] The value in the connected map field with xy in the name in the
=4 column with zz in the text name is set to 4
do col[+1]=4 The value in characteristic field 1 to the right of the search value
issetto 4
do map0.coll=4; 2 instructions

map0.col2=5
Attention: All indexes start at O!

Context menu:
You can right-click a selection in the list to directly modify the found cells.

Create from the list:

You can right-click a selection in the list to create markers, comments or maps. For
maps you can use the following placeholders:
%Num Number of the result

%

% Number of the result in the list
Num2%

% Found values

Results

%

% Searched value

Search

%

% Address of the result

Address

%

%Size% Size of the map at the position
%I1d% Id of the map at the position
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% Details column

Details

%

% From the found values the 3rd

Result3

%

% From the found values the 3rd as decimal value
Result3.

dec%

% From the found values the 3rd as hexadecimal value
Result3.

hex%

Note:
This dialog is a "floating" dialog. All floating dialogs can be toggled with the tab key.

Note:

The hotkey Ctrl+F will start this dialog only if a project window has the focus. If the
map list has the focus (= the cursor is blinking there), a search dialog for the map list
will be started.

Shortcuts

Symbol bar: ﬂ
Keyboard: Ctrl+F

The command Search / Selection (Menu Find)

This command starts a search for an area similar to the one currently selected. The
grade of similarity is configured in the following dialog.

Shortcuts

Symbol bar: g
Keyboard: Ctrl+Alt+F3
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9.3 The dialog Search parameters (Menu Find)

Searchrange from 0]
to address;  FFFFF
bl &, difference up: [dec.] 0

dowir [dez.] 0

]| LCancel |

This dialog allows you to edit global search parameters. You may configure an area
to search and the maximum difference a cell may have from the searched value.

Shortcuts
Symbol bar: -
Keyboard: Alt+F3

9.4 The command Continue search (Menu Find)

This command continues are search that was started previously.

Shortcuts

Symbol bar: ﬂ
Keyboard: F3

9.5 The command Search backwards (Menu Find)

This command continues are search that was started previously, but backwards.

Shortcuts

Symbol bar: ﬂ
Keyboard: Shift+F3

9.6 The command Restart background map search

WinOLS can search for maps while you work normally. This command allows you to
control this behaviour.

Depending on the situation this command is displayed under different labels and this
performs different functions.

If not map search was executed this command allows you to start one. If a search is
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running, you can stop it with this command. If a search is already finished, you can
restart it with this command.

Shortcuts
Symbol bar: -
Keyboard: -

The dialog Axis description profile (Menu Find)
B ' Axis description profiles l = i

The typical data about axis descrptions [description, unit, factor, ...] are automatically collected in profiles. 'ou may edit them manually
here or apply them to a project.

Current project zsignature: 54./0/3E /FF/C

Show automatic profiles Show manual profiles Irmpoit... J I Export...
Profile; | 041: Automatic profile - (34/0/1B/F5/79/5/D) &
042 Automatizches Profil - (CO36/C048/C1B4/C022/F944/C0Z28/DCOCACT 48/C1 BOAC044 /COCO/CICODATOAC2E0.
043 Automatizches Profil - (54/0/1B/F5/73/5/8080/66/0 /18]
044: Automatizches Profil - [CEACE/C4/E0/BF /80460

045: Automatizches Profil - (54/0/3E /FF/C/3) il
Mew. I [ Edit... l I Delete I Activate az manual profile H Signature. ..
D' ezcription:
Erzeugt auz 1253.0lz r

Aiz dezcrphions in this profile
Id Dezcription it Mu.. Re.. Sign Fachar Offzet P
ooos o= 10 Mo Mo 1 a -1

Mew... Edit... Delete Apply Al Mane

I OF Il Cancel I

4

Axis description profiles are collections of axis descriptions (Name, unit, sign, factor,
etc). They're automatically created from projects by WinOLS, and can automatically
or manually be applied to new maps to set the description information.

Automatically:

WinOLS automatically collects axis description profiles in the background (unless
you have disabled it in the configuration dialog under ‘automatically’). An axis
description profile contains a signature which enables WinOLS to recognize the
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source project and similar projects. This signature is automatically generated from
maps that are searched in the background. If you now configure axis descriptions or
import this information from a Damos file, then information about the description,
unit, factor, offset, etc. is collected in the profile.

If you later insert maps into a different project, then WinOLS will automatically fill in
the axis description information, if the axis is recognized.

Note: A signature cannot be generated for every project. Only projects with Bosch
maps contain a signature. Bosch Il maps are not enough, unless the project contains
‘normal’ Bosch maps, too.

In this dialog you may view and select (combo box at the top) the different profiles
and even rename them. In the lower part of the screen you can see the different axis
descriptions that were recognized for the current profiles. You may edit, delete or
apply them. Normally you won’t need to do all this manually, since WinOLS does
everything automatically in the background.

Manually:

For the manual mode there is always an active axis description profile. With the
respective button you can tell WinOLS which profile should be active. The active
profile collects the axis descriptions that are available to you in the dialog "Map
properties” as menu when you click on the small black triangle. By switching the
active profiles you can administrate different collections, for example for different car

types.

Groups:

You can create groups to define data for map+X-axis+Y-axis and then apply them
together. Only the group entry is then displayed in the menu. However, all other
entries in the group are applied. The members of a group must have the same
signature ID - with the exception of the last digit. This must be:

F: Group name

0: Map data

1: X-axis data

2: Y-axis data

Export + Import:
Use the button "Export" to write all selected profiles into a file. You can then use the
"Import" button to append the profiles from the file to the ones in the list.

You can also backup this data manually.The data of the axis description profiles are
store in the file "ols_sp.cfg". The current manual profile is part of the global
configuration file "ols.cfg". Both files are stored in the WinOLS Configuration
directory. You can copy these files any time, but should only replace them while
WinOLS is closed.

Shortcuts
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Symbol bar: -
Keyboard: Alt+Shift+P

The dialog Parallel maps

"ert paratiel mop: AR ===

For atolerance of 0 %1 parallel [=similar] maps were found [thereaf 1 new].

Folder Addrezs M ame Id
Paotential maps 19727 tap "Baoszch Il 16"

kKeep data in syne;

[ ] Transfer changes as difference

[] Tranzsfer changes in percent

[ [iMove all parallel maps of thiz group inte one folder:

Options:
Transfer axiz descriptions [] Show anly new maps

Transfer map name

Tranzfer changes already made in the map to other maps

k. ] [ LCancel
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Often the same map exists several times (with minor variations) in the same ECU. In
WInOLS these are called "Parallel maps". You may create all of them in one go and
transfer the changes automatically to the other (parallel) maps. Use the following
procedure:

1. Search the map in the hexdump window and register it as map within WinOLS.
2. Enter axis descriptions if you want.
3. Click with the right mouse button into the map and select "Parallel maps".

The dialog shown above will appear. Depending on the tolerance that is entered, a
different number of maps will probably be found. (The default tolerance value is
calculated in such a way that a least one similar maps is found, but never over
100%.)

Use the options to configure which things you want to transfer (this applies only to
the map and axis names) or which you want to synchronize (this applies only to map
values). If you transfer changes as difference, not the absolute values, but the
difference between original and version will be transferred.

It is recommended to create a folder for every group of parallel maps and store the
maps there. This makes it easier to understand which maps get synchronized. Or
you can make all maps except the current one invisible. (Right-click the map list
sidebar to make all visible.)

Synchronization notes:

This function creates "Sync-Blocks", which you may view in the checksum dialog
(Key F2). For these blocks WIinOLS always tries to keep each two data blocks
identical. If you change anything in one block, the changes will be performed in the
other one, too (With a confirmation request fort he first time).

Tips:

e In the map list sidebar, you can activate a column that shows the number of the
sync group (right click on the table header). This column has its own context menu.
For example, you can select some maps and add them to a group or create a new
group.

e In the map list sidebar, you can search for the group id. E.g.: #2

e In the open map window you can use the hotkey Ctrl+Left / Ctrl+Right to switch
between the maps of this group.

Shortcuts
Symbol bar: -
Keyboard: Ctrl+Alt+P
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The dialog Find similar maps

Find similar maps

For a tolerance of 0 +-1% 1 similar maps were found:

Address | Name

83306 Kennfeld

Search:

[]in registered maps Axis addresses must be identical
g p

in potential maps

Tip:
You can automate the transfer of data with the dialog parallel maps.

Shortcuts

Symbol bar: -
Keyboard: Ctrl+Alt+K

MNone

Cancel

Often the same map exists several times (with minor variations) in the same ECU.
With this dialog you can search these maps, open them, select them in the map
window or transfer data from the current map to the variations.
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9.10 The dialog Go to address (Menu Find)
6o to address B -

[] Address binarwand [Filesize-1]

]l Accept I

Use this command to set the cursor to a certain place. By default the current position
is show. Furthermore you may recall the last 16 positions. If the project contains
comments, they will appear in the list, too, together with their address.

Activate 'Address binaryand...' to calculate a binary and for the address you're
entering and the file size -1. This is useful if you have addresses that are without the
WinOLS address range. For example, if you've got the address 1E02ES8 and a file
size of 7FFFF, then effectively the address 602E8 is used.

Tip:
e To move the cursor relative to the current position, write a '+' or '-' in front of the
value.

e You may also enter the name or id of a map or value of a comment.

Shortcuts

Symbol bar: ﬂ
Keyboard: Ctrl+G
Ctrl+Shift+G (Skips the dialog an uses the clipboard instead)

9.11 The dialog Jump to address from hexdump (Menu Find)

Interprets the 4 bytes at the cursor position as address for the new cursor position. If
necessary, WinOLS will automatically switch to the Hexdump window.

If you have previously selected several DWORDs with addresses, WinOLS will
select the corresponding cells.

éhortcuts
Symbol bar:
Keyboard: J

9.12 The command Previous comment (Menu Find)

This command moves the cursor to the previous comment within the current project.

Shortcuts
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9.14

9.15

9.16

Symbol bar: -
Keyboard: Shift+V
The command Next comment (Menu Find)

This command moves the cursor to the next comment within the current project.

Shortcuts
Symbol bar: -
Keyboard: Shift+N

The command Insert / Edit comment (Menu Find)

This command allows you to insert a comment at the current cursor position or
consecutive selection or edit it if there already is one. Comments always stick to the
current address but count for all versions of the project.

Comments are also shown as tooltips, if you hold the mouse cursor for some time
over a cell with a comment. Furthermore they're listed in the dialog 'Go to address'.

To delete a comment, simply remove the text

Note:

Starting with WinOLS 3.57, comments may also be created from non-linear
selections. In this mode, the comment frame is not supported and you can't edit the
addresses manually.

Shortcuts

Symbol bar: -
Keyboard: Shift+Enter

The command Delete comment (Menu Find)

With this command you can delete the comment at the current cursor position, if
there is one.

Shortcuts

Symbol bar: -
Keyboard: -

The command Previous marker (Menu Find)

This command moves the cursor to the previous marker within the current project.

Shortcuts
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Symbol bar: -
Keyboard: Shift+F5

9.17 The command Next marker (Menu Find)

This command moves the cursor to the next marker within the current project.

Shortcuts
Symbol bar: -
Keyboard: F5

9.18 The command Insert / Delete marker (Menu Find)

This command allows you to insert a marker at the current cursor position or
consecutive selection or removes it if there already is one. Markers always stick to
the current address but count for all versions of the project. In contrast to comments,
markers cannot contain text.

Shortcuts
Symbol bar: -
Keyboard: Ctrl+F5

9.19 The command Solutions

With this dialog you can apply ready-made solutions to your current project. They
can do a multitude of things like adding maps or modifying your hexdump data.
Solutions are provided by resellers and know automatically whether they can be
applied or not. Thus you will only see solutions in the list that can be applied to your
current project.

To use a solution, open the dialog 'Solutions' and choose the desired reseller (icon
upper left corner). Solutions are billed via reseller credits.

Classic solutions
This variant has been implemented in WinOLS for some time and is currently only
offered by B&C.

Online solutions
For this new variant, data is transferred to the reseller's server, which can then
generate the corresponding version / maps as a response.

Privacy

We transfer as little data as possible. The reseller receives some ECU properties
and hashes (e.g. SHA) from the hexdump.

If you confirm the upload (or allow an automatic upload) he also gets the entire
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hexdump and your EVC license account number.

Shortcuts
Mouse: -
Keyboard: F7

The command Scripts (Menu Find)

The following scrpts are currently available in: ['\

D ate Applwable?  Mame

Execute Edit... Delete

Check all zcripts automatically
Show only zcnpts that can be applied to the current project

Cloze

If you're doing certain changes again and again because you always get similar
ECUs, it can make sense to create a script. This will summarize all changes into a
universal format so they can be applied quickly. Furthermore every script recognises
whether it can be applied to the current project or not. (If you have many scripts you
may delay the recognition to speed this dialog up. Simply turn off the option '‘Check
automatically'.)

This dialog allows you to execute, edit (a text editor will be started) or delete scripts.
Furthermore you may use a subdialog to create new scripts. The combobox in the
upper right corner allows you to restrict the search for the right script to a certain
subfolder of the script folder.

You may configure the WinOLS options (in the page 'Automatic’) in such a way that
WInOLS checks after every project import whether a script can be applied to the new
project or not.

When the scripts were created a preferred mode (absolute / difference / percent)
was defined for transferring the data. Depending on the kind of script you may
choose to override this mode when executing the script.

You can find more information about scripts in the respective chapter.
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This is just one of several options to import data from other projects.

Tip:
If you use LUA (OLS540), you can use projectimport to apply a script to a project.

Shortcuts
Mouse: -
Keyboard: F8

9.20.1 The dialog Create scripts (Menu Find)
Create WinOLS Script: )

Thiz function allovwes you to export all changes that pou made into a scnpt files. Thiz gives pou a completely automatic
pozzibility to apply the changes later on to ather projects.,

“Wwhich changes waould vou ke to export?

Only the curent map [The zcrpt can only be applied i a map of the zame zize iz active.]

[T] Data areas with changes:

Addresz Mame Fram Ta

For security reazons thiz zoript can only be applied if:
...all bytes that were changed match in their ariginal the other project's original version.
...all mapz match completely [in their unmodified parts, toa] in the onginal data.
...all data areaz match campletely [in their unmodified parts, baa] ik the aniginal data.

...and the following project properties match:
[ Producer [ Chassis [ Model [T] Softwareversion [ Softwaresize

[] Alzo transfer map structure

[Transfer changes abzolute v] Uszer may overule percentual / difference / absaolute decizion on execution

b aps and data areaz may at most be moved by an offzet of 1048576 Butes [dez].

The walues in the maps and data areaz may at most differ by 0 % from by values in order o 'match’.

T

This dialog is the recommended way to create new scripts. The bases are always
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the changes in the current project. All you need to do is to select which changes you
would like to export. Simply select the maps or data areas containing the changes.
Data areas are less secure than maps because WInOLS has less information. So, if
possible, register maps that cover data areas.

Data areas that do not contain at least 2 different byte values in the original
version, are not listed for security reasons. You can use the "make larger"
checkbox to work around this. WinOLS will then increase the size of the data areas
until a safe identification is possible.

For maps you have the option the use the map id instead of the values to identify the
map. This requires that the map has the id field filled in and that it already exists
(with the same id) in the target project.

If possible you should always restrict the script’s applicability as much as possible to
avoid misuse and increase comfort. This is done be requiring entire blocks / maps to
be recognized. Furthermore you may require certain project properties.

In addition you may define how far addresses can be moved from their origin and
how much the values may differ.

When saving, you should always choose a long, descriptive filename since this
name will later appear in the script list. Furthermore you should always store scripts
in the WIinOLS script directory, because they won’t appear in the script list otherwise.

You can find more information about scripts in the respective chapter.
Shortcuts

Mouse: -
Keyboard: -
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10

Commands of the menu Miscellaneous

The menu Miscellaneous offers the following commands:

Updates + Allows you to use the professional features of

Registration WinOLS.

Rescue project Tries to rescue data from a corrupt ols project file.

Configuration Starts the configuration menu for global options

Calculator Starts the windows calculator

10.1 The dialog Updates+Registration (Menu Miscellaneous)

YWelcome to the simplified updates-online wizard.

Thiz wizard will search online for updates and handle their registration.

And it works ke this:

1. Create a connection to the internet and click on "Start'’.

2. The program wersiohz are checked now.

[ Automatically search far updates in the 3. The updatez are loaded.
background |

Update WinOLS
Update checksums

[ YWebszite: Change list... ] [ Start ][ Cancel ]

|EI:EIEI

| 0:00

This dialog allows you to register WinOLS, to check for updates for WinOLS and its

plugins and to download and install these updates.

You may use WinOLS (depending on the purchased packet) on multiple computers.
Each must be registered separately. You may do that yourself easily over the

internet.

Simply click on "Start" and follow the assistant’s instructions.
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If WINOLS has a problem with connecting to the internet, please be sure to check
your local firewall. Furthermore you can use the test function in the configuration
dialog.

Shortcuts

Symbol bar: -
Keyboard: Alt+F1

10.2 The dialog Rescue project (Menu Miscellaneous)

Thiz function extracts maps and hexdumps from ols-files. This should only be done, if the file cannot be read
with the normal rethods,

Fleaze chooze the file you would like to rescue:

=

Start rezcue

Rescue protocal;

This dialog helps you rescue data from a corrupted WinOLS project file (*.ols). The
rescue process might not be able to extract all data and the extracted data might be
incorrect.

Note:
Please save all unsaved changes to other projects before using this menu item.
Please check any rescued data carefully before actually using it.

Shortcuts
Symbol bar: -
Keyboard: -
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10.3 The dialog Configuration (Menu Miscellaneous)

The configuration dialog contains many pages that are explained on the following
pages.

10.3.1 The dialog Configuration / Colours (Menu Miscellaneous)

*% Colours

Colour Theme: | Colour theme: WinOLS b |

Def. Text colour Def. Backar. colour
Diefault:
Map W 7
Hexdump J

<

CPU-Access i

Selection I
... Tight & 2d

e —

Changed data i

... increased

<l

... decreased o

Map in hexdump

Rowmarker

Potertial maps

I
Comments ]
|

Reset changes |

The first sheet of the window allows you to configure the colours WinOLS uses. You
may choose one of three predefined colour themes or choose your own user-defined
colours. If the checkbox ‘Def.” is checked, then the colour defined at

‘Default’ (topmost colour) will be used in this place.

You may edit a predefined colour theme. Use the button 'Reset changes' to return to
the default values for this colour theme. However, the recommended method is to
edit only the 'User defined' theme. If you activate this theme the button 'Reset
changes' will change to 'Copy theme from..." and allow you to copy the colour theme
from a predefined theme.

Shortcuts
-
Symbol bar: ﬂ
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Keyboard: F12

10.3.2 The dialog Configuration / View (Menu Miscellaneous)

C View

Al view modes:

[ Choose font...

Display spinbuttons in the map4toolbar always vertically

Search results & differences:
Fort size: 12

Additional line height:

Title:
Hexdump window title:

WinOLS (%MNAMET - S.5W%) | Insert
Map window title:
| Insert
| Insert

Project4itle in map selection window:

Area 'All view modes':

At the top you may choose the font and font size for hexdump and map windows.
Please note, that some fonts cannot be used as Axis description in 3d mode in spite
of the official documentation. If you have any problems with this, please choose a
different font.

Finally you change change the font size and additional line height. This applies to
the dialogs Differences und Search.

Area 'Title":

WinOLS automatically generates useful titles:

e The title of the hexdump window

e The title of the map windows

e The project name in the Map Sidebar

You can here configure which information you want to have displayed instead of the
default values. Use the button on the right to choose from templates.

Shortcuts

Symbol bar: ﬂ
Keyboard: F12
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10.3.2.1 The dialog Configuration / View / Hexdump (Menu Miscellaneous)
[ Hexdump

Default view for new maps & hexdumps:

Hesxdump: |TE:?d "’||HEK v| Right side: |Bars v|

Maps: | Text - | | Decimal - | Right side: | Bars hd |

| Connected windows: Activating one, pushes the ather to the top, too

| Show registered maps in hesocdump windows (Tesd +2d)
| With border {This is not the red border. You can configure that in the menu at “View = Mark cument map’.)

| Show potential maps in hexdump windows (Texd+2d)
| Show unimportant data pale
| Show overview data in scrollbar

+ | and differences

' |and search results

| and comments

| and markers

Default view:

Here you may define in which way new maps and hexdumps are displayed by
default. You may choose the view mode (Text, 2d, 3d), the numeric system (10, 16)
and the configuration for the right side (Empty, Bars, ASCII).

More options:
Here you can configure the activation behavior for connected windows.

Then you may toggle the display of registered maps with in hexdumps. Registered
maps are marked with a colored background and optional a border.

Next you may toggle the display of potential maps with in hexdumps. Potential maps
are marked with a border and a tag on the top. If you want to toggle the searching of
these maps, please refer to the page named 'Automatically’ / 'Background'.

Furthermore you can let WinOLS display unimportant data pale. Data is considered
unimportant if it is recognised as program code or as empty areas. The data from
the overview function is used for the display. That's why the pale display only works
when overview data was generated.

Then you can configure WIinOLS to display the overview data in the (vertical or
horizontal, depending of the view mode) scrollbar. This option requires that overview
information was generated. Either in the background or manually by opening the
overview dialog. For a reference of the colors, see the overview dialog. Furthermore
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you can configure if additional info is displayed here:

¢ White points at the left => Difference between original and version
¢ Yellow triangle right => Position of a search engine

e Yellow, dotted line right => Marker

e Solid line right => Comment (In the comment's border color)

Shortcuts

Symbol bar: ﬂ
Keyboard: F12

10.3.2.2 The dialog Configuration / View / Text (Menu Miscellaneous)

FF Text-Mode
Text-Mode:
Default value for new hescdumps:
2 Bit -
Vel _ | Chynamic
aluerangs: T

| Adapt number of columns when changing bit width
| Tooltips for dfferences

Fast tooltips

| Aundliary cursars

221

On this page you can select the default bit width and style for new hexdumps when a
new project is created by importing a file or reading an eprom. You may also define

the value range that is used for the bar display.

Furthermore you may configure how WinOLS should behave when if change the bit
width (8/16/32) while using the text mode. By default this won’'t change the number
of columns. But you can tell WinOLS to adapt the number of columns in such a way

that the total width displayed stays roughly constant.

Then you can configure if you want to see a tooltip when moving the mouse cursor

over a changed byte.

Finally you can select if you want to see markers for the line and column where the

cursor is currently located.

Shortcuts

Symbol bar: ﬂ
Keyboard: F12
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10.3.2.3 The dialog Configuration / View / 2d (Menu Miscellaneous)
W 2d-Mode

2d-Mode:
| Big pixel Fast tooltips

Big picel while displaying lines |+ Show original values

| Horizontal guides | Show Y scale

| Don't connect when starting new row

| Edit by click+drag

Default values for new 2d windows:

| Connect dots

o | Show row markcers

Area '2d-mode’:
The option 'Big Pixels' tells WinOLS to use larger pixels when displaying dots in 2d
mode to increase readability.

If the checkbox 'Fast Tooltips' is activated, the tooltips (the little yellow windows) will
appear faster if the cursor is above a value.

Use 'Big Pixels while displaying lines' to make WinOLS display large dots even when
the values are connected with lines.

The option 'Show original values' tells WinOLS also to display the original values in
2d mode if they differ from the current value.

Use the option 'Horizontal guides' to toggle the horizontal guides that are visible in
the window’s background.

The option 'Show Y scale' causes WinOLS to display a vertical scale on the right
side of the window.

If the checkbox 'Don't connect when starting new row' is activated, then WinOLS will
not connect the pixels when a new line (vertical guide) starts in the data.

By activating the checkbox 'edit by click+drag' you can change value simply with the
mouse. A special cursor appears when you move the mouse cursor directly over a
2d value that is either currently selected by the editing cursor or that is part of a
selection. Click and drag to change the value / all selected values. You can disable
this function in the configuration under "2d".
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Area 'Default values for new 2d windows':

Here you can set the default value for new 2d windows. Use the option ‘Connect
dots ' to toggle the default state for the connection of dots for new windows. You can
configure the default for row markers, too.

Shortcuts

Symbol bar: ﬂ
Keyboard: F12

10.3.2.4 The dialog Configuration / View / 3d (Menu Miscellaneous)

1+ 3d-Mode
3d-Mode:
+| Big pixel | Fast tooltips
| Shade areas | Aundliary cursars

with height colors

| Value-depended scaling

Original values: |Shnw version only -

+ | Edit by click+drag

Default values for new 3d windows:

| Fill areas

| Show helping lines

Area '2d-mode':
The option 'Big Pixel' tells WinOLS to display pixels at the line crossings of the wire
mesh to increase readability.

If the checkbox 'Fast Tooltips' is activated, the tooltips (the little yellow windows) will
appear faster if the cursor is above a value.

Enable ‘Shade areas’ to fill areas with a colour that represents its angle to the
viewer. With ‘Height colors’ WinOLS can display the values in the shading colour.
Both options improve the view but consume a lot of computing power.

If the checkbox 'Auxiliary cursors' is checked, 4 additional cursors will mark the
current values on the axis and mark the value on the map.

Value-dependent scaling: The points on the scales are not draw in equal distance,
but depending on their values.
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10.3.3

Use the 'Original values' combo box to choose the method that is used to display
both the original and version values at the same time.

By activating the checkbox 'edit by click+drag' you can change value simply with the
mouse. A special cursor appears either when you move the mouse cursor directly
over a 3d value that is currently selected by the editing cursor or when you move the
mouse cursor over a selection. Click and drag to change the value / all selected
values. You can disable this function in the configuration under "3d".

Area 'Default values for new 2d windows':

Here you can set the default value for new 3d windows. Check ‘Fill areas’ to create
new 3d-Views by default with filled surfaces instead of a wire mesh view. You can
configure the same for the helping lines.

Shortcuts

Symbol bar: ﬂ
Keyboard: F12

The dialog Configuration / Messages (Menu Miscellaneous)
= Messages

Wamings:

| .in case of large selections

| . if there is not enaugh harddisk space

Messages:
| Acoustic signal after lengthy actions

Requests:

| Ask when searching checksums (automatic comection,
swapped lines, ..}

On eprom operations without previoushy selected eprom
automatically detect & accept eprom type

Use this page to toggle the different warnings WinOLS supports. With the first
checkbox you may toggle a warning if a selection gets to large, it may take very long
to create. Secondly you may configure a check for harddisk space before every disk
operation.

Furthermore you may tell WinOLS not to display any request dialogs when searching
for checksums. This applies to the message asking whether the found checksums
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should be corrected automatically and to the message asking whether a forgotten
line swapping should be applied now. (Note: If one of the two messages appears
even though you’ve unchecked this features, you must get an update for the
checksum module from the EVC website.)

Shortcuts

Symbol bar: ﬂ
Keyboard: F12

10.3.3.1 The dialog Configuration / Messages / turned off (Menu Miscellaneous)

[X turned off

WinOLS uses windows that can be tumed off on several
occasions. This can be simple messages or requests, special
toolbars or dialogs. Al have in common that they contain a2 "Do no
not show this window again™ checkboo.

Here you can tum windows back an, which a tumed off previoushy.
All selected windows are tumed on.

The selection was loaded into the clipboard. -
Waming! Prirting a hexdump may take a lang time and many p3
Simulator-Interface: Address register not found

Simulator-Interface: Data register nat found

A corflict which may influence the results was found while loadi
You can rotate the view and change the poirt of view with the
The automatic checksum recognition needs an intact orginal ve

In 2d-mode you may change a selection {that doesnt have gap
The selection wizard automatically comects your selection a bit i|

Maote: This WinDLS version is olderthan 3 months. There's pro
Mo area similar to the one around the cursor found in the other

the wa

: You can change the unit of an axds by right-clicking

The automatic map search did find (Mumber) map. (Number) furt
With the new script editor you may save changes that you do a

paste changes absolut

Mow you can also copy and

aor as diff.

Do you really wart to delete the projekt (Text) 7
Do you real wart to delete the projekt E:t' and its I"-.Iuber'l -

g ' b

Some messages in WinOLS can be turned off. Use this page to turn them back on.
Selected messages will be displayed.

Shortcuts

Symbol bar: ﬂ
Keyboard: F12
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10.3.4 The dialog Configuration / Paths (Menu Miscellaneous)
== Paths

Projectfile path:

iz hainm carfionred wis the o
Lha DS L LUISL] Widg L L

-t
Lo

]

Flugin path:

QLC file path:
alc,

Script path:
C:\Software WinQ LS Skript®

Autodiscover path for linked files:
Eirfugen

Place for corfiguration files:

Directaory for application data (recommended) W
==> [ ProgramData“Evc \WinOLS"
Open data directory, e.q. for a backup [Shift+F13)

Default value for * key” key file:
Delete

Default value for spi key file:
Delete

Mote: Project files and plugins can be stored on shared network drives.

The different paths for the different kinds of files may be configured in the third page
of the dialog. Project files and plugins may be stored on shared network drivers. You
can also select the key file in this dialog which is used for eprom encryption.

Configuration files:

The WIinOLS configuration files can be stored in two different places. If you're using
Windows 95, 98 or ME it is a good idea to store these files in the WinOLS directory.
However for all newer windows versions this is not recommended. In this case you
should store the configuration files into the central folder for application data. Use
the hyperlink to open an Explorer window with the path or the hotkey Shift+F12
(while all dialogs are closed).

WInOLS uses the following files:

ols. The entire WinOLS-configuration

cfg:

ols. The entire WinOLS-configuration of an older WinOLS version. Useful if your
VH###. using multiple WinOLS versions parallel.
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cfg:

ols2. A backup of some parts of the WIinOLS configuration

cfg:

ols_s The data from the Axis description profiles

p.cfg:

ols_tbThe toolbars positions

.cfg:

ols_w The list of currently opened projects and windows (Workspace)
sp.

cfg:

You can copy these files any time, but should only replace them while WinOLS is
closed. To transfer the configuration data to another PC, use the online-function.

Autodiscover path for linked files:

If you have files for each project which are stored under a strict system, WinOLS can
automatically show them in the list of linked files. To activate this insert the
respective path with wildcards. The path can contain placeholders like %Client.VIN
%. It must end on characters or wildcards (i.e. not with "\" at the end, but for example
with *.*). You can use multiple paths (separated with "/") to search multiple folders /
use multiple wildcards. If one of the parts contains only characters and wildcards and
no path, the path from the previous part is used.

Example 1:
X:\Test\*.*

Example 2:
X:\Documentation\%Benutzerdefiniert.Benutzerl%_*.jpg

Example 3:
X:\Testl\*.jpg/*.png/X:\Test2\* *

Autodiscover path for A2L files:

Some projects contain Ids in the hexdump, which can be found in the A2L files. If
you select "Project > Ex- & Import > Damos & A2L Import", WIinOLS tries to find this
id and searches all A2L files in / below this folder for it. If suitable files are found,
they are displayed in a list.

Shortcuts

Symbol bar: ﬂ
Keyboard: F12
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10.3.4.1 The dialog Configuration / Paths / Clients (Menu Miscellaneous)

uCIients

MName Project data path

(Doubleclick to edit; Click on [...] to browse for a folder)

Clients allow you to quickhy switch between project file data paths.
This influences the project open function, seanching for similar
projects and creating new projects.

This dialog allows you to create and edit a list of clients.

By default WinOLS stores all projects in one single folder. You can change this
behaviour with "Clients". Each client represents a predefined path where WinOLS
stores the projects. By choosing a client with the hat icon in the WinOLS main
window or in the "Open project” dialog, you change the current project path.

Most file related functions (like searching similar projects or opening a project) will
only use the current path. Open projects are not affected by a change of the project
path, but will stay in their own directory. If you want to move a project to another
client (and thus another path), close the project and right-click it in the "Open project”
dialog.

Special clients:

Your standard client is displayed with a yellow background. This client is
automatically determined from the shortest path of all clients and forms the basis for
automatic subfolders for:

- Deleted Projects

- Corrupt files

- The Reseller Upload Folder

- The reseller download folders (for the cache.dir's of the resellers)

For resellers, the reseller client is highlighted in green. If you are registered with EVC
as a reseller, you can find the required name on the Reseller page in the log.

Shortcuts

Symbol bar: ﬂ
Keyboard: F12
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10.3.5 The dialog Configuration / Automatically (Menu Miscellaneous)
4 Automatically

| Automatically create intemal filenames for project files:

Mamespace: 1000 - 5999

This filename is used to store the WinOLS project file whenever
you save the project. t is independent from the WinOLS export
filename.

In the background automatically:
| Search potential maps
| Generate overview information
| Collect map axis description profiles

| Apphy map axis description profiles

Dialog project properties:
| Auto-complete data
| Viehicle / Model: Manage space characters (2.0 TDI)

| Space characters between number and TOIAFSIY .
Space characters between number and T/L

| Load open projects on startup

Namespaces:

229

The 'namespaces' feature is of interest to you, if you're using WinOLS on multiple
computers without using a central shared directory for all, e.g. because one of the
computers is a notebook. In order to make the manual synchronisation easier, you
may configure the way the files are named for each computer. Enter a from / to area

to enumerate the filenames. These filenames may also contain letters.

Examples for correct namespaces are:
1000 - 9999
1000 - 1999
laptop1000 - laptop1999
1000pc - 9999pc

Background:

Parameters for automatic behaviour can be configured in this section.

Search If activated, WinOLS will search the project for potential maps and
potential... display them (if this is activated in the 'View' page). Potential maps

will be searched only once. If you save the project and reopen it, they

will not be searched again.
Generate If activated, WinOLS will automatically generate the overview
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overview... information, even if the overview window is not open. This is useful if
you have the 'pale’ data display activated (see 'View' page)

Collect map... If activated, WinOLS will automatically generate for the different
projects. These profiles store information about the way map axis
descriptions are displayed (for example name, unit, factor, offset, ...).
These profiles may be administrated in the drop-drop menu of the
map selection window.

Apply map... If activated, WinOLS will automatically try to find information to
configure the map’s axis descriptions better than the default values
would do.

Data areas  With the help of the free plugin OLS526 can auto-detect data areas.

This improves the detection of similar projects.

Dialog project properties:

Auto-
complete...

Manage
space
characters
...TDI

...other text
More options:
Load

projects...

Shortcuts

If activated, WinOLS will try to complete anything you type in the
project properties dialog (and in the open project dialog if you're
using the inplace editing feature). For this WinOLS will use the data
you entered in other projects and some predefined data.

WinOLS can help you fill in the field "Vehicle / Model" in a consistent
way. To achieve this, WinOLS (if you enable this option) corrects the
space character between number (e.g. "2.0") and the following text
(e.g. "TDI") according to your preferences.

If this option is active WIinOLS corrects "2.0TDI" to "2.0 TDI".

If this option is inactive WinOLS corrects "2.0 TDI" to "2.0TDI".

If this option is active WIinOLS corrects "2.0L" to "2.0 L".

If this option is inactive WIinOLS corrects "2.0 L" to "2.0L".

If activated, all projects with were opened when exiting WinOLS will
be re-opened on the next start of WinOLS.

Symbol bar: ﬂ

Keyboard:

F12
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{ Jimport

10.3.5.1 The dialog Configuration / Automatically / Import (Menu Miscellaneous)

When importing projects. automatically:

| Detect eprom emors

Detect vitual eeproms and wam me

v
| Detect forgotten swapping
W

Show project properties

| Search and accept vehicle data

<)

Search identical projects

| Sugoest similar projects as orginal, if applicable

Search checlksumms

Suggest scrips, if applicable

Parameters for automatic behaviour can be configured in this page. All options only
apply for the import / eprom reading process.

Detect
eprom...

Virtual
eeproms

Detect
forgotten...

Show
project...

Search and...

Search
identical...

Suggest
similar...

Search

checksums...

Suggest

If activated, WIinOLS will search for typical eprom errors after a
reading an eprom or importing a file. Some typical mistakes can be
recognised this way, but not all. WinOLS will only display a message
if an error was found.

Details at http://www.evc.de/en/service/ql1608.asp

If activated, WinOLS will try typical line swapping configurations to
see if you forgot to use one when importing. If a missing line
swapping was detected you will be asked if you want to apply it now.
Otherwise you won't receive any messages.

Shows the dialog "project properties” when importing a file.

If activated, WinOLS will search the eprom contents for vehicle
information when the project properties dialog is displayed for the
first time after an import from file or eprom. The data will be
automatically entered into the dialog.

If activated, WIinOLS will search for identical projects after an import.

If activated, WinOLS will search for similar projects that could be
used as original for the current import and will offer a list with the
possible candidates.

If activated, WinOLS will search for checksums within the import. If
there were already checksums found within the projects, these will be
recalculated.

If activated, WinOLS will display a list of scripts if there are any that
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scripts... can be applied to the current project.

Shortcuts

Symbol bar: ﬂ
Keyboard: F12

10.3.5.2 The dialog Configuration / Automatically / Export (Menu Miscellaneous)
LHFExport

Suggest filename when exporting:

Default: Ins.
E-Mails:

IUnderscores instead of spaces

The filename is the default filename when exporting. When
sending the file by e-mail it is the name of the attachment.

Preview (default) for the cument project :

Suffix for binary files:  bin -

As forthe impart:
If possible, use the import settings for the export:
For the filename
For the folder

BdmToGo:

Skip customer name when exporting

Placeholders:

When exporting WIinOLS can use the project properties to generate a suggestion for
the export filename. You can configure the format of this suggestion with texts and
placeholders in this dialog. Use the button "Ins." to select the placeholder that you
want to use. For the export of binary files you can furthermore configure the method
that is used to generate the file suffix.

When importing a file, WinOLS remembers the import filename and the folder where
the file was imported from. You can use this data as default when exporting the
same file again. If you activate these options, it will override the template mentioned
above whenever this data is available.

For the export of BxxToGo/ols files, you can configure WinOLS to remove the name/
number of the customer and the license plate information from the file when
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exporting.
The settings on this page are used for the export as file and e-mail attachment.

Shortcuts

Symbol bar: ﬂ
Keyboard: F12

10.3.5.3 The dialog Configuration / Automatically / E-Mail (Menu Miscellaneous)
EE:E-Mail

E-Mail data:
Subject  WinOLS Datei

Attachment filename: See page "Bxport”

E-Mail Tead:
Hallo!
Anbei die besprochens WinQLS Datei:

| Insert Project properties, but not ..

| Date | 8-Bit Sum | Project state

| Filename | Softwaresize | WIN

| Created by | Modffied by | Versionsg
Viele Grilke

Mote: Your standard e-mail client will be used to send e-mails. You may
configure this property in your e-mail client.

With this dialog you can configure the standard contents of any mail you send when
exporting WIinOLS files by e-mail. The file is sent with your standard e-mail program,
but that program will probably not append any standard footer you may have
configured. (This behaviour may depend on your e-mail client.)

You can configure the default subject line, a starting text and an ending text.
Furthermore you may have WinOLS add project information to the mail. These are
all information you can display in the select ‘Select ECU’* dialog. (Only information
fields that contain data will be added.) You can choose to ignore several information
fields.

When sending a mail from WIinOLS, your standard e-mail client will be used. You
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can configure this property in your e-mail client. The actions necessary to do this
depend on the e-mail client.

Shortcuts

Symbol bar: ﬂ
Keyboard: F12

10.3.5.4 The Dialog Configuration / Automatically / Map search
&@::Map search

‘When searching fir maps ) or when searching for maps in the
background, certain rules are used. Here you may corfigure which
maps are found and which are ignored.

|gnore maps that...
| consist of one constant value

| mosthy consist of one constant value

| consist of 2 atemating values

Properitan: maps:
| Bosch
| Delphi
| Denso
/| Siemens

| Temic

Statistical map recognition:

This method recognised maps simphy by the look. The map
gearch will take mare time if you activate this option.

|se statistical map recognition

With this dialog you can configure the way maps are searched. This applies both to
the direct search (hotkey f) and the automatic search in the background.

In order to reduce misdetections, WinOLS ignores several map types by default. You
may choose to change this and accept maps which consist only of one value, mostly
of one value or of 2 alternating values.

Furthermore WInOLS can search for maps in the vendor specific formats, if this
activated in this dialog.
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Another option is the 'Statistical map recognition' which is able to recognise maps
that are not stored in a specific format. This method of recognition judges the data
by its 'Look’, just like a human would do it. As a result it is able to find maps without
any special headers or structural data. As a drawback this recognition takes quite
some time and map axis data is only rarely recognised.

Shortcuts

Symbol bar: ﬂ
Keyboard: F12

10.3.5.5 The Dialog Configuration / Automatically / Report
Report
WinQLS can generate an entry in a report file for every save /
export / programming. This makes it easier for you to remember

which work was done for which customer, for example, when writing
an invoice.

The report is a CSV file and can be opened with Excel.

| Activate report:

Write the report inta this file:

| =

Don't generate entries that already exdist

Which data to you want to log?

General:
| Action [+ Filename | Editor | Version name

Customer data:
| Mame | License plate | Project status

Vehicle:
| Producer || Chassis | Model

WinOLS can create report files in a logfile format. Everytime you save, export or
program a project, WinOLS will write a line with information into this file. You can
open the file later on with Excel to understand which work was done for which
customer.

If you activate the report option, you must select a file in which the information will be
stored. The file can be stored on a network drive and it can be used by several users
at the same time (if they all use the same settings).
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10.3.6

If you activate ‘Don't generate entries that already exist’, only one entry will be
created if you save the same project 2 times. If the report file is big, this option can
cause perceptible waiting times.

All further checkboxes refer to the information (and thus the columns of the table)
that are stored. Choose the information that you want to store. The current date will
always be stored.

Shortcuts

Symbol bar: ﬂ
Keyboard: F12

The dialog Configuration / Miscellaneous (Menu Miscellaneous)
FhMiscellaneous

Saving:
[ ] Autosave every 1 minutes...

| ...and ask before autosaw

if Windows is shut down while WinOLS is running and has unsaved projects open:
(") Save automatically (@fter 20 seconds)
(") Discard changes (sfter 20 seconds)
(®) Suspend shutdown

Open project dialog:
When multiple projects are selected and opened...

...open the most recently edited version W

Rights:

[ ] Mon-Developer Mode (sees only finished projects; waming when trying to open others; cannot change projects)

You can limit the rghts on a global scale. This applies to the cumrent user of the computer, but it is not stored in the
project and thus not transfemed during the export.

Rights...

Saving:

e If you activate the Autosave option, projects with changes are automatically saved
after a defined time.

e Furthermore you can choose how WiIinOLS should react if Windows is shut down
while WinOLS is running and has unsaved changes.
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Rights:

Here you may turn on the 'Non-developer mode’. In this mode, only projects which
are marked as ‘finished’ are visible in the open projects dialog. Moreover you cannot
make any changes on the projects.

With the button 'Rights’ you can (just like in the dialog Project properties) limit the
user rights. However, the limitations in this dialog apply not only to the current
project, but to the entire WinOLS.

Encryption:

You can have the versions encrypted in .ols files. This happens automatically when
saving the version. If the versions are encrypted with their customer number, then
they can only be opened with an appropriately registered WinOLS. This protects you
against unauthorized distribution of .ols files - but not against export.

The encryption/decryption is fully automatic. No password needs to be entered.

Shortcuts

Symbol bar: ﬂ
Keyboard: F12

(C) 2025 EVC electronic



238

WinOLS 5.74

10.3.6.1 The dialog Configuration / Miscellaneous / Edit (Menu Miscellaneous)

O* Edit

Selection & Clipboard:

[[]Select only visible parts of columns

Delete selection when moving the cursor

[+*]When pasting a single value onto a selection, fill the area

Scale when inserting into a rectangular selection

[+]Wizard ‘Create map® when no map was created from selection

Strength of ..
..the function value /- 1; 8 Bit: |1 16 Bit: |1 32 Bit: |1 Ctd:* |5
...Ctd + PagelUp + PageDown: a0oo Bytes (hex)
_the mouze wheel (1=default):  Text: |1 2d: 1 o |1

Tastatur:

The hatkey # rotates between: 8 Bit 16 Bit [/]32 Bt []32 Bt float
Mumber keys start in text mode the ‘Inplace edit’ mode

[+“]CapsLock works like Shift (and can skip dislogs./reloads)

Editing operations waork with shown values (Text+2d) Live-Preview map/hexdump properties

Doubleclick opens mapshexdump properties Line change from keys <- / -»

Hide duplicate maps in hexdump popup menus
[+’]Compare name, toa

Selection & Clipboard:

Select only...

Delete
selection...

When
pasting...

Scale when...

Wizard...

Strength of...

value...

If activated, column selections work only in the visible area.

If activated, any change in the cursor position, will remove the
current selection unless you're currently changing the selection. This
option is useful if you're working without a mouse.

If you copy a single cell, then select and paste a range, this function
can fill the range with the value

If you copy a rectangular selection and then create a rectangular
selection of a different size and paste , the values can be scaled to
fit.

Displays a wizard if the "Generate map" function cannot derive a
meaningful map variable from the selection.

Every time you press the + or - key, the current value is changed.
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PageUp...

Keyboard:
#

Number
keys...

CapsLock

Use these fields to configure how much the value should be
changed. It can be configured for the different possible bit widths.

You may use the keys Ctrl+PageUp and Ctrl+PageDown to jump a
large block with the cursor. The size of this block (in bytes) may be
configured here. This is for example useful if the interesting parts
within a project a exact 8000 bytes apart.

Determines which data organizations are switched through by the
hotkey.

If this option is active, you can edit values simply by hitting a number
key (0-9) in text mode. If the option is not active you have to hit the
'Enter’ key before you can enter a new value.

You can skip numerous dialogs (or reload events) by pressing the
Shift key. Both when clicking on menu/icon, and by adding the Shift
key to the hotkey. This determines whether the CapsLock key also
has this function.

Individual items:

Editing
operations...

Double-click

Duplicates

Live

<-[->

Shortcuts

When activated, the edit relative function will not work on the eprom
data, but on the shown data (which may be different because of
factor and offset). Furthermore the + and - function will not increase /
decrease the eprom value by one, but try to increase the last digit. If
that is not possible because the change would be too small, the
eprom value will be changed by 1.

Double-clicking in an empty area can open the hexdump/map field
properties.

In some places in the hex dump there are several map (axes) on top
of each other. You can filter out these duplicates in the context
menu. You can specify whether only address+size or also the name
is to be used for the duplicate detection.

Immediately applies changes in the hexdump/map dialog. For large
projects this can cost noticeable performance.

Determines whether the cursor left/right keys at the beginning/end of
the line should trigger a jump to the next line.

Symbol bar: ﬂ
Keyboard: F12
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10.3.6.2 The dialog Configuration / Miscellaneous / Debug (Menu Miscellaneous)

@Dﬂhug

Dont load all DLLs simultanioushy
(Solves DLL problems under 55/98/ME/NT. This makes the

plugins a bit slower, but you can still use all of them )

Send logfile to EVC

| Delete configuration |

Don’t load Under 95/98/ME/NT the number of DLLs that can be loaded at the

all... same time is limited. If you have licensed many plug-ins, it may
happen that some of these plug-ins do not work. Normally this option
is automatically activated in this case, but you may also activate it
manually. You can still use all plug-ins, but they may be slightly

slower.

Shortcuts

Symbol bar: ﬂ
Keyboard: F12

10.3.6.3 The dialog Configuration / Miscellaneous / Language (Menu Miscellaneous)
Filanguage

Language:

| English (UK) -
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Different languages may be chosen for the user interface. Changing the language
requires a restart and will reset the toolbar configuration.

Shortcuts

Symbol bar: ﬂ
Keyboard: F12

10.3.7 The dialog Configuration / Miscellaneous / Internet (Menu Miscellaneous)

A Internet

Test Intemet access now

[ ] Use Prosy-Server;

(=]

Save configuration online:

Slot: Sync W
Save cument configuration file online

Load corfiguration file online and apply

Including: [ |Paths [ ]5essions [ | Name spaces [ | Recent projects [ Prosey
[ JHardware [ |Windows

Test:
Several WIinOLS functions can access the internet. Here you can check the access
to the internet and the EVC website for various typical problems.

Proxy:
Furthermore you configure here whether WinOLS should use a proxy server to
contact the internet. Please contact your network administrator for details.

If your proxy requires a login with username and password, please enter this as
"host" in the format "username:password@proxy".

Save configuration online:
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10.3.7.1

You can save your configuration file online on evc.de. For example to have a backup
or to use the same configuration on multiple PCs. For this you can choose between
multiple slots on the server.

Please note: This function uses the currently *saved* configuration. Changes that
you just made, but didn't confirm with OK are ignored.
Shortcuts

Symbol bar: ﬂ
Keyboard: F12

The dialog Configuration / Miscellaneous / Reseller (Menu Miscellaneous)
@Hesellﬂr

Reseller (Seller):

- R P ) - S (TP R mr

n/sa 12 automaticaly’ uploaded In the background 1o the

m
L]
(2]
i
T

d
\EVERY Cchange Inthe

Digallow delete f =507 of the projects are affect. (Protects against local drive problems.)

Status: Mot running. (0 0)

This page is only available to resellers (sellers).
You start the reseller sync here and see the current status and messages.

Disallow delete...:
By default, this option should be enabled. If your reseller folder is seen as 'empty’
because of a hard disk or network error, the online versions are protected by this.

Automatically upload ...:

WiInOLS can automatically create second versions of your projects, which do not
contain any maps, nor versions, and offer them in addition to the regular project at
another credits price. This happens virtually when uploading, so no files are created
on your hard disk. The project type is automatically changed to 'originalfile', the
filename gets the prefix ‘autoorgver_". If you fill in the price field in this dialog, the
credits price is also changed accordingly. Projects from which you have already
manually created a copy without versions / characteristic fields are not given a
second version by this function.

Optionally, you can skip specific projects for this function. To do this, enter one or
more (comma-separated) reseller project types. An asterisk replaces any string.
Upper/lower case is ignored. Example: "Training project, *mappack, *test*"

Shortcuts

Symbol bar: ﬂ
Keyboard: F12
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10.3.7.2 The dialog Configuration / Miscellaneous / Reseller-Buyer (Menu Miscellaneous)

¥ Reseller-Buyer

Search

MName

12ChipTuning.de

1Tune-File

24 7chiptuningfiles

24-7 TuningFileServer
365chiptuningfiles.com
971pro

Al PlanB

A1ECUfiles

A2Performance

ADF Tuning
AE2G_Performances
AK-Tuning

AM-F Tuning Files

AMP Advanced Micro Performance
AP Tuning

ASA - ZIPtuning.com

ASAP Chiptuningfiles

ASE und Team Fileservice.at
AT-0OLS

AUTODTC.MET

projects

|
e |
Lad
(=N N

[

20014
6078

Here you can see a list of your resellers / available resellers.

Double-click / right-click the list to become a customer of the reseller on the website /
end the business relationship or view up the list of the reseller's projects.

If you uncheck the box in front of the reseller, the reseller will be skipped in the hat
menus and under "All resellers".

Shortcuts

Symbol bar: ﬂ
Keyboard: F12

10.3.8 The dialog Configuration / Hardware (Menu Miscellaneous)

ZJiHardware

Flease choose a subpage to configure.
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10.3.8.1 The dialog Configuration / Hardware / Read protection (Menu Miscellaneous)
¥ Read protection

Default values for read protection and 5P tag:

MOREAD-Tag (general read protection)
| 5Pltag ffor programming SP| files)
+| BDOM read protection

|sertan:

The curmert values can be edited in the project properties.

This dialog allows you to edit the default values for some protection settings. The
values can later be edited in the dialog "Project properties"” for each project
individually.

Shortcuts

Symbol bar: ﬂ
Keyboard: F12
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10.3.8.2 The dialog Configuration / Hardware / BDM (Menu Miscellaneous)

* BDM

BOM Firmware:
Wersion: e

Status: e

BOM |dertification:

Provider:

Serial number:

Read data again

(available: 0300)

ol
L]
0 ]
(1]

Diont do testempty / delete before programming

You can find the BEDM properties of the cument project under:
Project properties = Projeld type = Button [ ]

This dialog displays data about the currently connected BDM module.

245

For information about the BDM serial number in the project please use the dialog "

Properties: project".

Shortcuts

Symbol bar: ﬂ
Keyboard: F12

(C) 2025 EVC electronic




246 WinOLS 5.74

10.3.8.3 The dialog Configuration / Hardware / BSL (Menu Miscellaneous)

*BS5L
Local Driver:
Version LELT
Chip Firmware:
Version: 7 (@vailable: 0000)
Status: 0001
BSL activation:
Status: ?

B5L Identification:

Provider: ? Set / delete..

Seral number; 7

Read data again

You can find the BSL properties of the cument project under:
Project properties = Projeld type = Button [ ]

This dialog displays data about the currently connected BSL module.

For information about the BSL serial number in the project please use the dialog "
Properties: project".
Shortcuts

Symbol bar: ﬂ
Keyboard: F12
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10.3.8.4 The dialog Configuration / Hardware / Eprom (Menu Miscellaneous)
* Eprom
Mo Eprommer

Batroni:

@ LUSB
Found in: C:\Program Files {86)"BatroniProg-Express*Pro

Grale-Wilde:

Parallel port:
Port 378 Port 278 Port 3BC
Other Part:

ISA card:
Port 280 Port 298 Port 2B0
Port 288 Port 240 Fort 2B8
Port 250 Fort 248

Use exclusively recommended for readfwrite emors under
¥P)

Search

WinOLS can be used to communicate with a Gro3e-Wilde MP2440P or Batronix
eprommer. This dialog allows you to choose the kind of communication connection.

Note:
The MP2440P eprommer will only work, if you manually activated the support for this

device during the installation of WinOLS!
Shortcuts

Symbol bar: ﬂ
Keyboard: F12
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10.3.8.5 The dialog Configuration / Hardware / Simulator (Menu Miscellaneous)
* Simulator

Part:

@ Mone

Parallelport (OL516 anby)
Part 378
Part 278
Part 3BC
Cther port:

EPP-Emulation 1

= =

USE (OL5300 onty)

Status: (not testet)

Test

WInOLS can be used to communicate with an OLS16 or OLS300 simulator. This
dialog allows you to choose the kind of communication connection.

Note:
The OLS16 simulator will only work, if you manually activated the support for this

device during the installation of WinOLS!
Shortcuts

Symbol bar: ﬂ
Keyboard: F12
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10.3.8.6 The dialog Configuration / Hardware / Third Party (Menu Miscellaneous)

* Third party
bHash slave files: requires OLS1011)
bHash APl key :
Lifetime:

[] Compress

Autotuner slave files: (requires OLST1016)
Master toal 10:

Autotuner AP key:

Autoflasher slave files: (requires OLS1017)

Autoflasher AP key:

For some plugins you need keys or other information from third parties. You can
enter these here. For the specific values to be entered, please contact the respective
third-party provider.

Shortcuts

Symbol bar: ﬂ
Keyboard: F12

10.4 The command Calculator (Menu Miscellaneous)

This command starts the Windows calculator, if it was installed.

Shortcuts
Symbol bar: -
Keyboard: -
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11 Commands of the menu Window

The menu Window contains commands to manage the different windows:

Map selection

Differences to the
original

Overview
Preview

Project comment

Lua

Toggle floating
windows

New window
Cascade

Tile horizontally
Tile vertically

Window 1, 2, ...

Shows an overview for all maps

Shows the differences of the current map as a
list

Shows an overview of the project.

Shows a 3d-preview for rectangular selections
or selected maps.

Displays the comment stored for the currently
active project.

List, execute, debug and encrypt LUA script.

Shows or hides all floating windows.

Opens a new window for the current document
Cascades all open windows

Tiles all windows horizontally

Tiles all windows vertically

Switches to the selection window

251
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11.1 The dialog Map selection (Menu Window)

Symbol legend:

. Project is connected.

. Click to fold the project.

. Click to close the project.

. This map has a comment. You can see it
in the tooltip or in the map properties.

. This map has factor/offset

. The flag (or other symbols) is only for your

=t [ [A[i"|[Pv|KK|==] O overview.

. The map contains changed values.

. Bold = This map/hexdump is currently

Map selection

L _dM i P =

Extra 5: -

A WNPF

o U1

M.. | Address | Mame
100129.0ls {Original) 00 = =]

[oolN|

& Hexdump (1/1) open.

00000 Hexdump

& My maps (1/5)
= 20EDOC  Map
20EDCO Map
C Map
r'-"|.':||:|
Map
Potential maps (63)

Hexdump (1/1)
00000 Hexdump

This dialog displays an overview of all open projects and their windows and allows
you to duplicate and delete windows.

Button double-line:
The buttons in this line correlate with the items in the main menu. Each has a tooltip
for explanation.

Session button:
The wide session button allows changing the active session.

Search line:
» Video

The search line filters the entries in the list (either for the current project or for all
projects). Only maps with the text in the name or id are shown. Apart from a search
text, you can also enter the following commands into the combo-box:

e Bit width: 8, 16, 32

e Dimension: 0dim, 1dim, 2dim
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e Exact size or size range: 16x32, 16x20-32

e Map address: e.g. 0x800a

e Map groups ids: e.g. #2

e -Negative: Type a minus sign in front of a word to exclude all maps that contain
this word from the results.

e "exact words": Putting words into quotation marks to search for projects that
contain these words in exactly this way (and not just the individual words).

¢ "one/ortheother": Separating words with a slash (or the word "or") means that it's
okay if only one item in this group is found.

Filter button line:
The filter-buttons left of the black triangle are shortcuts to the filter submenus.

A mouse-click on the black triangle will open a small menu with additional

commands for this dialog:

e You can export the list into a CSV file. (Same function as in the Project / Export
Menu)

e You may search the map list for a specific map

e You may show or hide a column. (Note: The column Id is useful if you're importing
Damos or A2L maps.)

e You can show / hide maps according to their bit width. You may specify a certain
bit width or you can tell WinOLS to show only the maps that have the same bit
width that the hexdump window currently has.

List:

A line in bold type symbolizes an open window. The text color shows (just like inside
a window) whether the window contains any changes compared to its original
version. The windows inside the list can be opened, closed, deleted or duplicated
with a context menu (right mouse button). Double-click a line to open / close the
window.

If you click the icon near the project or with the context menu you may hide windows
from the list. This is useful when you have a large number of windows. Hidden
windows are normally not displayed in the list. If you right-click a project in this
window you may configure whether the maps are displayed even though they are
marked as hidden, for example if you want to un-hide them. Maps that appear in the
list even though they are hidden can be recognized by their faded color. (You can
configure the hiding strategy at Miscellaneous > Configuration > Miscellaneous >
Edit.)

Special clicks in the list:

e Click in the first column in order toggle a flag for marking purposes. The flag is for
your reference only.

e Click in the project line on the fold icon to reduce the entire project to one line.
Click on the X icon to close the project

e Click+Hold in the project line an drag it to an Explorer or Outlook window to export.
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11.2

¢ Click+Hold in the project line an drag onto another project line to connect the
projects.
¢ Right-click the list's headline to select the columns.

Modal + Docking:

This dialog is not modal, meaning that windows lying behind the window may still be
used. The size of the dialog may be configured. The window may be (un-)docked by
doubleclicking the headline / title. This dialog may be (depending on your
configuration) a "floating" dialog. All floating dialogs can be toggled with the tab key.

Shortcuts

Symbol bar: B
Keyboard: Ctrl+K

The dialog Differences to the Original (Menu Window)

-_DiFFerE;ces to the origin
I From address; 00 b as. number: 20000 [ ption:

Mo, Addr.. Original Werzion Change =

203 182BF AR AC 1
zZ04 132C0 BS B9 1
Z05 132C1 Ca C7 1
206 182C2 EdQ El 1
207 182C3 4 5 1
2058 132C4 32 33 1
209 132C5 5a 5B 1
210 182Ca g2 g3 1=
Lo+t J[ -1 J[ Original |[ +100 ][ -100 |

This dialog shows the differences from the original to the current version of this
window. The different buttons in this dialog allow you to edit the values in the list.

Synchronizing:

WinOLS tries to keep this window in sync with the hexdump or map window. If you
change the cursor position in the hexdump or map window, the differences window
will show the respective entry. If you change the position or select entries in the
differences window, WinOLS will change cursor position and / or selection in the
hexdump or map window.

Columns:
Right-click the table header to get an additional menu. Here you can turn off columns
or add new special columns.

The size of the dialog may be configured. It can be docked to the sides of the main
window. This dialog is not modal, meaning that windows lying behind the window
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may still be used. This dialog is a "floating" dialog. All floating dialogs can be toggled
with the tab key.

Trick:
You can scroll through the differences by clicking+dragging in the scrollbar in the
hexdump while holding Shift.

Shortcuts:

Symbol bar: E
Keyboard: Ctrl+U

11.3 The dialog Visualizer (Menu Window)

OBD-Visualizer: Playing ®
Ii" =l III milel |2 w [ 0:27,128 Options. ..

W

¥: Engine speed 1520,000 1/min

W

¥: coordinated torgue request for charge

map for calculation of nominal charge

(Choose column) =

(Choose column) >

The Visualizer displays OBD values in WinOLS. Either live or from a recorded
session. In contrast to the simulator, these are not based on memory accesses, but
on real values. The values can be displayed directly here in the window as numbers
or graphically in the map window (requires mapping, see below). Unlike WinUCM,
WinOLS cannot read the error memory.

Quick start:

1. Connect UCM100 to PC and vehicle.

2. Press the connection button (plug icon).

3. Open a map and use the upper two ">" buttons to map the correct OBD data
sources to the axes.

Open-Buttons:

With the first two buttons you can open a previously created logfile. (These files can
be created with WinOLS or WinUCM.) With the second button (small triangle) you
can access files attached/linked in project/version. Alternatively, you can drag and
drop files into this dialog.

Connection-Buttons:
With the next 2 buttons you can connect the Visualizer to UCM100 hardware. The
first button does this automatically, the smaller triangle button allows you to select
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the protocol used.

Play-Buttons:
With the next 3 buttons you can start/pause, stop, or record the recording (only if
currently a connection is active).

Time elements:
In the last block you can (for recorded sessions) select the playback speed and see
the current time. Use the slider to select the current position (for recorded sessions).

Options:
The cogwheel button can be used to access various options and special commands.

Data lines:

The following 2 rows show the current values for the axes of the current map. If
values are available for both axes, an estimated value (linear interpolated) is
displayed for the result in the third row. Below the line any 2 other parameters can
be selected. These are independent from the current map.

Mapping: ">"
The source data channels need to be mapped to the correct axes for display. Click
on the ">" to select a source data channel for this axis.

OEBD-Visualizer: Playing * X
- & [n]me x1 v 146123 | optons..

¥: Drehzahl < || pTC_CnT
ot 51 | 1AT
Ziindwinkelkennfeld a ;iic_l:' cT
{Choose column) = i
{Choose column) T

V55

Graphs

Each mapping line starts with a graph button. It determines whether this data source
is displayed in a graph below. With the options button you can determine if there are
one or more graphs.

Note on the data quality of the recording:
For simplicity, the recording is in table format. This is only an approximation and
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does not reflect the exact reality, since for performance reasons not all values can
be queried constantly. Especially with slow protocols, with many values and with
values that are not currently on the screen, the query is sometimes significantly
delayed.

Trick:
You can resize the dialog (and e.g. reduce it to first 2 lines) and dock it below the
map list.

Shortcuts
Symbol bar:
Keyboard:

11.3.1 Visualizer Logdfiles

Instead of live data, you can also open and play previously recorded data in the
Visualizer. Use the Open button in the Visualizer or drag the file into the Visualizer
window.

The following file formats are supported:
¢ .ObdVisualizer
® .CSV

If the files were not created by WinOLS / WinUCM, you need OLS1018 to open
them.

The files must meet the following requirements:

e The column names must be within the first 4 lines.

e Optional additional lines with longer description and/or units are supported.

e There must be a column named "Time

¢ All values of all columns (including "Time") must be specified as int or float
numbers (Not: "23:59:59")

Example for a CSV file:
Time;nmot_w;ps_w
0;1511;64.953
1;1510;6.503
2;1507.5;650
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11.4 The dialog Overview (Menu Window)

&

3 kit mapdata

16 bit mapdata
32 bit mapdata
Pozzible mapz

=
o
[

Recoghized maps

=
Q
o

Empty areaz
Program code

nrecoghized areas

1 Pixel = B4 Buyte(z]

This dialog shows an overview of the current project and classifies the areas
according to their suspected function. The analysis needed for this may take a few
seconds and is done in the background.

If the cursor is moved over the graphic, the current pixel will be marked in legend on
the right side of the window. A click in the graphic moves the view of the current
window. A doubleclick in the graphic area will force WinOLS to recreate the
information displayed in the window.

You may choose whether you want to display the differences between original and
version or the simulator access in a light colour. To choose which should be
symbolised by light pixels, click on 'Extended'. (You may need to make the dialog
wider for this.) If you have WInOLS display the simulator accesses, you must have
loaded the simulator previously. Furthermore you need to generate the needed data
for this once with the corresponding menu item from the 'Extended’ menu.

The width of this dialog may be changed to save space on the screen. You may
change the height to the double of the default to get a better view.

This dialog is a "floating" dialog. All floating dialogs can be toggled with the tab key.

In the scrollbar:

WinOLS shows by default the overview information also in the hexdump scrollbars.
Here they can contain additional information:

e White points at the left => Difference between original and version

¢ Yellow triangle right => Position of a search engine

e Yellow, dotted line right => Marker

e Solid line right => Comment (In the comment's border color)
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A click (or: click+drag) in the color area jumps to this address. If you hold Shift
pressed, WinOLS jumps to the nearest change in this area.

Shortcuts
Symbol bar: E
Keyboard: o

11.5 The dialog Preview (Menu Window)

This dialog shows a 3d preview of the data you are currently working on. A preview
is shown

a) When you're creating a rectangular, consecutive selection

b) When you're selecting a map in the map selection window

¢) When you're editing a map that is not shown in 3d mode

This dialog is not modal, meaning that windows lying behind the window may still be
used.

The size of the dialog may be configured. You may use the mouse to change the
perspective and angle of the preview by dragging the base corners of the cube.

The size of the dialog may be configured. It can be docked to the sides of the main
window. This dialog is not modal, meaning that windows lying behind the window
may still be used. This dialog is a "floating" dialog. All floating dialogs can be toggled
with the tab key.

Shortcuts
Symbol bar: E
Keyboard: P
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11.6

The dialog Map database - Basics

This function requires WinOLS 5.00

» Video: Map Database

The map database allows maps to be identified and labeled by their appearance.
The rules are applied as soon as a map is automatically recognized or manually
entered. You can switch this off at F12 > Debug.

Terms:

e Each map database corresponds to a *.mapdb file.

e Each map database contains 1 or more rule groups.

e Each rule group contains higher-level conditions (e.g. ECU manufacturer). If they
apply, then the rules contained in them can be evaluated

e Each rule group contains 1 or more rules. Each rule is assigned to exactly one rule
group.

e Each rule contains 1 or more conditions (Ifs) and exactly 1 result (Then)

e The conditions (Ifs) can be divided into numbered groups. For the rule to apply, at
least one condition from each group must apply.

e If the rule applies, the result (Then) is applied to the map properties.

Live preview:
For debugging, the rules are tested live (but not applied). The result can be seen as
color in several areas. Red = the rule does not apply.

If you activate a map window, the rules will be tested from now on. Also a click into
the preview map list or on the text "Current map" in the preview window changes this
test focus.

Normally, the preview window lists all maps to which the rule applies. But if you use
the search line, all maps matching the search string will be listed and displayed in
red/green.

Step-by-step example:

e Open a project and create the map. With name, factor, offset. If the map exists
several times, please create all of them as a registered map.

e Window > Map database

e Add > Add rule group; If the map is to be searched only for certain ECUs, you can
enter the search conditions here. OK.

e Click on the rule group

e Add > Rule

e Preview: Enter the name as search condition.
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e Preview: Select all the maps in the list that should be used as a source.

e Key values: Click on the hyperlink "Create from preview selection". The search
conditions will now be determined automatically. Name, factor and offset are also
copied.

The rule is ready. It will be applied automatically during the map search from now on.

You can use the buttons in the preview area to apply it retroactively.

Tricks:

e The individual areas of the (very wide) rule window can be collapsed. To do this,
right-click in the window title over the desired area. In the same way they can be
restored. (The red X can also be right-clicked).

e It is easier if the map you are looking for is already defined with the name in the
project.

e Use the search function in the preview list to find out whether the rule applies to all
the fields you are interested in.

e To find out why a rule does not apply, activate the affected map. Either in the
preview list or by simply opening the map.

e You can share .mapdb files with other WinOLS users. Edit the MapDB properties
to restrict the rights.

More info:

e Rule-List

¢ Rule-Details

e Preview

e Conditions

e Condition: Basic values
e Condition: Search text
e Then

11.6.1 Map database - Rule list

This function requires WinOLS 5.00

Area: Databases

In the ComboBox at the top you can select the database that is currently being
processed. Here you can also create new databases, edit the properties (rights) of
the active database or delete databases.

Databases must be located in the WIinOLS configuration directory (or a subdirectory)
for WinOLS to find them automatically.

Area: Rules

In the list you can see the rule groups and the rules they contain. The contained
rules are only executed if the conditions of a rule group are fulfilled. (Otherwise, the
list displays them pale).
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More info:
e Basics

11.6.2 Map database - Rules

This function requires WinOLS 5.00

The rules dialog is very extensive and contains various areas.

The individual areas of the window can be collapsed. To do this, simply click on the
button in the upper left corner (or simply on the heading).

Areas:

e Preview

e Conditions

e Condition: Basic values
e Condition: Search texts
e Result

More info:
e Basics

11.6.2.1 Map database - Preview

This function requires WinOLS 5.00

The preview dialog shows whether the current rule fits.
The top line shows whether it fits the current map window.

In the list below you can see all other maps:

e If no search term has been entered, all matching maps of the active project are
displayed here.

e If a search term has been entered, you will see all maps (optionally all projects)
that match the search term. They are displayed in red or green, depending on
whether they meet the conditions of the rule.

You can choose if you want to see registered and/or potential maps and if the list
should be updated automatically or manually.

Important:
For this dialog the complete current rule is evaluated. So not only the active
condition.
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11.6.2.2

Preview at other places:

Also the rule list and the list of conditions and the condition dialog show a colored
preview. By default for the current map. However, if you click on the text ‘current
map' in the list (or on the text 'current map' at the top), the preview will refer to it in
the other places from now on.

Map database - Conditions

This function requires WinOLS 5.00

A rule of the map database contains one or more conditions. These can be found in
this list. If you click on an entry, the details of the condition appear to the right of it in
the Basic Values or Search Text area.

Groups:

Conditions can be arranged in groups. In total, at least one rule from each group
must apply. Within a group there is an "or" condition, the groups are linked by an
"and" condition. So you can determine (by 2 rules in 1 group) that a map must be
exactly 8x12 or 10x14.

Preview:
This area shows live if a condition is true. Normally the current map window is used
for this. But if you click in the list in the preview area, the clicked map is used.

11.6.2.2.1 Map database - Basic values

This function requires WinOLS 5.00

In this dialog there are several numerical parameters that are requested for a map.
All of them must be true for the rule to apply. Empty fields / checkboxes with black
boxes are ignored.

Size:
Here you can set the minimum / maximum size.

Map values:
Here you can define the maximum size of the map.

Axis values:
Here you can define the maximum size of the first/last value of each axis.

Extreme values:

Here you can define at which position the largest/smallest value of the map may be.
With the 9 checkboxes you can define if the value may (or may not) lie in one of the
4 corners, one of the 4 edges or in the inner area.
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Create from:
You can have the values for this dialog filled in automatically. WinOLS then
automatically searches for values which fit so straight. Either for the current map

window, for the preview list or for the selection in the preview list. Furthermore you
can extend all values.

Preview:
This area shows live whether a condition applies. Normally the current map window

is used for this. However, if you click in the list in the preview area, the selected map
is used.

Important:
Factor / offset the from the "Then" page are used in the calculation of the axis/
extreme values. Thus it's better to set them first.

11.6.2.2.2 Map database - Basic values - Create

This function requires WinOLS 5.00

Important:
This is a tool for advanced users, not an automatic wizard.

It is not enough to click on "Create". You have to understand and check each
rule.

The create links can create a rule that matches:
- the current map

- all maps in the preview window

- all selected maps in the preview window

In general:
The more maps you select, the more unspecific (=worse) the resulting rule will be.

What to do:

e Try finding maps that are very similar. Not only by name, but also by size +
content. Selected them and use the create from selection link.

e If you have different clusters of maps (with the same name, description, etc.), use
one entry per cluster in the condition list.

(Cluster means that some are very similar; And others are also very similar to
themselves, but different from the first cluster)

e Test the rule: Use the preview dialog to test if your rule matches maps, that it
shouldn't match.

11.6.2.2.3 Map database - Search text

This function requires WinOLS 5.00
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This condition applies if all texts (or hex byte sequences) entered here were found in
the hex dump. Empty fields are ignored.

Preview:

This area shows live whether a condition applies. Normally the current map window
is used for this. However, if you click in the list in the preview area, the clicked map is
used.

11.6.3 Map database - Then

This function requires WinOLS 5.00

If a rule applies, then it can be addressed. Here are the values.

11.7 The dialog Command line

This function requires WinOLS 5.00

With the command line you can do various things by text input.

The window offers several command lines which all have the same function. The
lower lines can be locked against changes to keep frequently used commands at
hand. If they are not needed, the dialog can be resized so that they are invisible.
Several statements can be linked using ";".

1.Apply arithmetic operations to the current selection (or cursor position):

arithmetic operationed moved / to other windows:

This function requires WinOLS 5.58 + FeatureUpdate

These operations take the x/y coordinate of the cursor, current selection or search
result(s) and change the current window, the x or y portion before applying the
calculation operation.

Examples:

*2; +1 2 combined commands: The cells are doubled and 1 is added.

yaxis=1 The value in the Y-axis is setto 1

mapO0.coll=4 The value in the connected map 0 (counted from the left) in
column 1 is set to 4.

myid.yaxis=4 The value in the connected map with the Id myid in the Y-axis is
setto 4
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map[xy].col[zz]=4 The value in the connected map field with xy in the name in the
column with zz in the text name is set to 4

col[+1]=4 The value in characteristic field 1 to the right of the search value
is setto 4

map0.coll=4; 2 instructions

map0.col2=5

Attention: All indexes start at 0!
Attention: Unlike with the extended replacement in the search results, no "do" is
required, because it is already clear that it is a command line instruction!

3. jump to an absolute or relative address:
:80000
:+1000

4. Select an address range:
100..1FF

5. search and open a map by its ID:
AFl_MULT_MN

6. Change map properties similar to set_map_property WinOLS-Script
commands:

Spalten=10

Feldwerte.Faktor=2; Feldwerte.Offset=10

7. jJump to a comment:
My Comment Text

8. open an ols project:
filename.ols
filename

9. import a file that is located in one of the two default folders (visible for new,
empty projects):

filename.bin

filename.kp

10. LUA commands (requires OLS530)
lua:MessageBox("test");

11. absolute paths
c:\myfolder\test.ols
c:\myfolder\test.bin
c:\myfolder\test.lua

12. button names
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11.8

By appending a C-style comment, you can make the button larger in locked mode (i.
e. not in the top input line) and add the comment text.
+10% // MyName

The size of the dialog may be configured. It can be docked to the sides of the main
window. This dialog is not modal, meaning that windows lying behind the window
may still be used. This dialog is a "floating" dialog. All floating dialogs can be toggled
with the tab key.

Shortcuts:

Toolbar: -
Keyboard: Ctrl+Enter

The dialog Lua (Menu Window)

This command displays a list of the LUA scripts available in the selected folder.

If you hold down the Shift key during execution or have not configured a path, the
dialog will not appear and the last LUA script used will be executed.

You can start the script in the Lua debugger with the "Debug" button.
You can use the "Encrypt" button to create new, encrypted luax files of script files.
Shortcuts

Symbol bar: -
Keyboard: Ctrl+F9 / Ctrl+Shift+F9
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11.8.1 The dialog Lua Debugger (Menu Window)

LUA Debugger

Step ("mylib");
In | Out
-- Start
Walk aad=1;
Jog aabs=11;
Riun f[];
aad=
("test”);

Restart aad_:a:

Cloze 4

Global Value Function Value
| [anonymous)
11

The Lua debugger allows you to execute Lua scripts step by step and view the
contents of the variables. You can reach this function via the "Re-run last LUA script"
dialog (requires a configured LUA path).

Step/In/Out:

Keyboard: F10/F11/Shift-F11

Executes a single program step. The 3 buttons differ in their behavior with LUA sub-
functions. While "Step" executes the function completely and only stops again
afterwards, Stepln also allows you to step through the sub-function individually.
StepOut allows you to continue executing the code until the current function is
terminated.

Walk/Jog:

These functions work as if you keep using Stepln (F11). While Walk always pauses
for 500ms, Jog works as fast as it can. Both functions are ended by a breakpoint or
by the Pause button.

Run:

Keyboard: F5

Runs the script without debugger interaction until a breakpoint is reached or Pause is
clicked.

Pause:
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11.8.2

11.9

Interrupts the current script, at the next LUA command

Restart:
Interrupts the current script, at the next LUA command and restarts it.

Close:
Closes the debugger

Line colors:
The yellow line is the current line. The previous lines are highlighted in gray.

Breakpoints:
You can set/delete breakpoints by clicking to the left of the line numbers.
Breakpoints interrupt the Walk/Jog/Run functions.

Watches:

You can see global/local variables in the windows at the bottom left/right. You can
also query variables using the mouse tooltip and view them in the virtual comments
that appear n the line during execution.

Shortcuts
Symbol bar: -
Keyboard: -

The command Encrypt LUA script (Menu Window)

Creates an encrypted .luax file from an existing .lua file.

As with .olsx files, the encryption can be bound to a license account number and/or
password. With the right authorization, the .luax file can be run, but it cannot be
decrypted.

Shortcuts
Symbol bar: -
Keyboard: -

The command Toggle floating windows (Menu Window)

This command shows or hides all floating windows. Floating windows are windows
which are always displayed above the normal windows. Like the differences dialog,
the preview window and (depending on your configuration) also the map selection
window.

Shortcuts
Symbol bar: -
Keyboard: Tab
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11.10 The command New Window (Menu Window)
Use this command to create a new window with the same contents as the one
currently open.

11.11 The command Cascade (Menu Window)

Use this command to display all opened windows in a cascading style.

11.12 The command Tile horizontally (Menu Window)
Use this command to display all opened windows next to each other.
11.13 The command Tile vertically (Menu Window)

Use this command to display all opened windows above each other.
11.14 The commands 1, 2, ... (Menu Window)

Switches to the window selected.
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12

Commands of the menu ? (Help)

The menu ? (Help) contains the following commands to access help information
about the application:

Help topics

Help topics:

menus

Help topics:

Drop

Help topics:

dialogs

Help topics:
Help topics:

cursor

Help topics:

A small tip

Context
Drag &
Floating

Keyboard
Mouse

Selections

Tip of the day

Homepage EVC

Info about Plug-Ins
Info about WinOLS

Lists all help topics

Explains the context menus of WinOLS

Shows help about the drag & drop support of
WinOLS

Lists the floating dialogs and explains their use

Lists all keyboard shortcuts
Explains the different mouse cursors

Explains how to use the WinOLS selection
methods optimally

Shows different tips for the current context
Shows information about small but useful features

Starts your browser with EVC homepage

Shows all installed plug-ins

Shows program-information, version number and
copyright

12.1 The command Help topics (Menu ? (Help))

Displays a list of all help topics.

Shortcuts

Symbol bar: -
Keyboard: F1
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12.2 The command context help (Menu ? (Help))

Use this command to activate the help cursor. While this cursor is enabled, click on
toolbar icons of menu items to get help for them.

Shortcuts
Keyboard: SHIFT+F1

12.3 The dialog A small tip (Menu ? (Help))

This dialog shows tips that refer to the current context or action. You may also view
them by selecting them from the menu.

Shortcuts
Symbol bar: -
Keyboard: -

12.4 The dialog Tip of the day (Menu ? (Help))
( The tip of the day -2 [ |

The tip of the day:

I1ze the wiew menu o zelect the toolbars you want bo uge and
the place you want them to be.

Show tips at every start.

Lo« Jf oK L o» ]

RS -

This dialog shows hints and tricks for WinOLS at every program start. You may
disable this dialog, if you prefer not to see it.

Shortcuts
Symbol bar: -
Keyboard: -

12.5 The command Homepage EVC (Menu ? (Help))

Starts your internet browser with the EVC homepage. A connection to the internet is
needed for this command.
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Shortcuts
Symbol bar: -
Keyboard: -

12.6 The dialog Info about plug-ins (Menu ? (Help))
'Info about plug-ins )

The following checksum plug-ing are installed:

Froduct... Mame Werzion Regstered?

Tag-Patchblock Ve
Copy-Checksum Yes
b arnual Default-Checkaum ez

Drescription...

The following ather plug-ing are inztalled:

M ame Wersion Reqistered?

Damos and ASAPZ [mpart Werzion 3.021 Mo
Deutzch Wergzion 2.024 nia
Englizh [LE] Werzion 2.024 n'a

] [ DLL-Conflicts... ] [Qpen plug-in fu:ulu:ler...] [ Fe-activate plugin...

This dialog shows a list of all installed plug-ins. If a plug-in is installed, but not
registered its search function will work, but the checksum will not be calculated.
Contact EVC to get the plug-ins.

The button DLL conflicts is only available, if conflicts between two or more DLLs
occurred during startup.

Shortcuts
Symbol bar: -
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Keyboard: -
12.7 The dialog Info about WinOLS (Menu ? (Help))

i @ WinOLS Wersion 2.24.31 for 64 Bit
“Windows 7 64 Bit
Compiled: Jul 21 2012

Copyright [C] 1993-2012
EWC electronic GmbH
Arm Plauenzehnt 11a
46539 Dinglaken
Germary

Customer nurmber;

WinDriver WindLS: 11.0.0

WinDriver Windaws: wWinDriver ¥17.00 Juhgo (2] 1997 - 2012 Build D ate: Feb
27 2012 #36_B4 B4bit 555 14:32:14

You can i WindLS 27 times untl 12.09.2012 befare updating the registration.

Ok

This dialog shows version information.

Shortcuts
Symbol bar: -
Keyboard: -

275
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13

13.1

Other Dialogs

Please choose a subtopic.

The dialog Intel/Motorola import parameter

Intel/Motorola import paramets

File zize

The file contains data for the following
4 KByte [2732] address range: DR000-00000
2 EByte [27E4]

16 KByt [27128) Fleaze choosze the offzet:

32 KBEyte [2725E) 1] [hex]
B4 KEupte [27512)
128 KByte [Z27C010] Thiz will create thiz address
286 KByte [27CO20/29F 200] [please choose the project zize]
512 KByte [27C040/25F 400)
1024 KBute [29F200)
2048 KBute [29F1R0)
4096 KBuyte
2192 KBuyte

Address range:

| b are infarmatian. . |

When importing Intel or Motorola files, WinOLS may need additional information for
a correct import. This is due to the fact that these file formats may contain multiple
data blocks which are stored (according the file) at very different addresses.
Normally it is recommended to import these different blocks as elements and not to
use this dialog. (You may choose this in the question that appears before this
dialog.)

If you don't want to use elements, you can use this dialog for force all data into one
big data block. This isn’'t a real problem since these data blocks are mapped into one
large block anyway. But you must decide which project size is the right one for this
mapping. Optionally you may specify an offset, which results in a movement of the
data to another address. Depending on the project size you chose, the ‘Overlapping
areas found! * may appear in the dialog. This happens, when multiple data blocks
write into the same addresses due to the mapping (which is determined by the
project size and the offset). Overlapping areas are a hint that the project size may be
too small.

Press the button ‘More information‘ to get a list of all data blocks which the current
file contains.

Shortcuts
Symbol bar: -
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Keyboard:

13.2 The dialog Protected memory area is being changed

The contents of the
0xFFa17
iz to be changed, even though thiz address iz not covered by any checkzum areas. Apply the change?

W )

-*'eg, apply changes always [furns memary protection off]
-‘t'esz, apply changes for the entire operation

-eg, apply change

- Mo, ighore change

- Mo, ignore such changes for the entire operation [only for protected memony areas]

W ™M ™M
I n = e ks =

- Mo, cancel the entire operation

This dialog will be displayed if you're changing data that is not covered by a
checksum while having the memory protection turned on. It allows you to decide
what to do with this change and with further changes.

Shortcuts

Symbol bar: -
Keyboard: -

13.3 The dialog search in map list (Menu map list)

Search for: ||

In Bealime [ Match case

Single value Onedimenszional Twodimensional
Alzo zearch for maps in closed folders

K] [ coes ) (€] Result s | ceecten

Use this dialog to search the map list for texts or map types.

If the option ‘Search in realtime’ is activated, the search will run while you're entering
data.
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If the option ‘Also search for maps in closed folders’ is activated, WinOLS will even
find maps that are currently not in the list, because they are in a folder that is
currently closed. WinOLS will open the map’s folder to display it.

If the option ‘Result as selection’ is activated, all maps will be selected which match
the search criteria. You may continue to work with this selection, for example by
hiding or deleting them. Use the option 'Result as view filter' to hide all entries that do
not match your search criteria.

Use the blue arrow buttons to jump to the next or previous occurrence of the search
text.

Note:

The hotkey Ctrl+F will start this dialog only if the map list has the focus. If a project
window has the focus (= the cursor is blinking there), a search dialog for a byte
sequence list will be started.

Shortcuts
Symbol bar: -
Keyboard: Ctrl+F

13.4 The dialog Enter a filename

A new project file needs to be created. Pleaze enter a filename that iz currently not uzed
by any project:

[Mate: Thiz meszage appears if you've tumed the automatic file naming off or if the
namespace iz full. Y'ou may configure both under 'Configuration > Automatically'. ]

This dialog asks you to enter a filename for a new project. Most of the time WinOLS
can automatically create a new filename. This dialog appears only if you've turned
the automatic naming off or if the given namespace is full (meaning all files that can
be created with the namespace already exist).

Both issues can be configured in the dialog Miscellaneous > Configuration >
Automatically. For more information about namespaces, please refer to the help
page of that dialog.

If you are unsure what to enter in this dialog either accept the default value or just
enter a large random number.
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Shortcuts
Symbol bar: -
Keyboard: -

13.5 The dialog Name folder

M ame:

Automatically move maps inko this folder:;
[T 1f the address is within this range
0 - |0

[] 1f the name contains the following text:

Apply rule now on exizting maps

k. H LCancel ]

This dialog requests a name for a folder. It appears when you create a new folder or
rename an existing folder. You should avoid using the same name twice.

WinOLS can move a map automatically in the right folder, if the address is within a
certain range or the name contains a certain text. You can configure these properties
here.

Templates for folder names:

With the button ">" you can store / use a tree structure with folder names. The text
file with the names must have the following format:

Name of the groupl

-Namel.1

-Name1l.2

Name of the group2

-Name2.1

Shortcuts
Symbol bar: -
Keyboard: -
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13.6 The dialog Move maps

Pleaze choose a new falder for the selected maps:

[ Hexdump

| ok || Mewiolder.

This dialog allows you to move one or more maps into another folder. For this just
select a new (already existing) folder from the list.

Shortcuts

Symbol bar: -
Keyboard: -

13.7 The dialog Create map

Create map

1d: 63x1
Matching 1: 3x21
Matching 2: 7ud
Matching 3: 9x7
Matching 4: 21x3
User 1: 16x5
User 2: 8x16
User 3: 20x20

Start address: EDEAS =]+
Column x rows: 3 = x | 21 = Copy to selected line

Cancel You can also use MM P and didk into the Hexdump.

This dialog appears when you try to create a map from a linear selection that can't
be converted into a map, for example because it doesn't match the number of
columns. You can use one of the listed strategies to fix the selection. You can also
use the hotkeys M/W to change the number of columns or P to activate the preview
dialog.
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13.8

13.9

While the dialog is open, you can click into the hexdump to change the start/end of
the selection. A left-click works changes by entire rows. A right-click (at the start) by
individual cells.

Shortcuts
Symbol bar: -
Keyboard: -

The dialog Fix translation

You can use this dialog to correct text errors in the translation and report them to
EVC. You can access this dialog via Configuration > Language.

Enter a search text to find the desired text.
Edit the text in the first column by double-clicking. Confirm the entry with the Enter
key.

You can delete your own corrections by deleting the entire text when editing.
Use the button at the bottom right to send the changes to EVC.

Changes to menu texts only become visible after a restart with menu reset (View >
Toolbars).

Shortcuts

Symbol bar: -
Keyboard: -

Status bar

Map search in progress (51%, 16 map(s) found) |F'.II CHEs ok, &7 |ND CL5-Module |Cursu3r: 000648 == 05 (05) -= 0 (0,00%:), Width: 16

The status bar is displayed at the lower end of the WinOLS screen. You may toggle
the status bar in the "view" menu with the command "status bar".

While you're navigating through the menus, the status bar will display a help text for
the choice you're currently selecting. If you're waiting with the mouse cursor over an
icon, the status bar will display a help string for the icon, too.

When (like shown in the image above) the automatic background search is running,
you'll see its state in the status bar.

The first following range shows the state of the checksum modules. Depending on
cursor position and configuration, WinOLS may display information about the
checksums in general or about the current (manual) checksum.
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13.10

13.11

13.12

Right of the checksum one or more icon(s) may display the state of a possibly
connected OLS16 or OLS300 simulator module. Wait with the mouse cursor above a
symbol to get a tooltip with a description. Right of the symbols, a textual description
of the simulator state will be displayed.

The last range displays information about the cursor position, the current field value
at the cursor position (and the original value), the relative change in comparison to
the original (also in percent) and finally the width of the current hexdump or map.

Note:
You may right-click any of the ranges to receive a matching context menu for the
range that you clicked.

The command Right Side (Icon bar)
0

Use this command to change the contents of the right side of a hexdump or map
window. You may choose between a bar display (the value range for the bars can be
configured in the window's property dialog), an ASCII display or you may turn the
right side off.

This command is only available for the text view mode.

Shortcuts
Symbol bar: See above
Keyboard: -

The command Data width (Ilcon bar)

[] [T ([T
E 16 |32 FL

Use this command to specify the number of bits per shown value. Possible values
are 8, 16 or 32 bits or 32 bits floating-point. If you use a data width larger than 8 bit
you can use the button Data organisation to specify the bytes' organisation.

Shortcuts
Symbol bar: See above
Keyboard: #

The command Data organisation (Icon bar)

LOHI
HILD

Use this command to specify the way the data is organised. On the one hand,
storage may behind with the least significant byte. On the other hand, the most
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significant byte may be the first. These kinds of storage are also known as Intel or
Motorola.

This command is not available for 8-Bit Data.
Shortcuts

Symbol bar: See above
Keyboard:

13.13 The command number system (Icon bar)

E] FF 111

With this button you may switch between the decimal system (10er system), the
hexadecimal system (16er system) and binary system (2er system) for viewing.

If you're not familiar with the number systems, you should work with the decimal
system. Click on 255 to activate it.

Shortcuts

Symbol bar: See above
Keyboard:

13.14 The dialog Calculate factor and offset
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I Calculate factor and offse |-

Thiz wizard helpz you to calculate factor and offset from tpical formulas. For example if pou hawe wiitten documention about the conwersion of the
walles.

Formula;

Output = Output =

Sample values:

255000000
100

Result Tipit:

Eprom ' alue:

Dffset:  0,000000
Beciprocal with Offget: 0.000000

Shown value 0.000000

QK H LCancel |

This dialog is a subdialog of the dialog 'Properties: window'. You can reach it from
these with the button "f(x)".

This dialog allows you to calculate the WinOLS fields factor and offset from different
common formulas or sample values. This is useful if you have information about the
conversion of the eprom values, which cannot be entered directly into WinOLS (as
factor and offset) due to their given format.

For example you might have the following conversion formula:
VAL = 100/(0,00001 * N)

First you must select the kind of formula. The input size is below the fraction stroke,
so you must use the right formula. Enter the values. The number 100 above the
fraction stroke, The number 0.00001 below the fraction stroke. In our sample no
further value is added. So just leave the additive variable below the fraction stroke at
0.

As a result you can now see factor and offset in the lower left corner of the dialog.
Furthermore the checkbox "Reciprocal” is activated. You can now hit the OK button
to leave the dialog and accept the values. If you have sample values, you can use
the lower right part of the dialog to test your results.

Shortcuts

(C) 2025 EVC electronic



286

WinOLS 5.74

Symbol bar: -
Keyboard:

13.15 The command Factor, Offset, etc. (Icon bar)

13.16

% A= |0

Use these 4 Buttons to change the view mode for the data in comparison to it's
original data.

% The proportional difference between the original and the version will be
displayed.

Delta The absolute difference between the original and the version will be
displayed.

*1 The data of the version will be displayed ignoring factor and offset.

Org The data of the original will be displayed instead of the version. If another
version is selected as reference version, that will be displayed.

OrgOrg The data of the original will be displayed instead of the version. The
selected as reference version will be ignored and the original version of the
current project will be displayed. This button is only available if a reference
version is active.

You may activate each of this 5 modes for a short time just by moving the mouse
cursor over the icon. If you now click on the icon, the mode will be activated
permanently. If you move the mouse cursor away without clicking, the old state will
be restored.

Shortcuts
Symbol bar: See above
Keyboard:

The command Right Side / Fixate Ride Side (Menu View)

This command is useful if you're working in text mode with maps or hexdumps that
have a large number of columns. Normally the Right Side (where characters or bars
are) is hidden unless you scroll completely to the right. If you activate the mode
'Fixate Right Side’, the Right Side will never be hidden, but stay always visible.

You may also toggle the mode by clicking on the small red or green dot on the
dividing line between the data and the Right Side.

Shortcuts
Symbol bar: -
Keyboard:
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13.17 The dialog Change project size
Change projectsie . -

Altentionl

Y'ou have entered a different [smaller] project size, All versionz will be changed. Do vou want
to cantinue? This process cannaot be undone.

How do wou want the new data to be filled’?

wiith a copy of the exizting data
with |FF

YWwhere do you want to cut the data off? [Mote: The data will be lozt!]

1 At the beginning of the project
@) Ak the end of the project

This dialog appears when you change the project size in the project properties. Now
you may choose whether the bytes should be added to / removed from the beginning
or the end of the project. If you make the project bigger, you may also choose how
the new bytes should be filled.

Important: The change of the project size always applies to all versions of the project
and cannot be undone. If you cut bytes off, they cannot be recovered.

Shortcuts
Symbol bar: -
Keyboard:

13.18 The dialog Edit Multiple Maps

You can start this dialog by right-clicking a selection of maps (all in the same project)
in the map sidebar.

It allows you to perform various functions that you would normally do on each map
individually, on all selected maps in one go.

The following actions are available:
e Set maps to their original values
e Set maps to a decimal or hexadecimal value
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e Round the values or limit them to a minimum/maximum.

e Swap the maps (mirror them by a diagonal axis)

e Change the flag status (first column in the map sidebar)

e Set the view mode (Text/2d/3d)

e Set the Endian (HiLo or LoHi)

e Set Leading / Precision
If the fields are empty, the respective fields in the map will not be changed
want to change the fields to empty (=automatic mode), enter only a minus
character ("-").

e Add an Offset

e Paste the current clipboard contents onto the map

Edit multiple maps
All map values in the selected maps: All selected maps:

[ Set to orginal for reference project) *) Swap 2d maps:
Set to this decimal value: %)

[] Set to this hex value: %) [IHag:

[#] Round.Limit: e O View:
Desired precision: [] Address: *)
Value: 0,5 [] Endian: *)

[] Right side:

[ Allow more than 1 checkbox at the same time [] Mumber format: *)

[ Leading / Precision: *)

*) Apply on: [ Copy/swap text fields:

[] Paste clipboard

ii ncel

Shortcuts
Symbol bar: -
Keyboard: -

. If you
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13.19 The dialog Transfer changes

Transfer values

Transfer changes by:

All changes are relative to the |OWWN original.

) Difference
to be applied on:
(") Percentual

50

[ Even unchanged

Map: Puis:
[ Onby where source = target [ Only where source = target
[ Onby where source < target [ Only where source < target

i) Transfer nothing

You can reach this dialog by connecting 2 projects and right-clicking a map or
selection in a hexdump.

This dialog allows you to transfer the map you right-clicked into the other project.
You can choose whether you want to transfer the contents (the map values) and / or
the structure data (everything you see in the map properties). When transferring the
map start address will be adjusted according to the current connection settings.

Basis of calculation:

This dialog is often used in combination with the function connect / reference
version. For the consideration of what is ‘changed 'or the calculation of percentage /
relative, however, always the OWN original of the respective source / target project
is used. The reference version is ignored here.

Absolute/Difference/Percent:

If you choose the mode "Absolute”, the values will be transferred directory. For the
mode "Difference" the difference between original and version will be calculated
using the source data and added to the target data. For the mode "Percent” the
percentage difference between original and version will be calculated for the source
data and added as percentage to the target data.

Rights:
Some functions in this dialog can be locked if the rights of the source project (8 in
the Project properties) don't allow them.
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Problems?
If nothing appears to be transferred, check the selected mode. Also turn off the
reference version for both projects. This is the only way to see the basis of the
calculation.

Tip:
Hold the shift-key pressed to skip this dialog and perform the action immediately.

Shortcuts

Symbol bar: -

Tastatur: Ctrl+Alt+W / Ctrl+Alt+Shift+W  (Transfer values)
Tastatur: Ctrl+Alt+T / Ctrl+Alt+Shift+T (Transfer maps)

13.20 The dialog Insert / edit comment

—
I ,

Addrezs: 10D

This dialog allows inserting or editing a comment. Comments offer a lot of
possibilities:
- They mark places or areas.

They store information which can be seen as tooltips.

They allow fast access to the marked places with the next / previous

functions.

They appear in the "Go to" list.

They can mark security areas for the BdmToGo export.

If you have a selection active when using this function, the comment will be created
for the selected range. If you want, you may also edit the background and frame
color for the marking.

Shortcuts
Symbol bar: -
Keyboard: Shift+Enter

13.21 SPI-Signature

The SPI-Module must recognize a file as SPI file. That's why it must contain a so-
called signature.
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Audi A3 (Original) as Eprom, 378563, Hexdump * for Checksumtest El@

It consists of 8 the ASCII characters "EVC.EVC" and should be near the end of the
EPROM at an address xxxx0, an address where there lowest significant digit in
hexadecimal is zero.
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14  Advanced topics

14.1 Scripts

Scripts are text files that contain instructions how to change a project file and under
which circumstances the script file may be applied. Scripts can be used to store
often needed map changes and quickly apply them into other projects.

14.1.1 Basics

Scripts are text files which are stored in the script directory (can be configured in the
WinOLS options) and have the file ending '.Winolsskript'. Like in C++ you may start
line comments with '//'. Most of the commands may only be used within predefined
blocks. Only one command per line is allowed.

Basically the scripts describe the intersection of sets resulting from search
commands and replacement operators for the sets. Furthermore maps may be
defined.

Scripts are normally created by using the WinOLS Script dialog (button "Add"). But
you could also create or modify the files in the script language manually.

14.1.2 Script language

The following text describes the internal structure of scripts. This is only
relevant for very advanced users with programming experience. Normally
scripts should be created with the "Add" subdialog of the "Script" dialog.

Groups:

A central concept of the WIinOLS scripting language are groups. Thus you will find
groups in several commands. A group is always represented by a symbolic name (e.
g. "KF01") and describes a set of all matching search results.

For example, to search a map you would (strictly speaking) need three search
commands. One for the map data and one for the data of each axis. The data
should not be moved one beneath another (for example the distance between the
map data and the data of the X-Axis should be the same in the source project and in
the target project where the script is applied.)

Every search (details see below) has a defined start address. When WIinOLS begins
a search it will remember a list of all offsets relative to the start address and store it
within the group. (If a search finds no results, the script cannot be applied.) So, if you
search for the string "128 129 130" with the start address 0x1000, then the result
could be that string will be found at the addresses 0x1000, 0x1100 and 0x1200.
WiInOLS will remember the values 0, 0x100 and 0x200 for the group.

If you now issue another search command for the same group, the search string will
only be search for the known offsets. If the string cannot be found at one of the
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known offsets, then this one will be removed from the group. So, if you search for
"100 101" with 0x2000 as start address, then WinOLS will ONLY search at the
addresses 0x2000, 0x2100 and 0x2200. All other places will be ignored. And if the
string for example isn’t found at 0x2100, then this offset (0x100) will be ignored in
further searches, too.

Global commands:

requires_winols "1.505"

The script can only be executed if at least WinOLS version 1.505 is running. This
helps avoiding incompatibilities, because the last additions to the scripting language
were made in version 1.505.

requires_hexdump
This script can only be run if the currently active window shows a hexdump. It will be
ignored for map windows.

requires_map [X-Grol3e Y-Grolie]

This script can only be run if the currently active window shows a map. It will be
ignored for hexdump windows. You can specify 2 optional parameters that are the
number of columns and rows that the map is expected to have. If the currently active
map does not match this data then the script cannot be applied.

replace_mode Model [Mode2] [Mode3]

Defines, which replacement mode should be used. A script can specify multiple
replace commands for the same data area, as long as they use a different mode.
This command controls the selection in the script dialog. The first value (Model) is
the default value in the dialog.

The following keywords may be used for the Mode parameter: percent absolute
difference? all

The keyword all is a special case. If it is used, then Mode2 and Mode3 may note be
used. Instead all replace commands within the script, no matter what mode they use,
are executed. This can be useful if you want to use the same script both for absolute
and difference (or percentile) changes. A selection of the mode in the script dialog is
not possible in this case. If the keyword all is used, you should set the value for
requires_winols to 1.088, because this keyword is not supported in earlier versions.

Blocks:

begin_requires

end_requires

This surrounds a block that checks whether the script can be applied for the current
project. Only if all search commands find something the script is regarded as
applicable. Commands in this block can’t change the project.

begin_executable [tolerate_not_found]
end_executable
Surrounds a block containing commands to execute the script and modify the

(C) 2025 EVC electronic



Advanced topics 295

project. If the tag tolerate_not_found is set, then the script execution won't stop if a
group can't be mapped. (This does not influence the requires-block.)

begin_insert_map group

end_insert_map

This block may only be used within an EXECUTABLE block. It contains the definition
for a map that is inserted when the script is executed. The group must be identical to
one that was previously defined. If the group contains multiply positions only the best
is used.

Non-Global commands:

search Group Dataorganisation Startaddress Deviation Tolerance "Searchstring"”
This command performs a search for the search string. The string consists of several
decimal numbers separated by spaces. A question mark may be used instead of a
number, if any number is acceptable in this position. The data organisation (eByte,
eLoHi, eHiLo, eLoHiLoHi, eHiLoHiLo) describes the data format in which the search
string is expected in the project. The search will start at the start address and then
expand to the left and right as far as the deviation allows it. The tolerance describes
the maximal difference the search string values may have from the project.
Important: Prior to WIinOLS 5.59.05, tolerance was not calculated correctly. For
compatibility, WinOLS still uses the old method if requires_winols is less than "5.09".

search_by mapid Group maporaxis Startaddress "mapid"”

This command is an alternative to "search" and useful if the map already exists in
the target project and the id field is filled in. Then this command can determine the
address from the map id instead of the map values. The parameter maporaxis must
be "map", "x" or "y" and shows which start address is used for the offset.
Respectively the parameter Startaddress should be set to the address or the map
data or axis data. The mapid is always the id of the map (and never of the axis).
Usually its a good idea to use separate groups for "'map", "x" and "y". Then the script
can still be applied if the axis addresses have changed (seen relatively to address of
the map data).

check_size by mapid sizex sizey "mapid"
Checks if the given map has the desired size.

search_by mapname Group maporaxis Startaddress "mapname”
Just like search_by mapid, but it searches for the map name, instead of the id.

replace Group Dataorganisation Startaddress model mode2 "Replacestring"

This command replaces a search string with another string. Here you may use
guestion marks, too. They represent a cell that should not be replaced with a
different value. Model defines whether only the best found position should be
replaced ("Best") or each ("All"). Mode2 defines whether the data will be changed
absolute ("Absolute") in percent ("Percent") or whether the changes will be
transferred as difference ("Difference2")

Note: In WinOLS versions prior to 1.205 the automatic script generic could generate
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wrong values for the difference values. Due to security reasons the old keyword
"Difference" was deactivated, so that no bad data could be generated. If you've
created scripts by hand simply use the new keyword "Difference2". Otherwise you
should re-create the script or not use the difference method.

unique Group
The script will only continue if the group contains exactly one entry.

set_map_property "Property” "Value"

This command may only be issued with an INSERT_MAP block. It will define the
difference properties of a map. A complete list with all possible properties can be
seen in any script that transfers a map.

check_property "Property” "Value"

This command checks whether the current project has this value in its properties. If
this is not the case, the script can’t be executed. You may also enter a regular
expression (like in perl or in good text editors). Regular expressions are marked by
the prefix "RE:". An example for the recognition of a Mercedes in its usual variations
would be: check property "producer" "re:(Mercedes|*MB$)". If you would also like to
accept an empty value for the producer: check_property "producer” "re:(Mercedes|
AMB$|"$)". Valid properties are: Producer, Chassis, Model, Softwareversion and
Softwaresize.

Starting with WinOLS 5.34 you can use the same placeholders here (like "%Client.
VIN%"), that are allowed at other places (e.g. F12>Export).

MessageBox "Test"

Displays the given text. This can be used for testing to check at which point the script
execution stops. (Note: The testing phase is split in 2 parts. In part one all
"check_property” commands are checked. The "search” commands are run in phase
2, together with MessageBox.)

comment Group nBytes "Text"
Creates a WIinOLS comment with the given text and length in bytes at the start of
each occurrence for this search group.

Performance:

The scripts are quite fast. In order to keep the check whether a script can be applied
or not fast, only one simple rule must be obeyed: Simple conditions first.

Scripts are always processed in a linear way (starting at the top, and then going
down). It is a good idea to use the SEARCH commands first that can be done
quickly. This way the more complicated commands will be processed later and more
rarely. SEARCH commands are simple / quick if they don’t contain questions marks,
no or little deviation and allow no or little tolerance. CHECK_PROPERTY commands
are also simple at should stand at the beginning.
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14.1.3 Map scripts

Scripts are normally applied to the entire project. As consequence they can only be
used for projects that are very similar to the original project.

This problem can be avoided with map scripts. A map script only knows the current
map and can only be a map to another map (which must have the same size as the
source map). Furthermore such a script file can contain only the data of one map.

Creating:

To create a map script, open a map which contains differences between original and
version and run the script function from the menu (or press the key F8). In the now
appearing dialog use the button "Add".

Applying:
To apply a map script simply open a map and run the script function. Now it won't
display the normal scripts, but only scripts made for maps of the current map's size.

14.1.4 Importing with scripts

Originally scripts were introduced to enable you to repeat often needed changes.

But since scripts are quite easy to create, advanced users with programming
knowledge may use them as import interface for maps. This can be useful if you
have extensive information about one or more projects in a format that cannot
imported into WinOLS.

In this case you can develop your own conversion software to create scripts that are
used to import the known information. The created script can be dragged-dropped
into the project window.

The created script should follow this structure:

requires_winols "1.505"
replace_mode absolute

begin_requires
end_requires

begin_executable
search KFOO eByte 0x00000 O Q% 2

begin_insert_map KFOO
set_map_property "Name"™ "Kennfeld"
set_map_property *“ldName*™ ****
set_map_property "Typ" "eZweidim"
set_map_property "FolderName"™ "My maps"
set_map_property "ViewMode™ "eViewText"
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set_map_property
set_map_property

set_map_property
set_map_property
set_map_property
set_map_property
set_map_property
set_map_property
set_map_property
set_map_property
set_map_property
set_map_property
set_map_property
set_map_property
set_map_property
set_map_property
set_map_property
set_map_property
set_map_property
set_map_property
set_map_property
set_map_property
set_map_property
set_map_property
set_map_property
set_map_property
set_map_property
set_map_property
set_map_property
set_map_property
set_map_property
set_map_property
set_map_property
set_map_property
set_map_property
end_insert_map
end_executable

"RWin" "eBars"
"DataOrg" "eFloatLoHi™

"Feldwerte.StartAddr" "'7668"
"StuetzX.
"StuetzX.
"StuetzX.
"StuetzX.Offset” '""0,000000"
"StuetzX.
"StuetzX.
"StuetzX.
"StuetzX.
"StuetzX.
"StuetzX.
"StuetzX.
"StuetzX.
"StuetzX.
"StuetzX
"StuetzX.SignaturByte" "OxFFFFFFFF"
"StuetzX.SkipBytes"™ "0"
"StuetzY.
"StuetzY.
"StuetzY.
"StuetzY.Offset” '""0,000000"
"StuetzY.
"StuetzY.
"StuetzY.
"StuetzY.
"StuetzY.
"StuetzY.
"StuetzY.
"StuetzY.
"StuetzY.
"StuetzY.
"StuetzY.SignaturByte" "OxFFFFFFFF"
"StuetzY.SkipBytes"™ "0"

Name™ *-"
Einheit™ "-"
Faktor™ "1,000000"

PreOffset'" '"0,000000"
DataSrc'" "‘eRom"
DataHeader™ "0
DataAddr™ *4096"
DataOrg" "eFloatLoHi™
Radix"™ '10"
bRueckwaerts"™ "0
bKehrwert'™ 0"
bVorzeichen™ "0"
-.Nachkommastellen™ "0

Name™ *-'
Einheit™ "-"
Faktor™ "1,000000"

PreOffset'" "0,000000"
DataSrc'" "‘eRom"
DataHeader™ "0
DataAddr™ *'8192"
DataOrg" "eFloatLoHi™
Radix"™ '10"
bRueckwaerts"™ "0
bKehrwert'™ 0"
bVorzeichen™ "0"
Nachkommastel len' "0

//

//

//

//

//

set_map_property "bKehrwert™ 0" // reciprocal
set_map_property "bVorzeichen™ "0" // sign
set_map_property "bDelta"™ "0"

set_map_property "bProzent'™ 0" // percent
set_map_property "bOriginal™ "0"

set_map_property "bOriginalWerte™ "0" // original values

set_map_property "Spalten' "16" // columns
set_map_property "Zeilen"™ "3" // rows
set_map_property "Radix' 10"

set_map_property "Nachkommastellen'™ 0" // precision
set_map_property “Kommentar™ My comment’ // comment
set_map_property "SkipBytes'™ "0"

set_map_property "LineSkipBytes™ "0"

set_map_property "Feldwerte.Name'"™ "-" // field values

set_map_property "Feldwerte.Einheit"” "-" // ..._unit
set_map_property "Feldwerte.Faktor'™ *"1,000000" // .._factor
set_map_property "Feldwerte.Offset" "0,000000"

set_map_property "Feldwerte.PreOffset™ "0,000000" // For reciprocal

X-axis

For reciprocal

backwards

signature byte

For reciprocal

The sample script creates a map. To create more than one map with a single script,
simply repeat the text with the begin_executable / end_executable block and replace
"KF00" each time with other, unique identifiers.

The script uses the command set_map_property to fill several properties of the map
with values. The individual properties mirror the fields in the dialog "Properties: Map".
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Checkboxes are filled with the numbers 0 (not checked) or 1 (checked). The
individual field names have these meanings:

Name
I[dName

Typ

FolderName
ViewMode

RWin

DataOrg

bKehrwert
bVorzeichen
bDelta
bProzent
bOriginal
bOriginalWerte

Spalten
Zeilen
Radix
Kommentar

The name of the map or axis

The internal identifier. Normally only Damos / ASAP2 use it.
The map type. Valid values are eEinzel (Single value), eEindim
(Onedimensional map), eZweidim (Twodimensional map),
eZweilnv (Twodimensional, inverted map)

The name of the folder (requires WinOLS 2.08)

The view mode. Valid values are eViewText (Text mode), eView2d
(2d-Mode), eView3d (3d-Mode)

The right area in text mode. Valid values are eRightWinNone
(Nothing), eHex (Character view), eBars (Bar view), eHexBars
(Both views)

The data organization (Endian and bit width). Valid values are
eByte, eLoHi, eHiLo, eLoHiLoHi, eHiLoHiLo, eFloatLoHi,
eFloatHiLo, eUserdef, eUserdefString

1 for a reciprocal view (otherwise 0)

1 for a signed view (otherwise 0)

1 for a view of the difference (otherwise 0)

1 for a view with a percentual difference (otherwise 0)

1 to ignore factor and offset (otherwise 0)

1 to view the not the version values, but the original values
(otherwise 0)

Number of columns in the map

Number of rows in the map

Number system. 16 for hexadecimal, 10 for decimal

A comment

Nachkommastelle Number of positions after decimal point

n
SignaturByte

SkipBytes

Feldwerte (...)
StuetzX (...)
StuetzY (...)

StuetzX.1

Einheit
Faktor

The marker byte before the axis or OXFFFFFFFF (requires
WinOLS 2.08)

The number of bytes the are skipped between two axis values
(requires WIinOLS 2.08)

This prefix means that the following properties applies to the
actual values of the map.

This prefix means that the following properties applies to the
values of the X axis.

This prefix means that the following properties applies to the
values of the Y axis.

Sets the string axis value for the first position. Requires
DataOrg=eUserdefString. Can be used for StuetzY and other
numbers, too.

A text field with the unit for the values.
The multiplications factor for viewing the values

(C) 2025 EVC electronic



300

14.1.5

WinOLS 5.74
Offset The addition values for viewing the values
StartAddr / The values start at this hexdump address. This address is not
DataAddr absolute, but shifts with the same offset that was found to fulfill the
search condition(s).
DataSrc The type of data source. Valid values are eDataSrcNone (no axis),

eRom (Data from the hexdump), eRomAdd (Additive values from
the hexdump), eRomSub (Subtractive values from the hexdump),
eUserdef (Userdefined vallues), eRomBackwards (Values from
the hexdump in inverted order)

DataHeader Number of header bytes before the axis that is marked in the
hexdump as well

bRueckwaerts 1 for mirroring the data (otherwise 0)

Here an excerpt from a script that imports a text axis:
G-
begin_insert_map KFOO

...
set_map_property "StuetzX.DataOrg" "eUserdefString"

set_map_property "StuetzX.0"™ "First text"
set_map_property "StuetzX.l1l" "Second text"
set_map_property "StuetzX.2" "Third text"
set_map_property "StuetzX.3" "Fourth text"
set_map_property "StuetzX.4'" '"Last text"

end_insert_map
end_executable

Trickery with scripts

Technically speaking, each group is a list of offsets that are added to the address.
Here, for example, all offsets (find address - 0x005A0) are stored in the group KFO0O:
search KF0O eByte 0x005A0 0x100000 0% "247"

The offsets are added back to the address here:
replace KF0O eByte 0x005A0 all absolute "0"

The address can be changed. This can be useful if you are searching at location A
but want to change it at location B. (Important: The offset is in bytes, not in cells. The
data organization must therefore be the same). The absolute address is less
important (due to the tolerance) than the difference between the addresses of the
two instructions. (Whereby WIinOLS prefers the smallest possible offset in "best"
mode).

For example, you can use this to search for something in a map, but change it in the
axis. This assumes that the map + axis have the same data organization and the
map is 1*x (or x*1).

Here is an example script that you can drag into a 16x1 map. It searches for 247 in
the map and writes 0 to the axis (which must be directly in front of the map).
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requires_winols ""2.08"
requires_map 16 1

replace_mode absolute

begin_requires
search KFOO eByte Ox005A0 0x100000 0% 247
end_requires

begin_executable
search KFOO eByte Ox005A0 0x100000 0% 247
replace KFOO eByte 0x00590 all absolute "0"
end_executable

14.2 Additional file formats

WinOLS can already import / export several file formats. You can extend this list with
2 methods:

a) Import / Export Plugins

Visit www.evc.de/en/product/ols/plugins.asp to find import/export plugins for several
special file formats. You can buy / install them like checksums, then they will be
available in WIinOLS just like other file formats.

Search keywords:

.a2l .asap2 .dam .damos .bsw .0pa .0da .cff .cre .dcm .e2m .ecfg .ekl .fls .fl2 .mm3 .
nav.dec .nav.zenc .nav .odx .odx-f .frf .sgo .sgm .pdx .sox .prm .slave .smr-f .vbf .vds
xdf .xml

b) External Converters [Requires programming knowledge]

If you use other / your own file formats, you can integrate them into WinOLS. This
will cause WInOLS to show them in the file dialogs. If the user selects such a file
format, then WinOLS will import / export an uncompressed EcuX file and run a
program provided by you to do the actual conversion from/to EcuX.

14.2.1 Basics

To integrate your own External Converter into WinoLS, you need an executable
windows program which performs the conversion between your file format and an
unpacked EcuX file in at least one direction. To indicate success the program must
return the error code 0. If it returns any other value, WinOLS will display the
program's STDOUT as error message.

To allow WIinOLS to find you program, you need to create the following registry-
entries (all of the type "string"). If you want to give your program to third parties, it's
recommended to create an installer for this:
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HKCU\Software\EVC\W Name of the file format
inOLS\Importer\Compan
y\Name
HKCU\Software\EVC\W Description of the author / company, perhaps with URL
inOLS\Importer\Compan
y\Author
HKCU\Software\EVC\W A list of file suffixes (without star or dot, separated by
inOLS\Importer\Compancolons), which the converter can process. The first suffix in
Y\Suffix the list is the default-suffix during export.
HKCU\Software\EVC\W Commandline which is run during import.
inOLS\Importer\Compan
y\import
HKCU\Software\EVC\W Commandline which is run during export.
inOLS\Importer\Compan
Yy\Export
Please replace Company with your company name. If your converter supports only
one direction (e.g. only import), you can simply leave the registry key for the other
direction empty.
A command line should include the placeholders %1 and %2. They will be replaced
with source and target. Example:
"C:\Program Files (x86)\Acme\ExternalConvertSample\converter_export.bat” "%1"
nop0"
Import:
%1 is the path+filename of the file the user wants to import into WinOLS..
%2 is a path (without trailing backslash) where WinOLS expects the files that would
normally be compressed in an EcuX files. It's up to your converter program to create
these files.
Export:
%1 is a path (without trailing backslash) where WinOLS stores the files that would
normally be compressed in an EcuX files.
%2 is the path+filename of the file the user wants to have. It's up to your converter
program to create this file.
EcuX:
Information about the EcuX file format can be found at ecux.evc.de. Normally EcuX
files are zip files containing various other (contents.ini and binary file(s)). The zip
compression is omitted in the External Converters and the files are expected / stored
uncompressed in the above path.

14.2.2 Example

Here are the files that you need for a sample converter, including installer (Inno
setup). This sample demonstrates only the integration. Effectively it does not convert
anything, but only copies the eprom element and thus works only with projects that
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have an eprom element.

File: contents.ini

; This is the Contents.ini file of an EcuX package. It's an open format, you're
welcome to import/export it with your own tools. For the current version
documentation check http://ecux.evc.de/

[global]
EcuX_version =0.3
AuthorTool = ExternalConverterSample

[Description]

NumVersions =1
[Filel]
Filename = eprom.bin

File: converter_export.bat

@rem WiInOLS external converter sample, http://www.evc.de

@rem

@rem Please note that we're using a bat file for simplicity. You'll probably want to
use an exe.

@rem

@rem Each converter receives 2 inputs. The export converter receices:

@rem %1 - the temporary path containing the files that would normally be inside an
EcuX file (http://ecux.evc.de/)

@rem %2 - path + filename of the file that the user expects as final output

@rem For sake simplicity this file simply copies the source file.
@rem Note: This exporter only works for file that have an element named "Eprom".
@copy "%~1\eproml.bin" "%~2"

@rem returns any error from the last copy command to WinOLS:
@exit /b %ERRORLEVEL%

File: converter_import.bat

@rem WiIinOLS external converter sample, http://www.evc.de

@rem

@rem Please note that we're using a bat file for simplicity. You'll probably want to
use an exe.

@rem

@rem Each converter receives 2 inputs. The import converter receices:

@rem %1 - path + filename of the file that the user expects us to import

@rem %?2 - the temporary path where we have to create everything that's normally
inside an EcuX file (http://ecux.evc.de/)

@rem %-~dp0 is bat magic for "path of this bat file"

(C) 2025 EVC electronic



304

WinOLS 5.74

@copy "%~dpO\contents.ini" "%~2\contents.ini"

@rem For sake simplicity this file simply copies the source file.
@copy "%~1" "%~2\eprom.bin"

@rem returns any error from the last copy command to WinOLS:
@exit /b %ERRORLEVEL%

File: is_SampleConverter.iss
; Script generated by the Inno Setup Script Wizard.

; SEE THE DOCUMENTATION FOR DETAILS ON CREATING INNO SETUP

SCRIPT FILES!

#define MyAppName "WinOLS ExternalConvertSample”

#define MyAppVerName "WInOLS ExternalConvertSample 1.00"
#define MyAppPublisher "Acme Corp"

#define MyAppURL "http://www.example.org/"

[Setup]
: NOTE: The value of Appld uniquely identifies this application.

; Do not use the same Appld value in installers for other applications.

; (To generate a new GUID, click Tools | Generate GUID inside the IDE.)

Appld={{cbafb88b-60ae-42al-b31c-5fbba95738bf}
AppName={#MyAppName}
AppVerName={#MyAppVerName}
AppPublisher={#MyAppPublisher}
AppPublisherURL={#MyAppURL}
AppSupportURL={#MyAppURL}
AppUpdatesURL={#MyAppURL}
DefaultDirName={pf32}\Acme\ExternalConvertSample
DefaultGroupName={#MyAppName}
OutputBaseFilename=ExternalConvertSample
Compression=lzma

SolidCompression=true

ShowLanguageDialog=no

WindowResizable=false

WindowVisible=true
WizardimageFile=compiler:WizModernimage-I1S.bmp
WizardSmalllmageFile=compiler:WizModernSmalllmage-1S.bmp

[Languages]
Name: english; MessagesFile: compiler:Default.isl

[Files]

Source: contents.ini; DestDir: {app}; Flags: ignoreversion

Source: converter_import.bat; DestDir: {app}; Flags: ignoreversion
Source: converter_export.bat; DestDir: {app}; Flags: ignoreversion
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[Registry]

Root: HKCU; Subkey: "Software\EVC\WinOLS\Importer\Acme"; ValueType: string;
ValueName: "Name"; ValueData: "Sample"

Root: HKCU; Subkey: "Software\EVC\WinOLS\Importer\Acme"; ValueType: string;
ValueName: "Author”; ValueData: "SampleCompanyName, http://www.example.org/"

; We support multiple suffixes. The first one is the primary suffix that is appended by
default when exporting

Root: HKCU; Subkey: "Software\EVC\WinOLS\Importer\Acme"; ValueType: string;
ValueName: "Suffix"; ValueData: "externalconvertersample,ecs"

; Links to the software that would provide the actual work. Our sample just copies,
without any actual conversions.

; Notes: - {app} is replaced at install time by inno setup with you install target path

; - %1 and %2 are replaced by WinOLS with the source and target path/
filename. (Path without backslash at the end)

; - Don't forget the "™ around the paths! The outer quotes are for inno setup. The
inner double quotes are converted to single quotes by inno setup

Root: HKCU; Subkey: "Software\EVC\WinOLS\Importer\Acme"; ValueType: string;
ValueName: "Import"; ValueData: """
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(C) Copyright 2025 by
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Manager Axel Schroer
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